Table of contents

TABLE OF CONTENTS .............................................................................................................................. II

90SecondWebsiteBuilder ........................................................................................................................ 6

INTRODUCTION ............................................................................................................................................. 6
GETTING STARTED, A QUICK INTRODUCTION .......................................................................................... 8
How is 90 Second Website Builder different from a HTML editor? ............................................................ 8
Start 90 Second Website Builder ............................................................................................................ 9
Adding text to the page ............................................................................................................................. 14
Adding an image to a web page .................................................................................................................. 15
Rotate an image ........................................................................................................................................ 16
Apply effects to an image ........................................................................................................................... 16
Linking your pages together (Creating hyperlinks) ...................................................................................... 17
Saving your web site ................................................................................................................................ 17
Preview a page .......................................................................................................................................... 18
Publishing your web pages ....................................................................................................................... 19
What’s next? ............................................................................................................................................. 20

90 Second Website Builder OPTIONS .............................................................................................................. 21
File ............................................................................................................................................................ 21
Home ......................................................................................................................................................... 23
View ............................................................................................................................................................ 25
Page ............................................................................................................................................................ 26
Insert ......................................................................................................................................................... 41
Insert ......................................................................................................................................................... 41
Format .......................................................................................................................................................... 42
Table ............................................................................................................................................................ 45
Arrange .......................................................................................................................................................... 47
Tools .............................................................................................................................................................. 51

90 Second Website Builder Objects ............................................................................................................. 69

Style ............................................................................................................................................................. 70
Bookmark .................................................................................................................................................... 72
Bulleted List ................................................................................................................................................. 73
Horizontal Line .............................................................................................................................................. 74
Image ............................................................................................................................................................ 75
Marquee ....................................................................................................................................................... 80
Marquee ....................................................................................................................................................... 80
Text ............................................................................................................................................................... 81
Form Wizard ............................................................................................................................................... 83
90 Second Website Builder

Introduction

90 Second Website Builder is an all-in-one software solution to create complete web sites. It is programmed so that all the elements of the page will be displayed in the exact same position (fixed layout) as they are on the canvas - unlike fluid (dynamic) layouts (generated by traditional HTML editors) where the position of objects depends on the position and size of the objects surrounding it. 90 Second Website Builder generates HTML (Hypertext Markup Language) or XHTML tags while you point and click on available functions; you can create a web page without learning HTML. Just drag and drop objects to the page position them ‘anywhere’ you want and when you’re finished publish it to your web server (using the build in Publish tool). 90 Second Website Builder gives you full control over the content and layout of your web pages. A 90 Second Website Builder project file can hold multiple web pages, so you can easily manage all your pages from within one file.

Key Features:

• Drag & drop of HTML objects: Text, Lines, Images, Marquees, Tables and much more!
• HTML, XHTML or HTML5 output.
• Supports many CSS3 features: box-shadow, opacity, rounded corners etc.
• Site Management. Easily add, edit, clone and structure your web pages.
• Form wizard; create forms in less than 4 steps plus many Ready-to-use Forms!
• Supports all common form controls: Editbox, TextArea, Checkbox, Radiobutton, Combobox, Button and File upload.
• Form validation tools for most form elements.
• Built-in CAPTCHA for PHP forms.
• Many Shape objects (Rectangle, Round Rect, Ellipse, Hexagon, Octagon, Arrows, Signs, Stars, Talk Bubbles and more) with many fill effects such as solid, gradients patterns and glass.
• Support for YouTube, JAVA, Flash, HTML5 Audio/Video, Flash Video (FLV), Quicktime, Real Audio and other Plug-Ins.
• Build-in banner creator.
• Rollover images and Slide Show images (with many transition animations).
• Rollover Text, displays a text banner over image on mouse over. Includes cool slide and fade effects.
• Photo gallery object with photo frames and built-in light box slideshow support.
• Many cool Ready-to-use Java scripts.
• Navigation bar, Text Menu, Mega Menu, Tab Menu, Slide Menu, SiteTree and Menu bar.
• Bulleted Lists (Circle, Disc, Square, Numeric, Alpha, Roman and custom images).
• Image maps
• Import existing HTML pages.
• Customize hyperlink colors/format using cascading style sheets CSS).
• Template support. Already more than 100 free templates available!
• Publish your entire web site, a single page or a group of pages in one action (to local drive or a web server).
• Master objects and Master Frames. This allows you to re-use objects from other pages.
• Layer Object for advanced layout possibilities
• Free angle rotation for shapes and images
• Table support.
• CSS3 animations and transitions.
• Properties Inspector window for quick object manipulation.
• Ability to group/ungroup objects
• Image tools: Contrast, Brightness, Flip, Rotate, Resample, Hue/saturation, Stencils and Crop.
• Image effects: Grayscale, Negative, Sepia, Blur, Soften, Sharpen, Noise, Emboss and more!
• Drawing tools: Line, Line + Arrows, Scribble, Polygon, Curve and Closed Curve.
• Implement Events for Images, Shapes and form controls!
• Image reflection effect and the ability to add shadow to images.
• RSS Feed and built-in Blog tool.
• PHP Login Tools/Page Protection.
• Content Management System functionality with plug-in support.
• Mobile Web Design tools with built-in jQuery Mobile support.
• Responsive Web Design (breakpoints) based on CSS3 Media Queries.
• Gradient Style Manager to add/edit and remove global (multi color) gradients effects.
• PayPal eCommerce Tools. The PayPal eCommerce Tools are the quickest and easiest way to add eCommerce to your web site!
• Popup window support for links (with optional position, size, toolbar, statusbar, scrollbars etc.)
• Smart links; link to the next, previous, parent or child page. Sitemap generator.
• Built-in FTP Client to manage your online files. The 'Explore' button in publish settings give you access to your published files.
• Built-in jQuery support: Accordion, Tabs, Dialog, Date picker, Auto complete, animations etc!!!
• Site Search
• Image watermark tool
• Carousel functionality
• Built-in support for Flickr/MySpace/Picasa photo galleries.
• News feed ticker object to integrate RSS feeds, Twitter, MySpace, Flickr, Facebook etc.
• jQuery Menu. A themeable (multi level) menu with mouse and keyboard interactions for navigation.
• jQuery Spinner. Enhance a text input for entering numeric values, with up/down buttons and arrow key handling.
• jQuery Tooltip. Customizable, themeable tooltips, replacing native tooltips.
• Wrapping Text
• and much more…
Getting started, a quick introduction

90 Second Website Builder is a Web site building tool that helps you design and build full-featured Web sites without having to learn HTML. When you preview or publish a page, 90 Second Website Builder automatically generates the HTML code your Web browser needs to display pages. This chapter helps you get started in a few simple steps. You can find more details about each item elsewhere in this document.

How is 90 Second Website Builder different from a HTML editor?

The idea behind this application is to hide HTML from the user. 90 Second Website Builder is not an HTML editor, but an HTML generator. You don’t even have to know there is HTML involved. Just drag & drop images, text and other objects on your page and your page is ready to be published! You can think of it as a Desktop Publishing tool for websites.

90 Second Website Builder does not edit the HTML directly, but it uses its own file format (.wbs) to store the information of the website. You can even store your complete website into one single file! By not using HTML internally, 90 Second Website Builder can do much more than just generate standard HTML objects: it supports shapes, drawings, navigation bars, RSS feeds, blogs, photo galleries, ready to use JavaScript’s and much more advanced objects.

Tip: To export your pages to HTML you should use the built-in publish tool!

If you like you can insert existing HTML to your page using the HTML tools (Page HTML and the HTML object). You can also insert custom attributes or other code to almost any object.

FrontPage, Dreamweaver etc use a document (word processor) method for layout, where you can not pick up objects and drag it where you want it to go on the web page. In 90 Second Website Builder you can drag and drop the objects anywhere you want, giving you full control over the layout. You can even put objects on top (or below) other objects!

Traditional HTML editors use Dynamic Page Layout, which means that the first object on the page will also determine the position of the second object. Resizing or moving the first object will affect the complete layout of the page. You can’t overlap objects when using Dynamic Page Layout.

90 Second Website Builder generates Fixed Page Layout. All objects have a fixed position which is not affected by other objects. This also allows you to overlap objects and give you much more control over the layout of the page.

What-You-See-Is-What-You-Get doesn’t necessarily mean that the page will look exactly the same in all browsers because each browser uses its own rendering engine and has its own interpretation of the HTML specification. However 90 Second Website Builder will generate the most optimal HTML code, to make it look as close as possible. We also constantly monitoring the latest standards to make sure we’re 99.9% compliant with the W3C standards.

Tip: For step by step instructions to the basic features of 90 Second Website Builder please visit the onlinetutorials: http://www.90secondwebsitebuilder.com/videos
Start 90 Second Website Builder

Click the 90 Second Website Builder icon to launch the application.

When you startup 90 Second Website Builder the main screen will look something like this:

By default the Ribbon interface will be active, but if you prefer you can also switch to classic menu/toolbars in Tools->Options->Miscellaneous->User Interface.

User interface: Ribbon
               Ribbon
               Menu/Toolbar
Ribbon
The Ribbon gives you quick access to all available tools. The Ribbon contains tabs to expose different sets of control elements, eliminating the need for many different icon-based tool bars. Some of these tabs are contextual and appear only when a certain type of object is selected, providing specific tools for items such as tables, text or images.

You can minimize the Ribbon with the small arrow in the right corner. In that case you will still be able to access all tabs of the Ribbon, but the tools will hide to free up some screen space.

Contextual Tabs
Contextual Tabs only appear when needed. For example, if you select an image object then the Image Tools will be displayed. The tools will automatically hide if you deselect the object.

Text Formatting Tools
The text formatting tools are only active when you are in text edit mode.

To insert text simply drag the text icon on the workspace. A new object with the text "Double click to edit" will be displayed on the page. To switch to text edit mode double click this text and the formatting tools will become active. For some of the tools you need to highlight the text before they can be used (just like in a regular text editor).
Quick Access toolbar
You can put commands you use most often on the Quick Access Toolbar above the ribbon. Just like the Ribbon, this toolbar is fully customizable.

File Menu
The File Menu contains all file related commands like Open, Save, Close and Publish. There is also a search field that helps you quickly find specific commands.

Toolbox
The toolbox can be used to add new objects to your web pages. To insert a new object, select one of the available items and draw a box to indicate the position of the object. The new object will now be inserted to the page. Another way to add objects to your page is by simply dragging them out of the toolbox onto the workspace.

Tabs
When you have opened multiple pages you can use the tabs to switch between the pages. To close the active page press the small 'x' in the upper right corner of the tabs strip.

Workspace
The center of the screen is the workspace, where you can drag and drop objects from the toolbox. This represents your web page.
Site Manager

The Site Manager can be used to manage the structure of your web site.

The Site Manager has its own toolbar to add, edit, clone or remove pages. There is also a button to open the properties of the selected page.

In the picture above you see an example of a web site structure. The filename of this example web site is called 'mywebsite.wbs', this name is always displayed at the root of web site tree. The root can have one of more pages and each page can have sub pages. Web sites always have a **home page**, which is often called **index**, so for this reason 90 Second Website Builder automatically adds this page to each new project. The names of the items (pages) in the site tree are the actual file names of the target HTML files, so if you named a page 'index' is will publish as index.html. Do not add the file extension in the site manager.

**Tip:** Make sure all pages of a website are part of the same project, this way 90 Second Website Builder will 'know' that the pages belong together and generate optimal HTML for your website.

Every time you insert a new page to your website it will be added to the Site Manager. To edit previously created pages you can double click the page name to open it in the editor.

**Important Note:**
If you reopen the project then only the first page will be opened (to reduce the loading time of the project and limit the allocated memory). To open other pages of the project you must use the Site Manager. If you do not see also your pages then you may have added them as a child of another page. Click the '＋' sign in front of the page (or folder) to expand the tree..

You will find more information about the Site Manager later in this document.
Properties Inspector

Use the Properties Inspector window to view and change the properties of selected objects. You can also use the Properties Inspector window to modify page properties. The changes will be visible immediately. The Properties Inspector window displays different types of editing fields, depending on the needs of a particular property. These edit fields include edit boxes, drop-down lists, and links to custom editor dialog boxes. It is also possible to manually modify the size and position of the selected object by changing the Position and Size properties.

The ID property

The ID property of an object should be unique within the page. Normally 90 Second Website Builder will give your object unique names automatically. However if you use one of more master objects, then IDs may be duplicated, since the software cannot distinguish a master from a normal page. The Properties Inspector also give you access to more advanced attributes like the ID of an object. This can be useful if you use master pages and want to give the items of the page a unique ID. We recommend giving objects on a master page names with a prefix like MasterPage_Text1. This will make sure that if the master page is used in another page, the ID of the objects is unique.
Adding text to the page

One of the first steps in creating a web page is often adding text.

Select Insert->Text from the menu and draw a box to indicate the position of the text. Then double click the box to start editing the text. Type some text and (press Enter to go to the next line). The box automatically changes its size to fit the text.

Next, you can change the text attributes by highlighting the text you want to modify with the mouse and then choose the new attributes in the Format Tab. You can change font type, size, bold, italic, underline, text color, highlight color and many other attributes. Note that the formatting tools are also available in the context menu of the text editor.
Click anywhere in the page to stop editing.

**Adding an image to a web page**

Select Insert->Image from the menu and draw a box to indicate the position of the image or select **Image** in the toolbox. The size of the box doesn’t matter; 90 Second Website Builder automatically adjusts the box to fit the image after you place it.

The Image File Open dialog appears so you can locate the image you want to place in the image box. Select the image you want to add and click Open to add it to the page.

To resize the image drag the borders (handles) of the image object.
Rotate an image
You can rotate image and shape objects.

To rotate an object:
1. Select the Rotate tool on the Ribbon or right click and select Rotate.
2. Click to select the object, hover over one of its handles until you see the rotate pointer.
3. Hold the mouse button down and drag in the direction in which you want to rotate the object, then release. Use the Shift key for 15° rotation intervals.

Apply effects to an image
In 90 Second Website Builder you can apply effects to images without having to open a separate image editor! A few of the available effects are: Contrast, Brightness, Blur, Grayscale, Emboss, Negative, Sepia, Sharpen, Soften, Stencils and much more!
Linking your pages together (Creating hyperlinks)

Hyperlinks are text or images that can be clicked to bring the user to another web file such as a web page, images or any other file. They are the essence of the World Wide Web as they link pages within sites and web sites to other web sites. To create a hyperlink in 90 Second Website Builder, follow the instructions below.

**Linking text**

Highlight the text you want to link and select Insert->Link from the menu bar, click the link button on the toolbar or press CTRL+K on your keyboard. This will display the Insert Hyperlink window.

![Image of Insert Hyperlink window](image)

1) Highlight the text you want to link
2) The link button will be activated

**Linking an image, shape or rollover image.**

![Image of selecting an image](image)

1) Select the image you want to link
2) The link button will be activated

Please read the chapter ‘Links’ of this document for more details about linking.

**Saving your web site**

To save your web site, select Menu->File->Save Web Site from the menu and enter a name for the project. 90 Second Website Builder uses the extension .wbs (90 Second Website Builder Site) to save the project files, to save your page as HTML you’ll have to Publish your pages.
Preview a page

Select Home->Preview in Browser->Default Browser (F5) to preview the current page in your default browser. It is also possible to change the browser that is used for previewing. Go to Home->Preview in Browser->Edit Browser List to add/edit the list of browsers that can be used to preview the pages you are working on.

Depending on the preview scope (Tools->Options->Miscellaneous), you can preview either a single page or the entire web site. Holding down the SHIFT key while previewing will ‘invert’ the current preview scope.

**Important note:** Internal links do not work in Preview, unless you have set the Preview Scope to Entire Web Site. If you only preview a single page, your browser will not be able to find all the other (internal) pages unless you also generate them.

**Another note:** You cannot preview pages that use PHP in your local browser. PHP pages can only be viewed through a web server with PHP support.
Publishing your web pages
The final phase of creating a web site is publishing your pages. To place your pages on the Web, you need a Web server. Commonly called hosts, Web servers allow you to transfer and store files, including HTML documents, images and multimedia files. Unless you own your own Web Server, you need to find a server to host your pages. Users of 90 Second Website Builder are offered a discount on hosting services provided by BlackWire Marketing LLC. Discount coupon and information can be found in the Members Area of the 90 Second Website Builder website. The BlackWire Hosting service is at:
http://blackwirehosting.com

Make sure you choose a web host that supports FTP; this makes it much easier to publish your pages from 90 Second Website Builder.

Publish to a remote FTP server.
Once you have registered to a web host, you will receive a server address, username and password. Enter this information into 90 Second Website Builder by selecting: File->Publish. Click Add and select Type ‘FTP Server’. Sometimes you also need to specify a remote folder. Common remote folders locations are: /www, /public_html, /html, but unfortunately this value can be different for each webhost, so consult your webhost’s documentation for more details! If you have a firewall/router, select ‘Use passive mode for transfers’. Click OK to save. Now you can publish each page simply by selecting Publish.

Publish to a local folder
If your web host doesn’t support FTP or you want to use your favorite FTP client to transfer the files to the server, you can use the option ‘Publish to a local folder’. Click Add to add a new location to the list. Enter a name for the location a select ‘Local Folder’ as type. Enter the folder where you want to publish the active document. Click OK to save the data and then click Publish to save the files to the specified folder. Now you can take these files from the local folder and publish them using your preferred FTP utility.
Pages to Publish
Select which page or pages you want to publish.

- **Entire Web Site**, publishes all pages of the web site (except the pages which have enabled 'Don't Publish this Page' in Page Properties)
- **Select Page Only**, publishes the select page, click Select to specify the page to be published.
- **Select Page and Sub Pages**, publishes the select page and all of its sub pages (if any).
- **Publish pages using the selected master page**, This will publish all files using the selected master page. This can be useful if you have made some changes to a master page and quickly want to re-publish all pages that are using that master page.

What to do in case of publishing errors?
- Make sure your ftp address (host) is correct.
- Is your username and password ok?
- Make sure the remote folder is correct (very important!)
- If the files don't show up on your website you've probably specified the wrong remote folder.
- **Does your firewall block the FTP connection of 90 Second Website Builder?**
  - Enable 'Use passive mode for transfers'
  - Increase the connection timeout to 120 seconds (Tools->Options->Publish)
  - If the transfer takes a long time then you've probably used (very) large images.

- If your website doesn't look to be updated, select 'Refresh' in your browser multiple times!

Why aren’t my images displayed a published page?
- Did you upload the images to the web server?
- By default, 90 Second Website Builder places all images in a sub folder called images; you can change this through Tools->Options->Publish->Image Sub Folder. If you leave this field empty, the images will be published in the same folder as the published page.
- Some web hosts do not support sub folders, so make sure you have permissions to create folder on the server. If not, then you must tell 90 Second Website Builder to publish the images in the same folder as the HTML.
- Make sure the image names are valid; most web servers are case-sensitive and/or do not support special characters in the filenames of images.
- Do your image filenames contain whitespaces or other special characters? Image names with spaces can cause problems in some browsers and/or web servers, use underscores or dashes to connect words instead of spaces.

What’s next?
This manual has a description of pretty much all of Web Builder’s features. Scroll down to learn all the exciting features of 90 Second Website Builder!

Tip: For Frequently Asked Questions or other support please visit: [http://www.90secondwebsitebuilder.com/support](http://www.90secondwebsitebuilder.com/support)
90 Second Website Builder Options

File

New Web Site
Creates a new empty web site project.
All pages of a web site will be saved in one file.

New Web Site From Template
Creates a new web site based on a template. Templates can later be used by you (or someone else) to use a basis for a new page or web site. When you save a web page to a template it will include all images and other objects in the template file, so there is no need to copy these files separately. This can be useful if you want to transfer your work to another computer. 90 Second Website Builder Templates have the .wtp extension and are saved in the sub folder \My Document\90 Second Website Builder\system\templates. To add a new category to the template selection window, so you can organize your templates, simply create a new folder and put the template files in this folder. The name of the folder will then be displayed in the Category dropdown list. You can also download templates created by other 90 Second Website Builder users from the 90 Second Website Builder web site: http://www.90secondwebsitebuilder.com/templates.html

Open Web Site
Opens an existing web site project.

Close
Close the active page. Closing the last open page will also close the web site project!

Close Web Site
Close the active web site project.
Save Web Site
Save the active web site project.

**Important note:**
90 Second Website Builder does not edit the HTML directly, but it uses its own file format (.wbs) to store the information of the website. In order to save your pages as HTML you need to publish or export your pages. 90 Second Website Builder stores the information of all your pages in one project file.

Save Web Site As
Save the active web site project with a new name.

Save Web Site As Template
Save the active web site project to a template.
See ‘New Web Site From Template’ for more details about templates.

Save As HTML Document/ Export HTML
This option triggers the Publish window. If you really want to export the active HTML page only, then hold down the SHIFT key on your keyboard. To generate more than one file at a time, please use the Publish option.

Preview in Browser
Preview the active web page in your default Browser.
Depending on the preview scope (Tools->Options->Misc), you can preview either a single page or the entire web site. It is also possible to change the browser that is used for previewing. Go to File->Preview in Browser->Edit Browser List to add/edit the list of browsers that can be used to preview the pages you are working on.

**Tip:** You can also use the menu item 'Preview entire web site' to toggle between single page and entire website preview.

**Note:** You cannot preview PHP pages directly in your browser. PHP can only be viewed via a web server with PHP support!

Publish
Publish the active page, a group of pages or the entire web site. You can choose to publish to a local folder or a remote FTP server. Check out the chapter ‘Publish’ of this document for more details.

Exit
Quits the application.
Home

Paste
Insert Clipboard contents.

In text editing mode hold down the SHIFT key while using this command to paste without formatting. This can be useful when you are pasting text from MS Word which may include invalid control characters.

Paste in Place
Paste in Place is a method of pasting something in the workspace in the exact position that it was in when you copied it.

Cut
Cut the selection and put it on the Clipboard.

Copy
Copy the selection and put it on the Clipboard.

Delete
Erase the selection.

Undo
Undo the last action. You can undo up to 255 actions.

Redo
Redo the previously undone action.

Select All
Select the entire document (all objects).

Find
You can search for words or characters in the active page or your entire website. On the Edit menu, click Find. In Find in, select Current Page or Entire Web Site. In Find what, type the characters or words you want to find, and then click Find Next. To find additional instances of the same text, continue to click Find Next.

Find dialog box

Note: If you select Find in 'Entire Web Site' then all your pages will be opened. This may use a lot of your system's memory and slow down the overall performance of your computer!
Replace
You can search for and replace words or characters with text that you specify.
On the Edit menu, click Replace. In Find in, select Current Page or Entire Web Site
In Find what, type the characters or words you want to find.
In Replace with, type the text you want to replace it with.
Click Find Next, and then click Replace. To replace all instances of the text, click Replace All.

Properties
Edit properties of the selected object.
See the chapter ‘90 Second Website Builder Object’ for more details about object properties.

HTML
View generated HTML of the selected object or insert your own HTML code!
Please note that this option is for advanced users only. Inserting invalid HTML code may cause unexpected results.

Don’t Publish Assets (context menu only)
If this option is enabled then 90 Second Website Builder will not publish the assets (images, scripts, movies) for this object. For example a media player will not publish the associated media file(s).
This can be useful if a file already exists on the server, so it does not need to be published again.
Note that it will still generate the HTML code for the object.

Restore Original Size (context menu only)
Can be used to restore an image or flash object to its original size.
View

**Full Screen mode:** Normally, when you edit a webpage in 90 Second Website Builder, some of the screen is taken up with toolbars, a menu bar, a status bar, and other windows. To temporarily hide all of this extraneous information to solely work on your page, click "View" and select "Full Screen Mode". Everything will disappear except your currently edited page. To go back, press the F11 key or click the Full Screen toolbar button.

**Refresh:** The 'Refresh' option to reloads all images of the current page. This can be useful if you have edited images outside of 90 Second Website Builder.

**Object Manager:** Show or hide the Object Manager window.

**Properties Inspector:** Show or hide the Properties Inspector window.

**Site Manager:** Show or hide the Site Manager window.

**Toolbox:** Show or hide the toolbox.

**Grid:** Show or hide grid.

**Snap to grid:** Enable or disable snap to grid. Use the Snap to Grid feature to align objects exactly. 90 Second Website Builder creates a "magnetic" attraction between the selected object and the grid.

**Snap to ruler guides:** Enable or disable snap to ruler guides.

**Rulers:** Show or hide rulers.

**Ruler Guides:** Show or hide ruler guides. You can add ruler guides by clicking Ruler Guides->Add Horizontal/Vertical user guide or simply drag a new guide from the ruler bar.

**Object Outlines:** Show or hide object borders.

**Zoom**

You can zoom in to see parts of your web page close-up, or zoom out to see more of the page. You can either select one of the predefined zoom percentages or enter a custom value in the zoom toolbar.

**Notes:**

The quality of the zoomed page strongly depends on the zoom level. You will get the best quality for 100%, 200%, 300%, 400% etc. But a zoom level of 150% will introduce rounding errors.

You cannot edit text when a page is zoomed in or zoomed out.
Page

New Page
Adds a new page to your web site. The new page is automatically opened so you can start editing it right away. The new page (with a unique page name) with be added to the Site Manager tree.

New Mobile Page
Adds a new mobile page to your web site. Mobile pages have a different toolset, optimized for mobile devices. For more information about mobile web design please read the following article: Mobile Web Design.

New Page from Template
Create a new page based on a template. Pick any page from a template and insert it into the current project. The new page (with a unique page name) with be added to the Site Manager tree.

Edit Page
This will display a list of all the pages in your website. To open/edit the page, simple select the page name.

Clone Page
To make an exact copy of the active page, select Clone Page from the menu. A new item (with a unique name) will be added to the Site Manager.

Note:
'Clone Page' will duplicate the page and all objects on that page. To reduce the number of duplicated objects within your website you should consider using master pages.

Delete Page
Delete the active page from your web site. You cannot remove the last page in your web site.
Rename Page

Rename the active page. Note that the Site Manager must be visible to be able to rename your page. The name of the page will be highlighted in the Site manager, where you can change its name.

Note: When you have linked to the page you are renaming (from any page within the web site), 90 Second Website Builder automatically updates all the links for you so you don't have to redo all the internal links.

Notes about page names

While building your web site, 90 Second Website Builder saves the project file with the .wbs extension. This is a project file used by 90 Second Website Builder to simplify the building process. One project file can contain multiple web pages. Once your pages are ready you must export or publish them as HTML. The name of the output HTML file is taken from the name you have specified in the Site Manager. So if you named the page index then the output file will be called index.html. If the page needs another extension like .php, you can configure this in the Page Properties.

Here are some guidelines how to name your web pages:

1. Do not add .html or .htm extension to the page name. 90 Second Website Builder will automatically add the .html extension (or .php, .asp) when it publishes (or exports) the HTML code.
2. Always name your homepage: "index", this is the most common name for a homepage.
3. Always use lowercase filenames, most web servers are case sensitive and might fail to find your page if you have called it "Index" or "INDEX"
4. Use alpha numeric characters only. Do not use space or other special characters in the name, keep them simple like: "page1" or "my_products"
5. Use underscores or dashes to connect words.
Import HTML Page

Although 90 Second Website Builder is NOT an HTML editor, you can import existing HTML pages. Select Page->Import->Import HTML Page from the menu to display the Import HTML page window. You can either select an HTML page from your local drive or specify a URL of an online website. Click OK to start importing the page. 90 Second Website Builder will automatically copy all images to your local drive.

Important notes about importing HTML:

- 90 Second Website Builder is not an HTML editor, but an HTML generator! 90 Second Website Builder imports the HTML by rendering the contents of an existing page and then attempts to convert the layout to Web Builder's internal object format.
- The import feature currently only imports text, images, form elements and body attributes (link colors, background images, meta tags). Tables, scripts, style sheets and multimedia components are not imported. But in most cases this is good enough to get you started.
- 90 Second Website Builder does not parse style sheets, so is some cases the text may look different than the original page.
- 90 Second Website Builder currently doesn't support framesets. If you want to import a web page that is using frames you'll have to import all individual pages separately.
- It is very difficult to support all different types of HTML. Even the popular browsers will interpret HTML differently, so don't expect miracles. If a page fails to be imported it probably contains code that 90 Second Website Builder doesn't understand and you still have to start from scratch.
- Importing web pages created with 90 Second Website Builder will give the best results!

Import page from another project

This option makes it possible to import page from another 90 Second Website Builder project.

Page HTML

In this window, the HTML generated by 90 Second Website Builder is displayed. To insert your own code, select the appropriate Tab. Select if the code should be inserted at the Start of Page, Between Head tag, Inside Body tag, Beginning of Body, End of body or End of page. The custom code will be displayed in the color blue.

Warning: When you insert code in the Page HTML window, make sure you do not include the <HTML>, <HEAD> or <BODY> tags. 90 Second Website Builder already generates these tags.
• **Start of Page**  
The HTML will be inserted before all other code on the page.

    <-- your html -->
    <!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"
    "http://www.w3.org/TR/html4/loose.dtd">
    <html>
    <head>
    ...
    </head>

• **Between `<head>`</head> tags**  
The HTML will be inserted between the `<head>`</head> tags.

    <head>
    ...
    <-- your html -->
    </head>

• **Inside `<body>` tag**  
The HTML will be inserted inside the `<body>` tags.

    <body attribute=value>

• **After `<body>` tag**  
The HTML will be inserted after the `<body>` tags.

    <body>
    <-- your html -->
    ...
    </body>

• **Before </body>**

    <body>
    ...
    <-- your html -->
    </body>

• **End of page**

    <body>
    ...
    </body>
    <-- your html -->
Page Properties
Set or edit the properties of the active page.
The property window of a page is subdivided into these categories:

- General
- Style
- Meta Tags
- Miscellaneous
- Events
**Site Properties**
Change the page properties of all pages within the current web site project. These values will also be used as the defaults for new pages. You can also launch the property categories individually (General, Formatting, Meta Tags, Internet Explorer and Misc). This can be useful if you only want to update the Formatting properties, without also affecting the meta tags and other categories for all pages.

**Note**
Some properties like page size, title and extension are unique for each page, so these cannot be changed for all pages at the same time. To prevent you from accidental changing them and overwriting the properties of all pages, these properties have been disabled.

**User defined variables**
This option can be useful to get global variables for the project, for example to quickly update the copyright or other value that regularly changes.
The variables will be replaced during publishing by the specified value. You can use this variable anywhere in the page, text or property values.

Example:
Name: `$COPYRIGHT$`
Value: BlackWire Marketing, LLC
This will replace any instance of `$COPYRIGHT$` in the project by 'BlackWire Marketing, LLC'.

**Site HTML**
Insert (Page) HTML code that will be included on all pages.
To include HTML code only for specific pages, use Page HTML.
To include HTML code on multiple pages, but not on all pages you can use Master Frames.
Page Properties - General

Title
Enter the title of the web page. This title will be displayed in the title bar of the browser's window and search engine results.

Menu Name
This name will be used for the item names in navigation bars and menu bars which have enabled the option 'Synchronize with Site Manager'. By default, the page name (as specified in the Site Manager) and the button name are the same, but this field allows you to use an alternative name for the item.

Page Width
Specifies the workspace width of the page.

Notes:
1. This value is not used by the browser, it's only an internal value used by 90 Second Website Builder to indicate the available workspace and to control the scrollbars when your screen size is not large enough to display the content of the page.
2. The Center in browser option uses this value to calculate the absolute center of your page, so if you've designed your page for a resolution of 800x600, make sure this value is set to 800 or else your page will not be centered!

Page Height
Specifies the workspace height of the page.

Note:
This value is not used by the browser, it's only an internal value used by 90 Second Website Builder to indicate the available workspace and to control the scrollbars when your screen size is not large enough to display the content of the page.

Target screen size
This option helps you determine the optimal page size for a specific screen resolution. It controls the page width/height properties. For example if you select '800x600', then the page width/height will be set to 770x600.
Why? Because you will have to leave some space for the vertical scrollbar, so you can't use the full 800 pixels for the page content.

File extension
Normally your web page will be published using the .html extension. In some cases it might be necessary to specify another extension like .php or .asp in case your page uses PHP or ASP.

Notes:
If you set the file extension to something other than .html, then your browser may not be able to preview the page. In order to preview PHP or ASP page, you must publish the page to a web server which can handle these page types.

After changing the file extension you will need to re-publish all pages link to it, otherwise the links will still refer to the old page name.
Document Type
The doctype declaration is an instruction for the web browser about what version of the markup language the page is written in.
Currently 90 Second Website Builder supports these document types:

**HTML 4.01 Transitional (default)**
The generated output will be HTML and compliant to the HTML 4.01 specification of W3C (just like in previous versions of 90 Second Website Builder).

**XHTML 1.0 Transitional**
The generated output will be XML and compliant to the XHTML 1.0 specification of W3C.

**HTML5**
The generated output will be HTML and compliant to the HTML 5 specification of W3C. For some features (like HTML5 events, CSS3 styles, this option needs to be selected)

Select document type 'None' if you don't want to include the doctype declaration in the page output. The generated output will be HTML 4.01 Transitional in that case.

Favorites Icon
You can use favorites icons (also known as shortcut icons) to display your logo or some other small graphic on the Favorites menu, address or page tabs of your browser. They are a great way to add brand recognition to your Web site.
A shortcut icon must be square in size, and at least 16 x 16 pixels. Consider creating both a 16 x 16-pixel icon as well as a 32 x 32-pixel icon (and larger, bandwidth permitting), since on high-DPI displays, the browser may stretch the icon to fit the available space.

To create the icon, use an icon editor, such as Axialis IconWorkshop, IcoFX or Microangelo Toolset and save the icon in the .ico file format.

Center page in browser window
Enabling this option will center the published page in the browser window.
Most professional web sites are designed so they will look good on different screen sizes. Because 90 Second Website Builder uses absolute positioning for all elements, they cannot be stretched over the full width and height of a page, because that would ‘scramble’ the contents of the page and this wouldn’t look good;

Here are a few tips for the designing your pages so they are displayed in the center of the browser:
- Set the Page properties to 1024x768
- Enable the Guide Borders and set them to the same size.
- Make sure all page contents stays between the guide borders. Notice that the center of the page is at pixel 512 on the horizontal ruler in this case.
- Enable ‘Center to browser’ in Page Properties.

Center page horizontally and vertically
This option allows you to center the web page both horizontally and vertically in the browser window. *If the content of the page is larger than the screen size, it will not be centered.* See also Center page in browser window.

Align to left, but include page width/height (recommended for eBay)
This option may be useful for designers who want to use their pages for eBay listings. The width and height attributes for the page will be added to the page style.
Don't Publish this page
Enable this option if you don't want this page to be published if you select Publish Entire Web Site.
Possible reason for this can be:
1. This page is currently not part of the website or still under construction
2. The page is only used as part of your other pages eg. Master Page.
3. The page is not changed so there's no need to publish it again.

Don't synchronize this page in Navigation Objects
When this option is enabled the page will not appear in navigation objects which automatically synchronize with the Site Manager.

Don't Include this Page in the Search Index.
When this option is enabled the page will not be included in the search index.

Don't Include this Page in the Site Map.
When this option is enabled the page will not be included in the site map.

Character Set
The character set tells the browser how to interpret and display the characters on your webpage. Depending on the language of the text on the page it might be necessary to force the browser to another character set. The most common used character sets are: ISO-8859-1 (ANSI) and UTF-8 (UNICODE).

Note:
This setting will not change anything to the way 90 Second Website Builder displays your pages. It will only be used by browsers.

Page Language
Specifies the language (Content-Language) of the page. Search engines may use this tag to categorize pages by language.

Note:
This setting will not change anything to the way 90 Second Website Builder displays your pages. This value will only be used by search engines.

Direction
Specifies the text direction for the content in the page. This can be either property set to 'left-to-right' or 'right-to-left'.

Make Default
Saves the current values as defaults for new pages.

Note:
You can also update the page properties for all pages at once using Menu->Page->Site Properties!
Properties - Style

Background mode
Specifies the background mode.

- **Transparent**
The background of the page will be transparent. Note that normally this means that page will be white, because you cannot look through the browser window...

- **Solid**
Use a solid background color.

- **Image**
Use an image as background.

  Repeat
  Sets the tiling attributes for the background image. Possible options are:
  - Repeat in both directions
  - Repeat in horizontal direction
  - Repeat in vertical direction
  - Do not repeat

  Horizontal Align
  Sets the horizontal position for the background image.

  Vertical Align
  Sets the vertical position for the background image.

- **Scroll Background**
The background will scroll with the rest of the page content (default).

- **Fixed Background**
A fixed background is a background image that will stay in one place while the rest of your text and images scroll over the top of it.

- **Stretch Background**
The background image will be stretched based on the size of the browser window while trying to keep the aspect ratio of the image.

- **Gradient**
Use a (two-color) gradient as background.
The gradient can either be horizontal or vertical. By default a background image will be generated for the gradient effect. However you can also use CSS3 gradients by enabling the option 'Use CSS3 gradients instead of images' in Tools->Options->HTML. Keep in mind however that not all browsers support CSS3 yet.

- **Multi color gradient**
Use a (multi-color) gradient as background. 90 Second Website Builder includes many predefined multi color gradient styles but you can easily create your own style with the Gradient Manager.

- **Pattern**
Use a pattern as background. A new image will automatically be generated for the pattern.

- **Texture**
Use a texture as background. A new image will automatically be generated for the texture.
Link Color
This specifies the default, unvisited hyperlinks color.

Visited Link Color
This specifies the color of a followed link.

Active Link Color
This specifies the color of an active link.

Hover Link Color
This specifies the color of all hover links of the active page.

Underline mode
Specifies whether links will always be underlined or only when the mouse is over the link.

Note: You can also control the colors of hyperlinks by using Hyperlink Style Sheets. For more information, see the description in the chapter 'Links'.

Default Font, Size and Color
Specifies the default font, font size and text color that will be used for text you enter in the page.

Theme
Specifies the (ThemeRoller based) theme for the page. This theme will be applied to all theme enabled objects like jQuery UI widgets. Besides jQuery UI widgets you can also enable theming for the menubar, navigation bar, tab menu, slidemenu, horizontal line. This way you can give you page a uniform look and feel. Themes can be created and edited with the Theme Manager.

Make Default
Saves the current values as defaults for new pages.
Page Properties - Meta Tags

Author
The author meta tag is used to indicate who the author of the web page is.

Keywords
The keyword meta tag can be important when it comes to some search engines. When these auto robot search engines index your site, some will look for a keyword meta tag to use as index words. When someone uses their search engine and searches on a word that is in your keyword meta tag list, your site will be included in the output search results.

Tip
The keywords are typically separated by a comma (,)

Description
The description meta tag can be important when it comes to some search engines. There are many search engines that will index your site automatically. Some of these search engines allow for a short description to be placed in their web page. If the search engines are looking in your web page for a description meta tag, it will use this description in the search index.

Categories
Specifies to which Categories the page belongs to. This meta tag is used by the SiteTree object to categorize pages.
Example: downloads, products, fun, business, personal etc.

Tip: You can assign multiple categories to a page. The categories should be separated by a comma (,)

Generator
Typically the name of the application used to create the page.

User defined
Here you can insert your own custom meta tags. These will be inserted before all other meta tags right after the <head> tag.

Example:
<meta http-equiv="Cache-control" content="no-cache">
<meta name="expires" content="tue, 01 Jun 2010 19:45:00 GMT">

Make Default
Saves the current values as defaults for new pages.
Properties - Misc

Master Frame
Specifies the page used for the Master Frame. The content of this page will be put inside the Content Place Holder of that Master Frame when the page is being previewed or published.
To remove a previous selected name, click the 'Remove' button. More details: Master Frames

Redirect
The Redirect property redirects the user to another page after a specific delay (by using the 'refresh' meta tag).

Redirect To
- Do no redirect
  Disables the redirect feature.
- Web Site
  Redirect the user to an external page.
- Internal page
  Redirect the user to a (internal) page of your website.

Redirect URL
Specifies the URL where the user will be redirected to.

Redirect Delay
Specifies the redirect delay. 0 (zero) means no delay.

Search Engine Optimization
Search engine optimization (SEO) is the process of improving the volume or quality of traffic to a web site or a web page from search engines.
The theory is that the earlier (or higher) a site appears in the search results list, the more visitors it will receive from the search engine.
These values may help improve your SEO, however modern search engines use more advanced techniques to index your website.

Robots
The Robots Meta Tag is used to tell search engines whether to index and/or crawl a page or not.

Revisit after
The Revisit Meta Tag is used to tell search engines when to come back next.

Expires after
The Expires Meta Tag is used to tell search engines when the page and content is no longer valid.
Overflow
These properties specify whether content is clipped when it overflows the browser window.
‘Overflow-x’ determines clipping at the left and right edges, ‘Overflow-y’ at the top and bottom edges.

- **none**
The overflow attribute will not be added to the page HTML. In this case scroll behavior may be
different for each browser type.

- **visible**
This value indicates that content is not clipped, i.e., it may be rendered outside the browser
window.

- **hidden**
This value indicates that the content is clipped and that no scrolling mechanism should be
provided to view the content outside the browser window.

- **scroll**
This value indicates that the content is clipped and that if the browser displays scrollbars.
This avoids any problem with scrollbars appearing and disappearing in a dynamic environment
where pages have different sizes.

- **auto**
The behavior of the ‘auto’ value is browser-dependent, but should cause a scrolling mechanism
to be provided for overflowing boxes.

Layout Mode

- **CSS layout**
The recommended layout mode. This mode will use CSS (absolute positions) to create the best
possible layout. All objects will be individually positioned, so you can overlap objects and place
them anywhere you like. It also results in very clean HTML code.

- **Table Layout (not recommended!)**
This mode uses (invisible) tables to position objects on the page. It does not allow objects to be
overlapped! This technique was used by web designers before CSS was supported by all
browsers.
Note that today all browsers do support CSS and table based layouts are considered old old
fashioned technology. However table layouts can be useful for News Letters because email
clients usually do not support CSS.
See ‘Creating Newletters’ later in this document for more details.

Use z-index for object order
By default all objects use the ‘z-index’ attribute to set the position in the z-order of the page. If for some
reason you do not want this, then you can disable this option.
Do not change this value unless you know what you are doing!

Disable Internet Explorer’s image toolbar
Normally Internet Explorer will place an Image Toolbar above images on a webpage that allows the user
to save or print the image. To stop the toolbar from appearing on the images of your site, enable this
option.

Compatibility
This option enables Internet Explorer to emulate previously versions of this browser. This can be useful
in case you experience display problems in IE that did not exist in previous versions of the browser.
**Properties - Events**
For more information about events please go read the chapter **Events**.

**Properties – jQuery Mobile**
The following page properties are only for mobile web pages.

**Theme**
Specifies the jQuery Mobile theme for the current page and all objects on that page. Themes can be edited with the Mobile Theme Manager.

**Swatch**
Each theme can have up to 26 variations (swatches). In the Swatch property you can select one of those variations.

**Use AJAX**
jQuery Mobile will automatically handle link clicks and form submissions through Ajax, when possible. If false, URL hash listening will be disabled as well, and URLs will load as ordinary HTTP requests.

**Transition**
Specifies the page transition. Page transitions only work if AJAX is enabled.
Insert

Most of the menu items are also available through the Toolbox. More details about the available objects can be found in 90 Second Website Builder objects later in this document. A few additional choices are available in the Insert Tab:

Select
The Select object is used to select objects. To select multiple objects, drag a selection box around them, or hold down the Shift key while you click them one at a time.

Symbol
Insert a symbol (special character) into a text object. This option is only enabled when you are in text edit mode.

Link
Opens a link dialog for the selected object or text. Check out chapter ‘Links’ for more details.
Format

Most formatting tools apply to text only. 90 Second Website Builder allows you to make all the same attribute changes you can make in (for example) MS Word. To edit the formatting of text you must first double click the text object to go into edit mode, then highlight the text you want to modify with the mouse and select formatting option.

Font Type
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New. To change the font type, select the font you want from the Font Type List Box on the toolbar.

Font Style
The style of the text can either be bold, italics, or underline. To change the font style, select one or more of the Style Icons on the toolbar.

Font Color
The color of the text can also be changed. To change the font color, select the Text Color Icon on the toolbar. The Color Dialog Box appears. Choose the color you want and click OK.

Background Color
To change the background color of the selected text, click the Background Color Icon on the toolbar. The Color Dialog Box appears. Choose the color you want and click OK.

Change Case->Sentence case
Capitalizes the first letter of each sentence of the selected text.

Change Case->Lowercase
Sets all selected text to lowercase.

Change Case->Uppercase
Sets all selected text to uppercase.

Change Case->Capitalize Each Word
Capitalizes the first letter of each word of the selected text.

Change Case->Toggle case
Toggles the case of each letter of the selected text.

Decrease indent
Decrease the left margin (indent) of the current text line.

Increase indent
Increase the left margin (indent) of the current text line.

Letter spacing
Sets the amount of additional space between letters in the text.

Line height
Sets the distance between lines in the object.

Font Size
To change the font size, select one of available HTML font sizes.
**Text Alignment**
You can change the alignment of the selected text object by using one of the alignment buttons: Left, Center, Right or Justify.

**Remove formatting**
Sometimes it can be useful to remove all formatting from a piece of text at once. Highlight the text and select Remove Formatting to reset all styles to its default values. Formatting removed from the text include bold, italic, underline, subscript, superscript, strikeout, text color and background color.

**Remove link**
Removes the link that was assigned to the selected text.

**Search in Google**
When you are editing text this command will search the selected word on Google. Your computer must be connected to the Internet.

**Look Up in Dictionary**
When you are editing text this command will look up the selected word on the website: http://dictionary.reference.com/
Your computer must be connected to the Internet.

**Styles**
In the Style Manager you can manage the styles of a project. By using styles you can modify the style of the entire website all in one place.

**General Styles**
In the General Style page HTML/CSS styles can be defined, such as text header styles (H1, H2, H3 ...) or form element styles. See also: Style Manager.

**Hyperlink Styles**
By default all hyperlinks in your webpage use the default HTML link colors as defined in the Page Properties. But by using Hyperlink styles you can set the style of individual links.
a) Create a new style  
b) In the (text) link properties select the style The style will be applied when you preview or publish the page.

**Gradient Styles**
Use the Gradient Style Manager to add/edit and remove global (multi color) gradients effects. Gradient effect can be used by Shapes, ClipArt, TextArt and other drawing tools.
Web safe fonts

Updated information for 90 Second Website Builder 10 and above:
You can now enable @font-face to be able to use non web safe fonts. More information is available on
the bottom of this page.

Web safe (or "web safe", "safe for the web") fonts are fonts that are common among all versions of
Windows, Mac, and Linux. We recommend using web safe fonts if you want your web pages to look the
same on all computers.

List of web safe fonts:
Arial
Bookman Old Style
Comic Sans MS
Courier
Courier New
Georgia
Impact
Lucida Console
Lucida Sans Unicode
MS Sans Serif
MS Serif
Palatino Linotype
Symbol
Tahoma
Times New Roman
Trebuchet MS
Verdana
Webdings
Wingdings

You can enable the option 'Tools->Options->Misc->Display web safe fonts only', so 90 Second
Website Builder will only display web safe fonts.
This may also increase the speed of the user interface, because not all fonts need to be loaded into
memory every time you want to select a different font.

Of course this font limitation is only for text based objects. So you can use other fonts for navigation bar
buttons, banners and other image based objects. Web Builder’s text object also has an option to publish
the text as an image.

Using @font-face
For a long time it was only possible to use a selected number of web safe fonts in your web designs.
However now you can use any font by enabling 90 Second Website Builder’s 'Use @font-face for non-
web safe fonts' option (Menu->Tools->Options->HTML)!
If you enable this option you will be able to use any type of true type font even if it's not web safe by
using a new CSS3 feature called @font-face. 90 Second Website Builder will automatically generate
the necessary code and upload the font to the server. It will even generated a secondary (eot) font file
required to make this feature work with IE!
Table
The Table Menu contains all the operations related to creating and modifying tables. Tables have
columns and rows of cells that can contain text (images, forms, or other page elements are not
supported at the moment). Tables are useful for the layout of data; they can be used to simulate
columns of text. When you type text in a table cell it expands horizontally and vertically to
accommodate the text that are typed or inserted. You can edit, format, and specify properties
(background color or image) for the text, as well as for the table cell, row, column, or table itself. You
can easily resize cells, columns, rows, or the entire table by the dragging borders.

Insert Table
Draw a box where you want to position the table.
The Insert Table dialog appears.
Enter the number of cells and rows required.
Enter layout and size details and click on OK

Insert Rows or Columns
Select this option if you need to insert additional rows and columns after a table has been created.
Specify if you want to insert Rows or Columns and enter the number of rows/columns to be added.
To insert a column to the left of a selected column, choose Left of selection.
To insert a column to the right of a selected column, choose Right of selection.
To insert a row above a selected row, choose Above Selection.
To insert a row below a selected row, choose Below Selection.

Merge Cells
Merge two or more adjacent cells. This command is only available when two or more adjacent cells are
selected on the same row.

Split Cell
Split the selected cell into columns.

Delete Column
Select this option to delete the selected column.

Delete Row
Select this option to delete the selected row.

Table Column Width
Set the column width for the selected column.

Table Row Height
Set the row height for the selected row.

Sort
Sort text (Ascending/Descending) of a table column or row.
Table Properties

Border Size
Enter how wide you want the border to be, in pixels.

Cell Padding
Enter how much space you want between the contents and inside edges of cells, in pixels.

Cell Spacing
Enter how much space you want between the cells in the table, in pixels.

Background color
Specifies the color of the form background. If set to 'Automatic' the webpage background will be used.

Background image
Specifies the optional background image.

Border color
Specifies the color of the table’s borders. If set to 'Automatic' the table will have a 3d border.

Table HTML
View generated HTML of the table. You can also insert your own HTML code!

Cell Properties
Edit properties of the selected cell:

Background Color
Specifies the color of the text background. If set to 'Automatic' the webpage background will be used.

Background Image
Specifies the optional background image.

Repeat
Sets the tiling attributes for the background image.
Possible options are:
- Repeat in both directions
- Repeat in horizontal direction
- Repeat in vertical direction
- Do not repeat

Horizontal Align
Sets the horizontal position for the background image.

Vertical Align
Sets the vertical position for the background image.

Cell HTML
View generated HTML of the selected cell. You can also insert your own HTML code!

Table Tips:
1. While resizing the table hold down the Ctrl-key to resize last column/row of a table with affecting the size of the other columns/rows.
2. To select multiple cells hold down the Ctrl-key while selecting the cells.
3. To select the whole row, move the mouse cursor to the left border of the first cell.
4. To select the whole column, move the mouse cursor to the top border of the first cell.
5. To change the properties of multiple cells in one action, first select the cells and then click Cell Properties.
6. To center an image in the middle of a cell, open Cell Properties, specify the background image, set Repeat to 'Do not repeat' and set Horizontal/Vertical Align to 'Center'.
**Arrange**
The arrange menu contains all operations related to the layout of the current page.

**Align**
- **Lefts**
  Aligns the left edges of the selected objects with the dominant object.

- **Centers**
  Aligns the centers of the selected objects with the dominant object

- **Rights**
  Aligns the right edges of the selected objects with the dominant object

- **Tops**
  Aligns the top edges of the selected objects with the dominant object

- **Middles**
  Aligns the middles of the selected objects with the dominant object

- **Bottoms**
  Aligns the bottom edges of the selected objects with the dominant object

**Space Evenly**
- **Across**
  Evenly spaces the selected controls horizontally

- **Down**
  Evenly spaces the selected controls vertically

**Center in Page**
- **Vertical / Horizontal**
  Centers the controls vertically or horizontally within the web page

**Make same size**
- **Width**
  Resizes the selected objects to have the same width as the dominant object

- **Height**
  Resizes the selected objects to have the same height as the dominant object

- **Both**
  Resizes the selected objects to have the same size as the dominant object

**Arrange**
- **Move To Front**
  Move object to front of the page

- **Move To Back**
  Move object to back of the page

- **Move Forward**
  Move object to next position in z-order

- **Move Back**
  Move object to previous position in z-order
**Group**
You can group multiple objects, so that they stick together when you move them. When you select one object of a group, the other objects will automatically be selected too. Grouped objects can not be edited until you ungroup them.

**Ungroup**
Ungroup objects.

**Merging Objects**
By using this option you can merge multiple objects into a single image! This can be useful for merging multiple (layered) shapes into a single image to reduce the number of published images and speed up loading times. This option will basically convert any object (or group of objects) into an image. So if this is used for objects like forms, buttons, menu then they will lose their original functionality, since they will be published as a static image.

**Tip:**
You can also use this option on a single object. This can be useful to convert an image or shape to another image format.

For example:
Let’s say you have applied a shadow effect to an image. The output format of the image will then be PNG. Now select 'Merge' from the menu. The image will be converted to an ‘merged object’, you can now select another output format like **jpg** which will result in a smaller output image.

Q: But wait…. what will happen to the transparency of the shadow?
A: The merged object will make a 'snapshot' of the background objects and use that as background image!

**Merge Objects**
Merge the currently select objects.
In the properties of this object you can specify the output format of the image.

**Split Objects**
This option will split previous merged objects.

**Rotate**
This command will activate the rotate mode. You can rotate image and shape objects.
For more information see also: Rotation

**Lock/Unlock**
This will 'lock' the selected objects, so that they cannot be moved or resized accidentally. Note that this will also prevent you from editing the objects properties unless you enable the option 'Allow locked objects to be edited' in the Tools->Options->Advanced configuration. To unlock the object again, repeat the same command.

**Lock All**
This will lock all objects in the active page.

**Unlock All**
This will unlock all objects in the active page.
**Guide settings**

**Snap to ruler guides**
Enable or disable snap to ruler guides

**Show Table Cell Outlines (if border = 0)**
When this option is enabled 90 Second Website Builder will draw table cell outlines even if the border is zero.

**Show Guide Borders**
Guide border can be useful when designing a web page for specific resolutions. If you make sure all objects stay between the guide border, the final page will fit in the desired window size.

**Show smart guides when objects are aligned**
Smart guides are dynamic guidelines that appear when you move objects into alignment with each other.

**Lock page size (no automatic page adjustment)**
Normally 90 Second Website Builder will automatically update the page size if you place an object outside the page borders. When this option is enabled the page width will be locked even if you place objects outside the border. If you want a larger workspace you will need to update the page width/height manually in that case (using Page Properties).

**Show Grid**
Show or hide grid.

**Snap to grid**
Enable or disable snap to grid. Use the Snap to Grid feature to align objects exactly. 90 Second Website Builder creates a "magnetic" attraction between the selected object and the grid.

**Grid Spacing**
Specifies the spacing between the grid dots.

**Show Tooltips while resizing and moving objects and guides**
Enable this option if you want to see the current position (while moving) or size (while resizing) of the current object in a tool tip above the mouse cursor.
It also works while moving ruler guides!

**Note:**
This option may cause objects to render a little bit slower during moving/resizing because the tooltip needs to be updated constantly.

**Edit Points**
This option can be used for Polygons and Curves to add, edit and remove nodes.
To start editing nodes, first select the Polygon or Curve and then select 'Edit Points' from the menu.
To edit existing nodes simply hold the left mouse button and drag it to its new position.
To add a new node, click anywhere on the line and drag the point to the desired position.
To remove a node, hold down the CTRL key and click the node with the left mouse button.
Ruler guides
Horizontal and vertical ruler guides are used to align objects on the page. Typically ruler guides are placed on the page by dragging them from the horizontal and vertical rulers or by specifying precise positions using the 'Format Ruler Guides' dialog box. Alternatively you can use the menu option 'Add Horizontal Ruler Guide' or 'Add Vertical Ruler Guide' to insert a new guide.

To move the ruler guide, position the mouse pointer over the guide, until you see the vertical or horizontal Adjust pointer and then drag the guide to its new position.

You can remove a single ruler guide or all ruler guides from a page. Position the mouse pointer over the ruler guide you want to delete until you see the adjust pointer and then drag it back to the ruler. Or you can use the 'Format ruler guide' dialog box to delete the ruler.

To remove all ruler guides in a page, select the Arrange menu, point to Ruler Guides, and then click Clear All Ruler Guides.

Objects which are placed close to a guide "snap to" the guide for easy alignment.
Tools

Asset Manager
The Asset Manager can be useful to modify the location of one or more assets (images, movies, sounds etc) without the need to open the properties of each item. You can select which group of items will be displayed in the Asset Manager (Filter).

To change the location of only 1 asset, simply select the item, click the 'Update' button and select the new location. To change the location of multiple assets, select the items, click the 'Update' button and select the new location. This means that you can update the location of all assets with just a few clicks!

It is also possible to move assets to another location. In that case a copy of the assets will be made to the specified location and update the path in the editor. Note that the original file will not be deleted!

Another cool feature of the Asset Manager is the ability to show all orphan files in the project folder. Select Filter->Orphan files to display a list of all the assets no longer used by the current project. Now you can select and remove those files from the project folder.

Backup Manager
Each time you save your project the software will automatically create a backup of the previous version of the project. The backup behavior can be configured in Tools->Options->Backup

The Backup Manager can be used to easily restore and delete automatically created backups. The Backup Manager will display the time and date of the backup and the filename. The back upped files will have file names like: myproject_01.wbs, myproject_02.wbs, myproject_03.wbs. The highest numbered file will always be the latest backup.

To restore a backup, select the filename and click 'Restore'. The file will then be moved back to the project folder and renamed to its original name.

Notes:
- The Backup Manager will override the current version of the project!
- A backup cannot be restored if the project is current in use. So close the project before using the Back Manager.
**Page Weight**

The Page weight tool helps you determine the estimated size and download time of a page. The tool will list all files which are part of page and their sizes. By selecting the connection speed you can get an idea how long it will take to download the complete page. Note that some files (like scripts, images) are used by multiple pages. They will be downloaded only once!

![Page Weight Tool](image)

**Verify Links**

This option scans your documents for links and displays them in a list. You can choose to edit them or press the **Verify** button to validate their current state.

Possible states:
- Not verified - not verified yet
- Validated URL - URL is valid
- URL not found - URL is not valid (or currently not reachable)

This tool can be handy when you want to verify all your links so you don’t have to verify them one by one.
Site Map
The sitemap tool creates an XML sitemap that can be submitted to Google and other search engines to help them crawl your website better.

A Sitemap is an XML file that lists the URLs for a site. It allows webmasters to include additional information about each URL: when it was last updated, how often it changes, and how important it is in relation to other URLs in the site. This allows search engines to crawl the site more intelligently.

It's important that you specify the full URL to your website, for example http://www.90secondwebsitebuilder.com/
This URL must begin with the protocol (such as http) and end with a trailing slash. You can specify the change frequency and priority for each page in your website.

Change frequency
How frequently the page is likely to change. This value provides general information to search engines and may not correlate exactly to how often they crawl the page.
Valid values are: always, hourly, daily, weekly, monthly, yearly, never

The value "always" should be used to describe documents that change each time they are accessed. The value "never" should be used to describe archived URLs.

Please note that the value of this tag is considered a hint and not a command. Even though search engine crawlers consider this information when making decisions, they may crawl pages marked "hourly" less frequently than that, and they may crawl pages marked "yearly" more frequently than that. It is also likely that crawlers will periodically crawl pages marked "never" so that they can handle unexpected changes to those pages.

Priority
The priority of this page relative to other pages on your site. Valid values range from 0.0 to 1.0. This value has no effect on your pages compared to pages on other sites, and only lets the search engines know which of your pages you deem most important so they can order the crawl of your pages in the way you would most like.
The default priority of a page is 0.5.

Please note that the priority you assign to a page has no influence on the position of your pages in a search engine's result pages. Search engines use this information when selecting between pages on the same site, so you can use this tag to increase the likelihood that your more important pages are present in a search index.

Also, note that assigning a high priority to all of the pages on your site will not help you. Since the priority is relative, it is only used to select between pages on your site; the priority of your pages will not be compared to the priority of pages on other sites.
The final step is to tell Google where it can find your sitemap.

The location of the sitemap will be something like:
http://www.yourwebsiteurl.com/sitemap.xml

**Customize**

This command will display the Customize window.
This option is for advanced users only and allow you to customize almost every menu, toolbar or keyboard shortcut of the application.
Users who are familiar with Microsoft Office products, will probably recognize most of the available settings.
Options
This command displays the configuration window of 90 Second Website Builder.

General Options
Create blank document at startup
Enable this option to create a new empty project when the application starts up.

Application window maximized at startup.
Enable this option to maximize the application window at startup.

Open the most recent used file at startup
Specifies whether to open the most recent used project at startup

Show splash screen
Enable this option to display the splash screen/copyrights image at startup.

Allow locked objects to be edited.
Locked objects cannot be moved or resized, but you can still edit their properties.

Determine Flash Movie size by finding the largest frame
This option tries to find the largest frame within a Flash Movie.
Note that some Flash Movie may have invisible frames which are larger than the actual movie size!

Use high quality rotation for images.
Enabling this option will increase the quality of rotated images, but it also makes the process slower.

Check for updates online at startup.
This option will connect to the 90 Second Website Builder website to check if there is a new version of the software available.
You can also check for updates in the Help menu: Menu->Help->Check for updates online.

Show page extensions in Site Manager.
Enable this option to display the extension of the page (html, php, asp etc) in the Site Manager.

Note:
You must restart the application before the page extensions will be displayed.

Automatically check for duplicated IDs when page is loaded.
Enable this option to automatically check for duplicated IDs when page is loaded, published or previewed. If the software find duplicate IDs then it will show a message with a link to Error Reports.

TextBox
Initial Text: Specifies the initial text of a text object. Default: Double click to edit

Do not show initial text, but directly go into edit mode when created.
If you enable this option then the initial text (Double click to edit) will not be displayed. You can directly start typing text into the box.
**HTML Options**

*Generate external CSS style sheets for page specific styles.*
Enable this option to generate a separate CSS file with the styles used by a page. The name of the file will be the same as the page name. So 'index.html' will generate a 'index.css' file.
Inline styles will not be part of the style sheet! So for the best results your objects should make use of styles created in the Style Manager.

*Generate single CSS style sheet for global styles.*
Enable this option to generate a single CSS file with all styles created in the Site Manager. All pages will refer to this file.
The global style sheet will not contain page specific styles (like menu bar styles).

*Optimize inline styles (experimental)*
This is an option which attempts to cleanup the HTML code by moving inline styles to the page's style sheet.

**Note:**
This option will process all HTML elements on the page, however not all (third party) extensions may support this behavior. So please test all functionality of your website before using this!

**Web Fonts (@font-face)**
- **Do not use @font-face (default)**
  No code will be generated to support non-web safe fonts.

- **Automatically use @font-face for non-web safe fonts.**
  If you enable this option you will be able to use any type of true type font even if it's not web safe by using a new CSS3 feature called @font-face. 90 Second Website Builder will automatically generate the necessary code and upload the font to the server. It will even generated a secondary (eot) font file required to make this feature work with IE!

- **Manually specify @font-face fonts.**
  In some cases it's necessary to manually configure @font-face. For example if it's not possible; to automatically determine the filename associated with a specific font or if you want to use separate files for each format. Enabling this option allows advanced users to manually link font files to a specific font.

**Notes about @font-face:**
- Be aware that font files can be pretty large, so they can add a considerable weight to the page.
- Make sure you check the license of the font you wish to use, as most fonts are not licensed to allow this kind of use. Making the font available on your server violates most end user licensing agreements.
- Unfortunately Internet Explorer requires a different font type (EOT instead of TTF), so the software will automatically generates the EOT version of the font. This means that you will end up with two versions of each font!!
• **Use Google Fonts for non web-safe fonts**

Enable this option if you plan to use Google Fonts in your project. If this option is enabled then the software will assume that all non web safe fonts you are using are Google Web Fonts and it will automatically generate a link to the font in the HTML code, so you do not have to do that manually. Note however that to use Google Fonts during design time you must have it installed on your computer!

Here’s how you can install a Google Font on your computer:


2) Find the font you want to use and add it to a collection (Click ‘Add to collection’). Take note of the font name, you will need it in step 6.

3) To be able to use the font on your computer you will have to download and install it so it will be available in 90 Second Website Builder (and other Windows software).

Click the “Download your Collection” link at the top of the Google Fonts website and you’ll get a zip file containing all the requested font(s) in TTF format.

4) Unzip the collection and and drag the TTF files to your Windows fonts folder. (In Windows 8: Control Panel\Appearance and Personalization\Fonts). The font(s) will now be available to all your Windows applications.

5) To see the font in 90 Second Website Builder, make sure the option ‘Display web safe fonts only’ is disabled: Menu->Tools->Options->Miscellaneous

Note: Some Google fonts require additional parameters. You can add those parameters by clicking the 'Manage' button. Next click 'Add' and select the font family. In the Parameters field specify the parameters.

Example:

```
&subset=latin,cyrillic-ext
```

or

```
:400,700,900&subset=latin,cyrillic
```
Use CSS3 gradients instead of images (when possible).
Enable this option to generate CSS styles for background gradients instead of images. This reduces the number of images generates for the page. Keep in mind however than not all browsers (especially Internet Explorer!) do support CSS3 gradient yet. Also note that not all gradients styles are yet supported, for in some case images still will be used.

Include page name in automatically generated ID attributes.
This option will add the page name to automatically generated ID when a new object is added to the page. So for example 'Image1' it will become 'indexImage1'. Where 'index' is the name of the page. This can be useful when you use lots of master pages in which case it will prevent duplicated ID attributes within a page.

Note:
This option does not change your existing ID's only for newly created objects!

Enable HTML encoding (based on the selected character set).
This will save the document encoded with the selected codepage. This is a new feature in version 7.5 in an attempt to generate (even) better W3C compliant HTML documents. This option should be enabled unless you are experiencing problems with character display in browsers.

Enable HTML beautifier
Formats the HTML code so it looks better and is easier to read.

Notes:
- This option will affect all HTML on the page. Including custom adding code and code generated by extensions!
- PHP and JavaScript will not be formatted.
- If this option is enabled it may take more time to generate the page.
- The size of the page will slightly increase because of the extra white spaces added to the page. But in general this does not affect the performance in the browser!

Enable URL encoding to prevent web unsafe file names.
Specifies whether to use URL encoding for file names. In general you should not use white spaces or other non-alphanumeric characters in file names, because it may confuse web servers and browsers (specially in combination with JavaScript). If you enable this option then the software will encode file names to prevent possible problems with invalid file names. Of course it's still better to make sure your filenames are valid before adding them to your website.

Use shared folder for assets (pages in folders will not have their own asset folder)
Enabling this option will share the asset target folder(s) for the entire website (including pages in sub folders!). This means that sub folders in the Site Manager no longer use a separate asset folder. Note that you can set the target folder for specific file types in Publish & Preview. If this option is disabled then each folder you create in the Site Manager will have its own asset folder.
**Files & Folders Options**

In the **System Folder** option you can configure where the software will store all user specific data, like extensions, templates, publish settings, gradients etc.

**Important:**

If you change the System Folder folder then this will also change the location where 90 Second Website Builder looks for extensions, templates, publish setting etc. So if you change the folder then make sure your also move all files to the new folder!

If you enable **Let 90 Second Website Builder manage images and other files used by a project**, then 90 Second Website Builder will make a backup copy of all assets (images, movies, sounds) which are part of your website to a folder relative to the project file, so all files will be stored in one place. The name of the folder will be the same as the project name. This means that if your project is called 'mywebsite', then all assets will be stored in the sub folder 'mywebsite'. Copying or moving your project to another computer is now as easy as copying the project file and its sub folder to another PC!

In the **Preview Folder** field you can change the default folder which is used for the preview files. This can be useful if you want the files to be copied to a folder of your local web server in case you generate PHP or ASP pages.

If the option **Remove preview files** is enabled, 90 Second Website Builder will remove all previously generated files the next time you select the preview option. This prevents that old files will be left behind and only new files exists in the preview folder.

**Warning:** This will remove all files from the specified folder! (not only the files that were previously generated by 90 Second Website Builder).

**Publish & Preview Options**

**Connection Timeout**, increase this value if you experience timeouts while connecting to the FTP server. Default is 30 seconds.

**Enable Logging**, enable logging when you have problems while publishing your web site. The log might contain useful information about the problem.

**Images name prefix**. Some objects such as shapes, navigation bar buttons will be published as (dynamically generated) images. These images do have an unique name within the website (eg img0001.gif, img0002.gif). With this option you can control how the images will be named. For example if you specify wbimage as prefix, the images will be named 'wbimage0001.gif' or 'wbimage0002.png'

It is also possible to make the name of the page part of the filename by enabling the option **Use page name for image prefix**, this makes it easier to keep track of which images belong to a specific page

**Target folder for File Types**

90 Second Website Builder can publish the images, scripts, swf, pdf, css and other files it generates to a separate folders on the web server. This will keep your web site organized.

If the web server does not support sub folders, then remove all file type from the list. In that case all files will be published to the same folder as the HTML files.

**Note:** The folders are relative to the folder of the HTML page. So if you have created folders in the Site Manager then each folder will have its own sub folders for the files!

**Preview Scope**, this option specifies the preview scope of 90 Second Website Builder. Select **Current Page** to only preview one page or **Entire Web Site** if you want to test your complete web site.

**Tip:**

Holding down the SHIFT key while previewing will 'invert' the current preview scope.
This means that if 'Current Page' is selected then holding de SHIFT key will preview the Entire Website'.

**Disable IE security warning during preview**

By default Internet Explorer will display a security warning if you try to preview web page stored on your local disk. And although this can be disabled in the settings of IE it might be more convenient to mark the page as 'safe for local preview'.

90 Second Website Builder will add the required code to the page to disable the warning. This code will not be included in the published page.

**Remove PHP code during preview**

Many of the advanced features of 90 Second Website Builder use PHP code. As you may know, browsers cannot interpret PHP code and usually will display errors or nothing at all! Previewing the layout of such a webpage on a server is not always convenient, so that’s why we introduced this option. If this option is enabled then all PHP code will be removed during preview, so you can view the layout. Of course you will still be to publish the page to a PHP enabled web server to fully test the (dynamic) behavior of the page.

**Note:**

During preview the software will rename the page’s file extension from .php to .html.

This means that if other pages link to this page then the browser will not find the page since it has a different extension.
**Misc Options**

**Language:** Use this option to specify the language used for the user interface. Default is English. Before a certain language is available from the dropdown list, you need to install the appropriate language module. Visit the website of 90 Second Website Builder to check for the available languages.

**User Interface**

Specify whether to use the classic menu and toolbars or the Ribbon interface.

**Docking algorithm for resizable bars:** Default or Visual Studio 2005 style. When Visual Studio 2005 style is selected, so called Dock Markers are displayed when you reposition windows like the Site Manager or Toolbox.

**Display websafe fonts only**

You can enable this option so 90 Second Website Builder will only display websafe fonts.

**Tab 'Close' button**

Specifies the appearance and behavior of the close button on the page tabs.

- **None**
  No close button on the tabs.
- **Active Tab**
  Close button is displayed on the active tab only.
- **Highlighted Tab (Compact)**
  Close button is displayed on the active and highlighted tabs. The space for the close button on non-active tab is not reserved.
- **Highlighted Tab**
  Close button is displayed on the active and highlighted tabs.
- **All**
  Close button is displayed on all tabs.

**Backup folder**

90 Second Website Builder can automatically make backups of your projects, before overwriting a previous version of the project.

Backup folder specifies the folder where the backup will be stored.

**Total number of site backups.** Specifies the number of backup to keep before overwriting them with newer versions. Enter 0 if you do not want 90 Second Website Builder to create backups.

90 Second Website Builder will name the backups like this: myproject_01.wbs, myproject_02.wbs, myproject_03.wbs

The highest numbered file will always be the latest backup. If the maximum number of backups is reached, the oldest backup will be deleted and all other backups will be renamed.

**Auto backup**

Enable this option to automatically make backup copy of your project every 5, 15, or 30 minutes. This may help you restore your work if your computer crashes unexpectedly.

The name of the backup will be myproject_autobackup.wbs and it will be stored in the backup folder.

**Make a backup of the project on the server.**

Enable this option to automatically make a backup of the project on the server. This may be useful if your computer crashes or your local projects become corrupted. In that case you will always have a backup copy on the server.

**Enable live HTML rendering of extensions.**

Some extensions use 'live HTML rendering' which means they create a live preview of the generated HTML code for the extension. And although this may be useful to get an idea what the final page will look like, it also can use lots of system resources (memory /processor time), especially when you are using many extensions in the same project. Disabling this option can reduce the memory usage and loading time of projects. It will have no affect on the generated output.
Enable debug logging (use for test purposes only!)
If you enable this option then extensions will create a log file with information that can be useful for debugging. This may help you or the developer of the extension to trace/solve problems.
The log file will be created in the extensions folder and it has the same name as the extension (extensionname.log).

The following information will be logged:
• Loading/uploading with version number.
• Properties, variables and values
• Dataset XML transformation (user input applied to XSL template)
• Gallery XML transformation
• Menu XML transformation
• Copying files to publish folder.
**Extension Manager**

Extensions (also called add-ons or plugins) are components which enhance the functionality of 90 Second Website Builder. Extensions can be accessed through the Toolbox or via the Insert menu just like the standard objects.

There is already a long list of official extensions and in the future we plan to release many more to make 90 Second Website Builder even more powerful than it already is. Some extensions are simply components with few parameters while other are almost complete applications by themselves! See also:

The Extension Manager helps you organize extensions. In the Extension Manager you can install/remove and update extensions. You can also search for extensions in the online gallery. The [Installed Extensions](#) page displays all extensions which are currently installed. If you do no longer need a specific extension you can remove it by clicking the 'Uninstall' button.

**Note:**

Please make sure that none of your projects uses the extension if you decide to remove a specific extension, otherwise you will no longer be able to load that project until you re-install the extension.

The Online Gallery page displays all extensions available for download and installation. If a new version of an extension that you already have is available online, then you have the choice to update it. Each time you open this window, 90 Second Website Builder will ask if you wish to download the most recent list from the website. Normally you will have to do this only once a week.

**Notes:**

The built-in Extension Manager only works correctly if the software can access our web server! If for some reason your firewall or virus scanner blocks access the Internet connection then you will not be able to use this feature. To fix this problem make sure 90 Second Website Builder is on the exception list of your firewall/virus scanner!

If you've recently purchased your license, it's possible that your registration information is not yet in the online database. IT MAY TAKE SEVERAL HOURS BEFORE YOU CAN DOWNLOAD THE EXTENSIONS! Please be patience.

The Manual Install page allows you to manually install extensions. Click the 'Install' button to select an extension file (*.wbx) or zip file. You can also drag & drop one or more extensions from Windows Explorer on this window! You can also manually install extensions by copying the .wbx file to the extensions folder: C:\Users\Your Name\Documents\90 Second Website Builder\system\extensions Where 'Your Name' is the name of your personal folder on the computer.

**Disclaimer:**

Extensions are made available as an extra service for registered users. They are not an official part of the software. BlackWire Marketing, LLC will not offer support for third party extensions and is in no way responsible for proper functioning of these extensions. All extensions are provided "AS IS" for those who find them useful. Of course we will do our best to make sure they work properly.
**Search Index**

90 Second Website Builder has basic built-in 'search engine' functionality, so visitors can search for specific words within your website. To make this feature available non-advanced users we decided to use Javascript as it does not require you to setup database and indexing service on the server. The downside is that it can be slower for larger websites (> 100 pages).

**Generate Search Index**
Enable this option to create the search index during publishing.

**Note:**
The search index is required if you want to use the 'Site Search' object on your website!

**Name of Index File**
Specifies the name of the search index file. Since this is a javascript file, it must have the .js extensions.

**Create Index from**
This option specifies how the search index will be created.

- **Page Content**
  The search index will be created from the content of the page. In this case 90 Second Website Builder will extract all text from the pages.

- **Meta tags**
  The search index will be created from the meta tags you've specified content in Page Properties.

- **Text Only**
  This will only index the text which result in a smaller/faster search index. In most cases this mode will be sufficient enough. Note that will also decrease the time required to create the search index during publishing.

**Exclude Stop Words from Index**
Enable this option to exclude stopwords.

90 Second Website Builder includes a predefined list of stopwords in the file 'search.dat'. To make your own list of 'exclude' words simply copy the file to 'My Documents\90 Second Website Builder\system\search.dat' and 90 Second Website Builder will use this file instead.

**Note:**
Stop Words are words which do not contain important significance to be used in Search Queries. Usually these words are filtered out from search queries because they return vast amount of unnecessary information.

**Use absolute links**
Enable this option if you want to use the search engine in sub folders. In that case absolute links must be used otherwise the links in the search results will not be using the correct path (because there is only one search index in the root of the website).

Example:
http://www.yourwebsite.com
Error Report
The Error Report tools will analyze the current page and check for errors like duplicated IDs, invalid filenames or other common problems.

Here’s a list of possible problems which are currently detected by error report tool:

Invalid filename
Names must contain only ASCII letters (a-z,A-Z), digits (0-9), underscore, dot and dash.

Empty ID
Make sure all objects have a valid ID.

Duplicate ID
All objects must have a unique ID property within the context of the page. This includes the objects on master pages!

Invalid HTML
Custom HTML may not contain <html> <<head> or <body> tags.

Invalid page extension
The page contains a form which requires PHP. Set the page file extension to 'php' (in Page properties)

Success page not specified
The success page property of the form cannot be empty.

Error page not specified
The error page property of the form cannot be empty.

Invalid page title
The page does not have a meaningful title. The page title is either empty or has the default 'untitled page' value.

Invalid page name
The 'index' page should not have uppercase characters in its name. 'Index' or 'INDEX' is invalid.

Form is using 'mailto:'
Using 'mailto:' in forms is unreliable. Please consider using the built-in form processor instead.

Text is not optimized
The text is not optimized for all browsers. Consider using one of the compatibility options.
Theme Manager

The Theme Manager provides an alternative way to create jQuery UI themes which are used by objects like jQuery Accordion, jQuery Tabs and many other jQuery based widgets. Normally you would create these themes via [http://jqueryui.com/themeroller/](http://jqueryui.com/themeroller/), but you can create awesome themes directly from within 90 Second Website Builder! The Theme manager uses the powerful ‘shape engine’ of 90 Second Website Builder to produce high quality themes.

To create a new theme click the ‘Add’ button. Now you can specific styles for each state of the jQuery widgets. There is the default state, the hover and activate states, and the content area. The content area may be the panel of a set of tabs or an accordion. You can also set the global font-family, font-style and the font-size. The corner radius specifies the roundness of the borders. In the right panel you can preview the result of the specified styles.

When you are done designing your theme click ‘Save’. The Theme Manager will now generate the CSS files and associated images. The files will be copied to the My Documents\90 Second Website Builder \sysytem\themeroller folder. If the theme already exists you will be asked to overwrite the current theme.

Note that if you save a theme with the same name as a standard theme then (like 'cupertino' or 'smoothness') then the custom theme will used by the software, although the original theme will not be overwritten or removed (because it's in another folder). This means that if you delete the custom theme, then original version will still exist. Original themes are located in C:\Program Files\90 Second Website Builder 10\themeroller

You can also create a new theme based on an existing theme by using the ‘Copy’ button. It’s even possible to import CSS themes generated by the theme roller website. Although this will only import the color scheme of course, because it not possible extract style data from images...
In Page Properties you can select the theme for a page (which then will be applied to all objects on that page). And although the Theme Manager was designed to create themes for jQuery UI widgets, other objects also support the themes! For example you can select 'Use page theme' in the menubar, navigation bar, tab menu and many other objects.

Of course you can also still use theme create on the ThemeRoller website: http://jqueryui.com/themeroller/. New themes must be installed in the ‘themeroller’ folder of 90 Second Website Builder: My Documents\90 Second Website Builder\system\themeroller

**Mobile Theme Manager**

Mobile Theme Manager introduces an easy way to create themes which are used to style jQuery Mobile Objects like buttons, menus, headers, footers etc.

A jQuery Mobile theme is a set of color swatches defining: text colors, background color and gradients and font.

You can define up to 26 color swatches, from A to Z. It supports many CSS3 properties, such as rounded corners, shadows, and gradients.

To create a new theme click the 'Add' button. Now you can specify color for each part of the jQuery Mobile widgets. You can also set the global font-family, border radius and shadows.

In the right panel you can preview the result of the specified styles. To modify the colors of another swatches, select the swatch letter (A-Z) in the property list.

When you are done designing your theme click 'Save'. The CSS files and associated images will be generated when you publish the website which uses the theme.

The theme definitions are saved in the file: C:\Users\Username\Documents\90 Second Website Builder\system\mobilethemes.dat

In 90 Second Website Builder you can select the theme for a (mobile) page in the Page Properties.
**Global Replace**
The Global Replace tool can be used to quickly change the color, font, URL or filename for all objects (or a selection) on the page or entire website.

**Pages**
Specifies whether to replace values on the current page only or on the entire website.

**Objects**
Specifies the object categories the find/replace will apply to.
For example: only replace a color value for form elements.

**Property**
Specifies what to replace:
- **Color**
  Replace a color value with another value.
- **File**
  Replace a filename. The tool will automatically list all filenames currently in use.
- **Font Name**
  Replace the font name. The tool will automatically list all font currently in use.
- **Font Size**
  Replace the font size.
- **URL**
  Replace an URL. The tool will automatically list all URLs currently in use.

Note that this action cannot be undone!
90 Second Website Builder Objects

In 90 Second Website Builder you create your website by dropping objects on the page. Most of these objects represent a standard HTML element. There are 2 ways to insert object to your page:

1. By using the Insert Tab.
2. By using the Toolbox

To insert a new object, select one of the available items and draw a box to indicate the position of the object. The new object will now be inserted to the page. To change the properties double the object or select Edit->Properties from the menu bar. It’s also possible to call the object’s properties using the keyboard shortcut ‘Alt+Enter’.

Tip:
Another way to add objects to your page is by simply dragging them out of the toolbox onto the workspace.
Style
Most objects have a style section in the properties window, here you can set the appearance of the object. Note that not all options do apply to all objects!

Predefined Style
Here you can select one of the global site styles. This option will overwrite all custom style settings for the object. You can add or edit styles in the Style Manager. Note that the <h1> ... <h6> are generally only used for text!

Background
Background mode
Specifies the background mode.

- **Transparent**
  The background of the object will be transparent.
- **Solid**
  Use a solid background color.
- **Image**
  Use an image as background.
  
  - **Repeat**; Sets the tiling attributes for the background image. Possible options are: Repeat in both directions, Repeat in horizontal direction, Repeat in vertical direction and Do not repeat.
  
  - **Horizontal Align**; Sets the horizontal position for the background image.
  
  - **Vertical Align**; Sets the vertical position for the background image.
- **Gradient**
  Use a (two-color) gradient as background. This option supports many different gradient styles like linear, ellipse, glass, glossy etc. By default a background image will be generated for the gradient effect. However you can also use CSS3 gradients by enabling the option 'Use CSS3 gradients instead of images' in Menu->Tools->Options->HTML. Keep in mind however that not all browsers support CSS3 yet.
- **Multi color gradient**
  Use a (multi-color) gradient as background. 90 Second Website Builder includes many predefined multi color gradient styles but you can easily create your own style with the Gradient Style Manager. Just like the standard gradient option it supports many different gradient styles like linear, ellipse, glass, glossy etc. By default a background image will be generated for the gradient effect. However you can also use CSS3 gradients by enabling the option ‘Use CSS3 gradients instead of images’ in Menu->Tools->Options->HTML.

- **Pattern**
  Use a pattern as background. A new image will automatically be generated for the pattern.

- **Texture**
  Use a texture as background. A new image will automatically be generated for the texture.

**Border**

**Style**
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. For many objects you can also set the individual style, width, color and radius for each side for the border! Select 'Individual style for each side' and then click 'Settings'.

- **Width**
  Specifies the thickness of the border around the banner. Set this to 0 (zero) for no border.

- **Color**
  Specifies the color of the border around the banner.

- **Radius**
  Defines the degree to which border corners will be rounded.

**Text**

**Font**
Specifies the font family of the text, such as Comic Sans, Times New Roman, and Courier New.

- **Style**
  Specifies the style of the text such as Bold, Italic or Regular.

- **Size**
  Specifies the size of the text.

- **Color**
  Specifies the color of the text.
**Bookmark**

Text and images can be set as bookmarks (also called "anchors") that can be linked to within a page. For example, if a page has several new items, the news titles for each item can be set as bookmarks and a row of links can be added to the top of the page that will each skip down to those bookmarked sections. This method of using bookmarks allows visitors to your site to quickly access information by not having to scroll down the page to view the information they want.

You can create a Bookmark by using the Bookmark tool from the Insert menu and place it anywhere in the page. Make sure you give the bookmark a unique name. Once you have placed the bookmark icon on your page, it can be selected from the Bookmark dropdown list.

You can read more about bookmarks in the ‘Links’ chapter.
Bulleted List

You can add a bulleted list to your web page to set apart a list of items from the rest of the page of text. The bulleted list is a combination of ordered (numbered) lists and unordered lists and supports the following styles:
Circle, Disc, Square, Numeric (1, 2, 3), Lower Alpha (a, b, c), Upper Alpha (A, B, C), Lower Roman (i, ii, iii), Upper Roman (I, II, III) and custom images.

- Item 1
- Item 2
- Item 3
- Item 4

To insert a bulleted list into your page select Insert->Bulleted List. Next select the initial number of items and the bullet style. Note that you can always change the bullet style to something else through the object's properties.

Other properties of the bulleted lists include Font, size, color and spacing and padding for the individual items.

**How do I edit the text of a item?**
Double click the item to edit the text. Formatting of the text works the same way as in a regular textbox.

**How do I insert a new item?**
Right click the bulleted list to display the context menu and select Insert Item.

**How do I remove an item?**
Right click the bulleted list to display the context menu and select Delete Item.

**How do I select the next item using the keyboard?**
Use the Tab key to go to the next item.

**How do I change the space between the bullet and the text?**
When you move the mouse cursor between the bullet and the text you can drag the (invisible) border to increase or decrease the spacing.

**Why does 90 Second Website Builder not use 'real' bullet tags in the output HTML?**
Bulleted list are not cross browser compatible. This means that all browsers have their own way of displaying lists all with their own padding, line-spacing and other specific offsets. It is impossible to generate a bulleted list using the standard <OL> <UL> tags in a way that is looks the same in all browsers. For this reason, we have decided to use tables to simulated look and feel of bulleted lists. This way we have much more control over the layout of the bulleted lists and we can be sure it looks (almost) the same of every browser.
**Horizontal Line**
The Line object is used to insert a horizontal line across the page.

**Line Color**
Specifies the color of the line.

**Use page theme**
Use the page theme to style the object. More details about themes: Theme Manager.

**Box Shadow**
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled browser.

---

**Note:** HTML does not have a vertical line object, but in 90 Second Website Builder, you can use the shape object or draw tools instead.
Image
To add images use the Image object. Drag the object to the page and a file dialog will popup to select the image. 90 Second Website Builder supports jpg, gif, bmp and png files.

Filename: enter the path and filename of the image/picture or select Browse to find an image on your local drive.

Notes:
1. This property specifies the location of the local image, when you publish the page the image will automatically be copied to location as specified in Tools->Options->Publish->Images Sub Folder.
2. You can also specify absolute URLs like this https://www.paypalobjects.com/en_US/i/logo/paypal_logo.gif
3. To make a (backup) copy of the images used in your page enable Tools->Options->Folders->Make a copy of images to this folder when documents are saved. This will copy all images to the specified folder, so they’re all stored in one place. It also prevents having duplicate image names in your web site.

Alternate text
This text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the mouse over the image.

Title
In modern browsers this title appears as a ToolTip when you move the mouse over the image.

Use original size
Select this if you want the image to appear at its original size.

Fit to layout rectangle
Select this if you want to manually specify the image size.

Border size
Specifies the thickness of the border around the image. Set this to 0 (zero) for no border.

Border Color
Specifies the color of the border around the image.

Border radius
Defines the degree to which border corners will be rounded.

Reflection
Specifies the amount of reflection.

Opacity
Change the transparency (0 - 100%) of the image.
Enable Shadow
Specifies whether to enable the shadow effect. A shadow with an x and y offset of 0 (zero) will produce a glow-like effect. Decreasing the blur factor of the shadow will make the edges more sharp.

Shadow Offset X
Horizontal shadow offset

Shadow Offset Y
Vertical shadow offset

Shadow Opacity
Sets the transparency of the shadow.

Shadow Color
Specifies the shadow color

Shadow Blur
Softens the shadow's edges.

Use CSS3 box-shadow
Enable this option to use native CSS shadow instead of generating a new image with the shadow effect. This option requires a modern browser with CSS3 support!

Rotation
See also the description 'Rotate an image' earlier in this document.

Links
For more details about linking please read the chapter about 'Links'.

Events
For more information about events please read the 'Events' chapter.
**Image Tools & Effects**

In 90 Second Website Builder, you can apply effects to images without having to open a separate image editor.

Available tools are:

- **Rotate**
  Rotate the image 90 degrees left or right.

- **Flip**
  Flip the image horizontally or vertically.

- **Contrast**
  Adjust the contrast of the image.

- **Brightness**
  Adjust the brightness of the image.

- **Resample**
  Re-sampling an image will change the number of pixels and therefore the physical file size of an image. Re-sampling will be done based on the current size of the image on the page. If the size is smaller than the original size, the physical file size is decrease. It it's larger the physical file size will increase!

- **Crop**
  By cropping an image, you can remove areas of the image that you don't want to use. While in crop mode drag the handles of the cropping box to resize and include the part of the image that you want to keep. Click Crop again to remove the area outside of the cropping box.

- **Slice**
  The slice tool is used for "Slicing" up your images into many smaller pieces you will not notice anything on your page because when it is previewed all the piece show as one. The logic behind slicing is that your images will load faster and it can also help to stop users from trying to steal your images if the try to they won't get one large image but just one small piece of it.

- **Hue/Saturation**
  Adjust the hue or saturation of the image.

- **Auto thumbnail**
  Use this option to quickly create a smaller thumbnail-sized version of the image. A hyperlink to the original full-size image will be added.

- **Set Transparent Color**
  You can create a transparent area in most images except in animated GIF images. Select the image you want to create transparent areas in. On the image toolbar or menu click 'Set Transparent Color'. In the image, click the color you want to make transparent. The Set Transparent Color option is available for images that don't already have transparency information. The image will be converted to the PNG format and will be published with a different name.

- **Add/Replace stencil**
  Stencils are a cool way to change the appearance of your images. Stencils can convert your images into any shape! Basically stencils replace the alpha channel information (transparency) of the image with the one from the stencil. You can create your own stencils and place the stencils in the sub folder ‘stencils’ of the program.

- **Save as Image**
  This option can be used to export the image to disk including all applied effects. You can export the image in JPG, GIF or PNG format.
Available effects are:

- Aquarelle
- Blue Print
- Blur / Blur More
- Buttonize
- Colorize
- Comic
- Cylinder
- Diffuse
- Droste Effect
- Edge Linear / Edge Non Linear
- Emboss / Emboss More
- Engrave / Engrave More
- Erode
- Fish Eye
- Flame
- Holga
- Impressionism
- Inner bevel frame
- Invert Luminance
- Jitter
- Gaussian Blur
- Glow
- Gold/Ice/Metallic effect
- Grayscale
- Laplace
- Median
- Mosaic Tiles
- Motion Blur
- Negative
- Neon Glow
- Night Vision
- Noise
- Oil Painting
- Old Movie
- Old Photo
- Pencil
- Pinch
- Pixellate
- Polaroid Stack
- Psychedelic
- Punch
- Replace Color
- Ripple
- Sepia
- Sharpen / Sharpen More
- Sketch
- Sobel
- Solarize
- Soften
- Soft Edges/Feather
- Splash
- Swap Color Channels
- Texture
- Thermique
- Threshold
- Tilt Shift
- Twirl
- Urban Ink
- Water Reflection
Things that you should know about effects:
1. You can apply multiple effects to an image.
2. Effects are non-destructive, which means they are not apply to the original image. A copy of the original image will be published to your website using an unique name (.png format).
3. Effects are applied to the image ‘on-the-fly’ when the images are loading into workspace and in the order you’ve added them. So for example if you apply Brightness 3 times, the images will be processed 3 times the next time you load your page.
4. Plan your effects! Do not add to many effects to images. This will slow down loading times of the image in 90 Second Website Builder. Before applying effects test which impact the effect has on the image, if you do not like it use undo the restore the original image.
5. Do not apply effects to very large images! The bigger the image, the longer it will take before the effect has been processed (just like in any other image editor!).
6. Resample can be used to decrease the size of the published image and therefore can increase the loading speed of your website. Of course resampling will also reduce the quality of the image.

**Watermark**

Watermark Tool is the powerful feature that allows you to quickly and easily protect your images with a visible watermark. With the many watermarking options available, you’re able to personalize your images in a variety of ways including text size, color, and position.

**Type**
- **None**
  The watermark tool will be disabled.
- **Standard**
  The text will be rendered in top of the image.
- **Inverted**
  The watermark effect will be inverted.
- **Embossed**
  This option will use an emboss effect for the text.

**Text**
Specifies the watermark text.

**Font**
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.

**Color**
Specifies the color of the text.

**Opacity**
Specifies the opacity/transparency of the text.

**Horizontal / Vertical Alignment**
Specifies the horizontal and vertical alignment of the text.

**Repeat Text**
Enable this option to repeat the text over the full image.
Marquee
The Marquee object is used to introduce text that scrolls.

A Marquee creates a scrolling display

Text
Enter the text to scroll. Text can include formatting and links.

Direction
This attribute controls the direction of scrolling.

Repeat
Number of times to repeat the scrolling (0=Continuously).

Delay
This controls the delay (in milliseconds) between the successive displays that give the impression of animation.

Amount
This controls the amount of movement (in pixels) between the successive displays that give the impression of animation.

Behavior
This attribute controls the behavior of the displayed text.

Pause scrolling on mouse over
Specifies whether to pause scrolling on mouse over.

Note:
Although the Marquee is not an official W3C complaint HTML element, most modern browsers do support it! Note however that W3C validators will complain about using this object.
Text
This object allows you to add text to the web page drag the object to the page and double click it to start typing your text. Use the Format Toolbar to change the font, size, color and other properties of the text. For the available formatting options please see Format Tools.
To insert a link in the text use the Link option. For more information about hyperlinks please read the ‘Links’ chapter of this document.

Most text properties can changed using the format toolbar or using the menu bar’s format item. You must first highlight text before you can change the formatting.

Note:
Although 90 Second Website Builder can display all fonts installed on your computer, it’s recommended that you only use web safe fonts so your web pages will look the same on all computers. You can read more about web safe fonts in the ‘Format menu’ section of this document.

The following properties can be changed using the Text Properties window (right click context menu):

Padding
Sets the amount of space between the object and its border.

Publish this text as an image
Converts the text to image when your page is published.
This option can be useful if you want the text to be displayed exactly as in 90 Second Website Builder, even when you selected fonts which are not web safe.
The text will be converted ti a GIF, JPG or PNG image.
GIF will use single pixel transparency.
JPG will use a solid background color since it does not support transparency.
PNG will result in the best (anti-aliased) quality for larger fonts, but the output image will be larger.

Include text in ALT attribute
If text has been converted to an image then search engines will not be able to ‘see’ this text. Select this option if you want the original text to be included in the alt attribute.

Compatibility/Output format
Unfortunately there is no way to make text look exactly the same in all browsers. Each browser uses its own text rendering engine and they are all slightly different. And although 90 Second Website Builder uses pixels to specify the font size, this still causes different results in different browsers.
To help you optimize your text so that it looks as good as possible is all browsers, we have added a few options to control the way the text is outputted in HTML. There are 3 output formats.

- Default /Classic Mode
  All code will be inside one div. This should be ok for most standard page layouts with not too much text.

- Use <div> for each line
  Each line will be embedded inside its own <div> with its own styling. This gives more accurate results in some occasions.

- Use <div> with position for each line
  Each line will be embedded inside its own div and includes position/size information (previously known as Optimized for Firefox/Safari mode). A common problem with Mozilla based browsers is that they do not handle large text blocks in combination with CSS absolute positioning very well. This option attempts to overcome this problem by breaking up the text into multiple <div> elements. This will result in better layouts, but also increases the amount of generated code.
Note that there is not really a preferred output format because it all depends on your layout, so you should try what works best for you. And test it in all popular browsers to find the optimal solution.

**Shortcut Keys**
The text editor supports the following shortcut keys:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Operations</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
<td></td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Center alignment</td>
<td></td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Justify alignment</td>
<td></td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right alignment</td>
<td></td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left alignment</td>
<td></td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td>Ctrl + ' (apostrophe)</td>
<td>Superscript</td>
<td>After pressing the short cut key, press the appropriate letter (for example a, e, or u). This applies to English, French, German, Italian, and Spanish keyboards only.</td>
</tr>
<tr>
<td>Ctrl + ~ (tilde)</td>
<td>Accent grave</td>
<td>See Ctrl+’ comments.</td>
</tr>
<tr>
<td>Ctrl + ; (semicolon)</td>
<td>Accent tild</td>
<td>See Ctrl+’ comments.</td>
</tr>
<tr>
<td>Ctrl + Shift + 6</td>
<td>Accent caret (circumflex)</td>
<td>See Ctrl+’ comments.</td>
</tr>
<tr>
<td>Ctrl + , (comma)</td>
<td>Accent cedilla</td>
<td>See Ctrl+’ comments.</td>
</tr>
<tr>
<td>Ctrl + Shift + ‘ (apostrophe)</td>
<td>Accent acute</td>
<td></td>
</tr>
<tr>
<td>Backspace</td>
<td>Accent grave</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Delete previous character</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Shift + Backspace</td>
<td>Delete previous word.</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Insert</td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Shift + Insert</td>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td>Overwrite</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Left Arrow</td>
<td>Move cursor one word to the left.</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Right Arrow</td>
<td>Move cursor one word to the right.</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Up Arrow</td>
<td>Move to the line above.</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Down Arrow</td>
<td>Move to the line below.</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Move to the beginning of the textbox.</td>
<td></td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Move to the end of the textbox</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Delete</td>
<td>Delete the next word or selected characters.</td>
<td></td>
</tr>
<tr>
<td>Shift+Delete</td>
<td>Cut the selected characters.</td>
<td></td>
</tr>
<tr>
<td>Esc</td>
<td>Stop editing text. Leave edit mode.</td>
<td></td>
</tr>
<tr>
<td>Alt+0xx (Number Pad)</td>
<td>Inserts Unicode values if xxx is greater than 255.</td>
<td>When xxx is less than 256, ASCII range text is inserted based on the current keyboard. Must enter decimal values.</td>
</tr>
</tbody>
</table>

**Lorem Ipsum**
Lorem ipsum is a placeholder text (filler text) commonly used to demonstrate the graphic elements of a web site, such as font, typography, and layout, by removing the distraction of meaningful content. 90 Second Website Builder has a simple built-in Lorem Ipsum Text generator to add placeholder text to the text object. You can either insert complete paragraphs or a specific number of words.

The text will be loaded from a file called loremispum.txt in the application folder. If you like you can edit or overwrite this file with your own custom text (for advanced user only!).
Form Wizard

Creating forms has never been so easy! Create complete forms in just a few steps. One of the many ways in which you can interact with people who visit your website is to get feedback from them through forms. Creating a form from scratch can be a rather difficult, so we've implemented the Form Wizard to make this task a little easier.

Step 1: How do you want to create the new form?

The 90 Second Website Builder Form Wizard has 3 methods to create a form:

1. **Create a new form based on a template**
   - This option allows you to select a template form, which you can use as the basis for your own form.

2. **Create a new form from scratch using the wizard**
   - Manually insert controls and labels to the form.

3. **Create a blank form so you can add controls later**
   - This inserts a blank form to your page with no controls on it. Basically this is the same as manually inserting an empty form area.

Step 2: Select a template form

We've included several ready-to-use forms to get you started. Please take your time to study the properties of each of these forms to get an idea how we've implemented them, so you can use this knowledge to create your own forms. For some forms you will need to modify the pre-defined values such as the specified email address or website URL.

There are 2 form processor templates where external websites are used to process the form data. Before you can make use of the services of these websites you will need to register first.

http://www.formbuddy.com/
http://www.mailmyform.com/

These examples can be useful if your website does not support PHP or any other type of form processing.
**Step 3: Add Control to the form**

In this step you can insert controls to the form. Each control can have a label which will be displayed in front of the control.

Click Add and select one of the items from the drop down menu to insert a new control. In most cases the wizard will ask you to enter a label name.

To modify the properties of the controls, select it in the list and click Edit to show the control’s properties.

You can re-arrange the items using the Move Up and Move Down buttons.

**Tip**

Make sure your form contains a Submit button. Without this button the user will not be able to submit the entered data!
Step 4: Where should the data be sent to?
When the user presses Submit, the browser sends the form data to a web server, so we need to specify where the data should be sent to.
One of the possibilities is 'Submit the data to an email address', although this is a very common method, it doesn't work reliably for all visitors to your site. Whether or not a visitor can use this method depends on the mail client installed on their computer. And unfortunately, there's no way to test if that's the case for each of your visitors. **We do not recommend using this method!**

Instead of using the Submit the data to an email address ("mailto") method, try using a remotely hosted CGI script like PHP, ASP or remote hosted solutions like [http://www.formbuddy.com](http://www.formbuddy.com) or [http://www.mailmyform.com](http://www.mailmyform.com). These services let you access a CGI script run off of their servers. You build your form as you normally would, but now you select **Submit data to a script on an external server** and fill in the URL of the remote CGI script. The CGI script translates your form into an email message and sends it on to the address you provide.

Alternatively you can create your own form processor and make the form processor script part of your 90 Second Website Builder website. In that case select **Submit data to a page within your website**.

In the tutorial section of our website you can find an example how to implement this using PHP: [http://www.90secondwebsitebuilder.com/videos](http://www.90secondwebsitebuilder.com/videos)

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some form templates use their own form processor script (usually added as a separate HTML object). In that case please do not change the predefined values unless you know what you are doing!</td>
</tr>
</tbody>
</table>

Templates that use a custom form processor include:
Dictionary lookup
Form processor: ASP
Form processor: Godaddy
Form processor: Tell a friend
Form processor: [www.formbuddy.com](http://www.formbuddy.com)
Form processor: [www.mailmyform.com](http://www.mailmyform.com)
Tell a friend
All PayPal templates
All search templates

<table>
<thead>
<tr>
<th>Important</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some form template use hidden fields to (for example) specify an email address or website. Make sure you replace these values with your own information!!! You can change the values of the hidden fields at any time later through the form's properties.</td>
</tr>
</tbody>
</table>

Use Built-in PHP form processor to send data to an email address.
Enable this option if you want to use the built-in form processor.
For more details about this feature in the Form chapter.

Encoding type
The required encoding type depends on the form processor script, so please consult the documentation of the CGI script for more info. In case you have selected a pre-defined form, the correct encoding type will be selected.
Form
A form provides a way you to collect information from the people who view your web pages. A viewer enters data or makes choices among several options and then submits the form. The results can be sent to you by email. If your web server has the right software, you can save the form results in a database.

Prefix:  
First Name:  
Last Name:  
Email:  
Will you be attending the event?: Yes  
Number of Guests: 1  
Send

The Form Area object is a container for FORM objects like buttons, edit boxes and checkboxes. You can add any standard form object to a form, including single- and multiple-line text fields, checkboxes, radio buttons, scrolling lists, and drop-down lists. You add objects to a form using the Form toolbar (Form Tools). You must place form objects inside a form to make them work as part of the form. Browsers display form objects differently, so test your form on all the browsers and platforms you plan to support.

How do I create a form in 90 Second Website Builder?
1. Drag the Form object to the page and a draw a box to indicate the position of the form.
2. Design your form by adding some Form controls to the form, for example: Button, Image Button, Advanced Button, Checkbox, Radio button, Editbox, Text Area or Combobox. You can also make text and images part of the form. You'll notice that all objects become a part of the form, so when you change the position of the form all those objects move along.
3. Make sure your form contains a Submit button (push button). Without this button the user will not be able to submit the entered data.
4. Once you have designed your form, you may need to set some properties. Select the form and choose Edit->Properties from the 90 Second Website Builder menu. The most important thing you need to do is specify the form action. For example to send the entered data to your email address, when the user presses the submit button: mailto:yourname@yourdomain.com

Note: Much more information about forms is available in the Frequently Asked Questions section of the website, in the online tutorials and on the video page:
http://www.90secondwebsitebuilder.com/videos
Form name
Enter a name for the FORM. This name is primarily used for advanced scripting.

Action
Required attribute, specifying the URL of a CGI script which processes the form and sends back feedback. There are two methods to send form data to a server. **GET** will send the form input in an URL, whereas **POST** sends it in the body of the submission. The latter method means you can send larger amounts of data, and that the URL of the form results doesn’t show the encoded form.

Example:
```
mailto:yourname@yourdomain.com
```
This will email the results to your email address using the visitors default email client.

**Note:** We do not recommend using the HTML’s ‘mailto’ feature. It is very unreliable and its behavior strongly depends on the type of browser and user preferences. When possible use the built-in PHP form processor or create your own processing script.

If your web server supports PHP then you can use the **built-in PHP form processor** which is probably the easiest way to implement form processing. Read more details about this later in this document.

If your server is not PHP-enabled, then you should contact your web host and ask them for the details on processing forms. Some servers offer server-side scripts that you can use, and if this is the case you’ll need instructions setting this facility up. Alternately you can use a remotely hosted solutions like www.formbuddy.com or www.mailmyform.com. These services let you access a CGI script run off of their servers. You build your form as you normally would, but now you fill in the URL of the remote CGI script. The CGI script translates your form into an email message and sends it on to the address you provide.

Accept Charset
Specifies which character will be accepted by the form. This can be useful for Unicode languages. This value also used by the built-in form processor.
Common values supported by most browsers are ISO-8859-1 or UTF-8.

Encoding type
Here you can specify an encoding type
the default of "application/x-www-form-urlencoded" is most widely supported.
An alternative is "text/plain", which is typically used in combination when the Action attribute points to a mailto: URL. If a browser supports both, the contents of the form is sent in plain text to the indicated recipient.

Use Built-in PHP form processor to send data to an email address.
After the user has entered the information in the form, you probably want to process it somehow. By default a HTML form does do anything with the data so you need to implement a form processing script. One of the great features of 90 Second Website Builder is that is has a built-in form processor. This implements all the basic features of a form processor like sending an email, saving it to a file on the server or even store it in a MySQL database.

Enable **Use Built-in PHP form processor to send data to an email address** option if you want to use the built-in form processor. This feature automatically generates a PHP script that will process the fields of your form and send it to an email address you specify. The form processing script will be inserted into the same page and you will be able to select a ‘thank you’ or successful page that will be displayed after the user has submitted the data.
Email address
The email address where the results of the form will be send to.

Subject
The subject of the email message.

Message
A short message that will be added to submitted data.
By default the message will be sent in plain text, but it's also possible to format the text. Click the 'Edit' button to change the format of the message. Select 'Rich text' to use the built-in editor to format the text (click the 'Edit' button to open the editor) or select 'HTML' to insert your own HTML code for the message (for advanced users!).

Success page (required)
The page that the user will be redirected to after the data has been submitted (after the 'submit' button has been pressed).

Error page (required)
The page that the user will be redirected to if an error occurred while processing the data.

Write form data to a .csv file.
This option will save the submitted form data to a comma separated data file on the web server. You open this file in Microsoft Excel, a text editor or import into a database.

Note that the data file must exist on the server and it must be writable!
90 Second Website Builder has a very useful option to automatically create this file for you and set the appropriate permissions. Simply click the 'Create' button next to the filename field and follow the onscreen instructions.

Step 1
Enter the name of the data file. For example 'formdata.csv'

Step 2
Select the publish location where the file will be created. 90 Second Website Builder will list all profiles you've created in the publish manager.

Step 3
90 Second Website Builder will connect to the selected location and display the folder structure on the web server. Select the remote folder and click 'Finish' to create the data file.

Upload files to a folder on the server.
If this option is enabled the built-in form processor will upload files to a folder on the server instead of sending them as attachment via email.
The files will be saved with an unique filename. The location of the uploaded file(s) will be included in the email message.
**Database (for advanced users only)**

You can use this option in combination with the built-in form processor to store form data in a MySQL database on the server. The generated PHP script will attempt to automatically create the table and fields based on the settings you configured, so you do not have to worry about creating it yourself. The database fields will be in the same order and use the same name as in your form design.

**Note:**
To view or process the submitted form data you will need a separate tool, like the standard MySQL admin tool. Please consult the documentation of your web host for more details.

**Write form data in a MySQL database.**
Specifies whether to write form data in a MySQL database.

**Database / Table**
Specifies the MySQL database name and table name.

**Username / Password**
Specifies the MySQL username and password.

**Server**
Specifies the MySQL database server.

**Auto responder**
We have added some basic auto responder functionality to the form processor. This allows you to sent a (thank you or confirmation) message to the user.

**From**
Specifies the 'from' email address for the email message.

**Subject**
Specifies the subject for the email message.

**Message**
Specifies the body text for the email message.

**Miscellaneous**
Enable **Include IP address in form data** to include the IP address of the computer form where the form was submitted in the message. The option **Process variables in Success Page** makes it possible to include form results in success page. This allows you to use variables in the text (or other parts of the success page) which will be replaced by the submitted values of the form.

**Example:** on the success page add a text object with this text:

```
The following data has been submitted to the online form:
Name: $name
Email: $email
Website: $website
```

Where name, email and website are the names of the form fields plus dollar sign. So if the field name is 'name' then the variable name will be '$name'.


Adding custom code to the form processor (for advanced users only!)
It is possible to add additional code to the form processor, this can be useful for inserting CC/BCC headers or to send another email, store to database etc.

Step 1
First make sure the option 'Use Built-in PHP form processor to send data to an email address' is enabled.

Step 2
Right click the form and select 'HTML' from the context menu.

Step 3
Notice that one of the tabs is called 'Custom Form Processing', here you can type your own code.
The code will be inserted just before the PHP mail() function:

```php
$body .= '--'.$boundary.'--'.$eol;
// your code will be inserted here!

mail($mailto, $subject, $body, $header);
header('Location: '.$success_url);
exit;
```

Important notes about the built-in PHP form processor:

- If the form contains an editbox named 'email', then this email address will be used as the 'from' address for the message. This field name is case sensitive! So do not call it Email or eMail.
- If the form contains one or more 'file upload' objects then the script will automatically attached these files to the email message.
- You MUST change the file extension on the page to PHP (in Page Properties), because PHP will be added to the page.
- You cannot preview/test a PHP page on your local computer unless you have a PHP web server installed. PHP scripts can only be tested once the page has been published to the server.
- Your hosting account must support PHP and the mail() function must be enabled, otherwise it will not work.
- You can have only one form per page.
- The z-order of the objects on the form determines the order of the items in the email message. You can change this order by using the Arrange tools or select 'Arrange Objects' in the form's context menu.
**Hidden Fields**
You can also add hidden fields that are not rendered but whose values are submitted with a form. Generally hidden fields are used to store information between client/server exchanges that would otherwise be lost due to the stateless nature of HTTP.

**Events**
For more information about events please read the ‘Events’ chapter of this document.

**Web Storage**
Web storage is a new feature of HTML5. It allows you to store field values between sessions or/and pages. This can be useful if you want to transfer values from one form to another.
Enable this option and 90 Second Website Builder will automatically store and retrieve all values for you!
Note that the ID of the objects will be used as the key for the value, so if you want to retrieve the values in another form (on another page) then it must have the same ID.

Local storage stores data with no time limit.
Session storage stores data for one session.

Note:
Web storage only works if you website is online. It works in all modern browsers.

**jQuery Mobile**

**Use AJAX**
jQuery Mobile will automatically handle form submissions through Ajax, when possible. If false, ordinary HTTP requests will be used.

**Transition**
Specifies the page transition when loading the success page. Page transitions only work if AJAX is enabled.

**Set Tab Order in Forms**
The option 'Set Tab Order' can be used to quickly set the Tab order in forms.
Here’s how it works:
1) First select the form.
2) Next select the 'Set Tab Order' option in the menu (also available in the context menu of the form).
3) 90 Second Website Builder will now display the current index of each form element that supports the tab index attribute. If the tab index is not set yet, it shows 'Not Set'.
4) Now click each object in the desired order. The new index will automatically be displayed.
Advanced Button

Inserts an Advanced Button object on a form. The Advanced Button gives you much more control over the appearance and behavior of a button. You can change the background color, use different fonts for the text or even activate JavaScript.

**General**

**Name**
Name of the button.

**Value**
Initial value of the button.

**Button Type**
- **Normal**: Normal (Push) buttons have no default behavior.
- **Submit**: When activated, a submit button submits a form.
- **Reset**: When activated, a reset button resets all controls to their initial values.
- **OnClick**: With this option you can associated a client-side script to the button.

**OnClick action**
Here you can specify which action if associated with the button OnClick event:
- Navigate to the specified URL; enter an URL as **OnClick value**
- Open a new window and load the specified URL Close the current browser window; enter an URL as **OnClick value**
- Reload; reload the current page (same as Refresh in the Internet Browser).
- Go to the previous page; the same as Back in the Internet Browser.
- Go to the next page; the same as Forward in the Internet Browser.
- Execute JavaScript function; specify a script function you've defined elsewhere in the page.

**OnClick value**
Depending on which OnClick action you've selected you enter the associated value here. For example for **Navigate to the specified URL** you enter an URL.

**Access Key**
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

**Disabled**
The disabled option disables the control for user input. Disabled controls do not receive focus.

**Tab Index**
All elements (except hidden elements) in a form are part of the form's tab order.

**Title**
Specifies the tooltip displayed by the browser

**Events**
For more information about events please read the ‘Events’ chapter of this document.
CAPTCHA

The CAPTCHA object was designed to work in combination with (PHP) forms. It helps to stop spammers from submitting form data automatically. CAPTCHA (an acronym for "Completely Automated Public Turing test to tell Computers and Humans Apart," ) dynamically generates an image with (random) letters and numbers. The letters, because they're part of an image and not text, are difficult for a spambot or other computer program to read. Yet, a person has little trouble reading the letters in a captcha image.

Tip:
The CAPTCHA object must be part of a form. And because it uses PHP, it can only be used/tested on a web server with PHP support! To be able to generate the CAPTCHA image the GD-library (version 2) must be enabled in your PHP setup. In some cases an error message may be displayed on your website. The message is will look something like this:
Warning: imagepng(): Unable to open './captcha.png' for writing in /../../captcha.php on line x
This problem may occur when the captcha script is placed in a folder on the website. The solution is to change the properties of that folder after publishing. The correct properties are 757 or 777. You can use the built-in FTP client to change the permissions of the folder.

Some web servers that do not allow to set the GDFONTPATH option. In that case you can disable this option in Menu->Tools->Options->HTML

CAPTCHA image

Width
Specifies the width of the image

Height
Specifies the height of the image

Font type
Specifies the font used for the letters/number of the image. Note that 90 Second Website Builder will upload the selected font to your website, so PHP can use it to generate the image.

Font size
Specifies the font size.

Background
Specifies the background color of the image.

Generate random background
This will generate a random background with polygons and lines in different colors which is more difficult to read by spam bots.

Enable text shadow
Adds shadow to the text, making it even more difficult to read for spam bots (but also for humans...).
**Editbox**

**Offset**
Specifies the offset between the image and the editbox.
Tip: If you enter a negative value, then the editbox will be positioned below the image!

**Access key**
This attribute assigns an access key to the object. An access key is a single character.
Pressing the access key gives focus to the element.

**Tab Index**
All elements (except hidden elements) in a form are part of the form's tab order.
When the user presses the Tab key, the browser shifts the input focus from element to element in order
the elements appear in the HTML code.
However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute.
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

**Validate**
For more information about validation please read the ‘Form validation’ chapter.
Checkbox

Checkboxes are on/off switches that may be toggled by the user. Use checkboxes if want to allow more than one item to be selected.

**General**

**Name**
Name of the checkbox.

**Value**
Value of the checkbox when it’s switched on.

**Initial state**
Initial state of the checkbox.

**Access Key**
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

**Disabled**
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the form.

**Tab Index**
All elements (except hidden elements) in a form are part of the form’s tab order. When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value ‘1’. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

**Validate**
For more information about validation please read the ‘Form validation’ chapter.

**Events**
For more information about events please read the ‘Events’ chapter of this document.

---

**Note:**
This control is normally part of a form.
Combobox

Used to allow users to make a selection from a number of different options.

General
Name
Enter an identifier for the field.

Note:
It's important to note that the element name must be in the form name[] for multiple selects! This way you’ll receive the selected values in an array (this is a PHP feature).

Type
- Combobox
  This will make the object a drop-down list. Only a single line is displayed at once.
- Listbox
  This will make the object a standard list box. Multiple lines are displayed at once.
- Datalist (HTML5).
  A datalist is a combination between a combobox and an editbox. The user can select data from a list or enter the value manually.

Allow multiple selections
Allows the user to select multiple items at the same time.

Elements
You can Add, Edit and Delete items that will appears in the list.

Add
Add a new item to the list.

Edit
Edit an existing item in the list.

Delete
Remove the selected item from the list.

Import
This option allows you to quickly import lists of predefined data. Select from many predefined values (countries, states, months, days etc) or import from an external file.

Import from external file
The file with items must have two items per line, separated by a semi colon: Item Text;Item Value

For example:
Afghanistan;Afghanistan
Albania;Albania
**Move Up**
Moves the selected item up one position in the list.

**Move Down**
Moves the selected item down one position in the list.

**Disabled**
The disabled option disables the control for user input.
Disabled controls do not receive focus.
Disabled controls are skipped in tabbing navigation.
The value of disabled controls will not be submitted with the form.

**Tab Index**
All elements (except hidden elements) in a form are part of the form's tab order.
When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute.
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

**Validate**
For more information about validation please read the ‘Form validation’ chapter.

**Events**
For more information about events please read the ‘Events’ chapter of this document.

| **Note:** |
| This control is normally part of a form. |
Editbox

**Enter a value**

Single-line field that can be used to add name/e-mail address fields.

**General**

**Name**
Enter an identifier for the field.

**Initial Value**
Value that is initially displayed in the field.

**Place holder (HTML5)**
Specifies a short hint to help the user to fill out the input field. The text will disappear as soon as the user enters some text.

**Max. Length**
Specifies the maximum number of characters a user can enter into the editbox.

**Type**

- **text**
  A plain text field.

- **password**
  Makes the editbox a password field so any text entry is displayed as asterisks.

- **color (HTML5)**
  The browser displays a visual color picker.

- **date (HTML5)**
  The browser displays a date picker.

- **datetime (HTML5)**
  Input field is for precise, absolute date and time stamps.

- **datetime-local (HTML5)**
  Input field is for local dates and times.

- **email (HTML5)**
  Input field is for email addresses.

- **month (HTML5)**
  The browser displays a month picker.

- **number (HTML5)**
  The browser displays a visual spin box.

- **range (HTML5)**
  The browser displays a range selector.

- **search (HTML5)**
  The browser displays a search input field.

- **tel (HTML5)**
  The browser displays a telephone input field.

- **time (HTML5)**
  Input field is a time input field.

- **url (HTML5)**
  Input field is for web addresses.

- **week (HTML5)**
  The browser displays a week picker.

**Note:** Currently only text and password fields are supported by all browsers. In other cases some browsers will simply display the default edit box.
Disabled
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the form.

Access Key
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

Alignment
Specifies the horizontal alignment of the input field.

Auto complete (HTML5)
Specifies whether the input field should have autocomplete enabled (if available in the browser).

Readonly
The readonly option prevents the user from changing the value of the field, but not from interacting with the field. The user can still highlight the text for copying for example. Readonly elements receive focus but cannot be modified by the user. Readonly elements are included in tabbing navigation. Readonly elements will be submitted with the form.

Tab Index
All elements (except hidden elements) in a form are part of the form's tab order. When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

Title
Specifies the tooltip displayed by the browser

Box Shadow
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled browser.

Padding
Sets the amount of space between the object and its border.

Validate
For more information about validation please read the ‘Form validation’ chapter.

Events
For more information about events please read the ‘Events’ chapter of this document.

Note:
This control is normally part of a form.
File Upload

This object provides a means for users to attach a file to the contents of the form. The element is rendered as a text field and an associated button, though in some browsers it may appear differently. For example: the text of the 'browse' button will be 'Choose' in Opera and 'Browse' in IE/FireFox. Also there is no way to control the size of the button or edit field through HTML.

Notes:
When using the built-in PHP form processor, the generated script will automatically take care of attaching the selected file(s) to the email message after the form has been submitted.

Most hosting services limit upload size to between 2 and 4 Mb. While you can control the upload limit by adding an hidden field called 'filesize' with the size in kB, it will nevertheless comply with the limits imposed by the hosting providers.

If you choose not to use the built-in form processor, then you must implement a script to handle file uploads yourself!

General
Name
Enter an identifier for the field.

Disabled
The disabled option disables the control for user input.
Disabled controls do not receive focus.
Disabled controls are skipped in tabbing navigation.
The value of disabled controls will not be submitted with the form.

Access Key
This attribute assigns an access key to the object. An access key is a single character.
Pressing the access key gives focus to the element.

Tab Index
All elements (except hidden elements) in a form are part of the form's tab order.
When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute.
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

Title
Specifies the tooltip displayed by the browser

Validate
For more information about validation please read the ‘Form validation’ chapter.

Note:
This control is normally part of a form.
Image Button

Inserts an Image Button object on a form. An image button is just like a Submit button. When the visitor of the page clicks on the Image it will perform the action associated with the form.

**General**

**Name**
Name of the button.

**Image:** enter the path and filename of the image/picture.

**Use original size:** Select this if you want the image to appear at its original size.

**Fit to layout rectangle:** Select this if you want to manually specify the image size.

The Image button acts the same way as a Button with the type set to: Submit

**Disabled**
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the form.

**Access Key**
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

**Tab Index**
All elements (except hidden elements) in a form are part of the form’s tab order. When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value ‘1’. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

If you want more control over the appearance and behavior of the button you can also use the Advanced Button

---

**Note:**
This control is normally part of a form.
Push Button

The push button will usually be used as submit or reset button on a form.
If the push button isn’t part of a form it doesn’t do anything by default.

**General**

**Name**
Name of the button.

**Value/Label**
Caption of the button.

**Button Type**

- **Submit**: When activated, a submit button submits a form. A form may contain more than one submit button.
- **Reset**: When activated, a reset button resets all controls to their initial values.
- **Normal**: Normal (Push) buttons have no default behavior.

Each push button may have client-side scripts associated with the element’s event attributes.
When an event occurs (e.g., the user presses the button, releases it, etc.), the associated script is triggered.

**Disabled**
The disabled option disables the control for user input.
Disabled controls do not receive focus.
Disabled controls are skipped in tabbing navigation.
The value of disabled controls will not be submitted with the form.

**Access Key**
This attribute assigns an access key to the object. An access key is a single character.
Pressing the access key gives focus to the element.

**Tab Index**
All elements (except hidden elements) in a form are part of the form’s tab order.
When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value ‘1’. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

**Events**
For more information about events please read the ‘Events’ chapter of this document.

**Note:**
This control is normally part of a form.
Radio button

Radio buttons are like checkboxes except that when several share the same name, they are mutually exclusive: when one is switched "on", all others with the same name are switched "off".

**General**

**Group Name**
The Radio Button will be part of this group. Radio buttons with the same group name will force the user to select one choice.

**Text**
Text that appears on the right of the radio button.

**Value**
Value of the radio button when it is selected.

**Initial state**
Initial state of the radio button.

**Disabled**
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the form.

**Access Key**
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

**Tab Index**
All elements (except hidden elements) in a form are part of the form's tab order. When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

**Events**
For more information about events please read the ‘Events’ chapter of this document.

---

**Note:**
This control is normally part of a form.
**TextArea**

A Text Area is a multi-line form field where the user can enter large amounts of text. Note: This object is normally part of a form!

**General**

**Name**
Enter an identifier for the field.

**Initial Value**
Value that is initially displayed in the field. When the form is submitted the new or edited text is entered.

**Disabled**
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the form.

**Access Key**
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

**Readonly**
The readonly option prevents the user from changing the value of the field, but not from interacting with the field. The user can still highlight the text for copying for example. Readonly elements receive focus but cannot be modified by the user. Readonly elements will be submitted with the form.

**Tab Index**
All elements (except hidden elements) in a form are part of the form's tab order. When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

**Title**
Specifies the tooltip displayed by the browser

**Box Shadow**
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled browser.

**Padding**
Sets the amount of space between the object and its border.

**Validate**
For more information about validation please read the ‘Form validation’ chapter.

**Events**
For more information about events please read the ‘Events’ chapter of this document.
ActiveX

You use ActiveX controls to embed an application in a Web page. ActiveX controls can add custom capabilities such as audio/movie players, calendars, custom buttons or other features to your pages. When using ActiveX controls make sure your site visitors use a browser that supports this. Draw a box to indicate the position of the ActiveX control. The Insert ActiveX Control dialog appears, listing the ActiveX controls currently installed on your system. At the bottom the selected ActiveX control's path (which has an .ocx or .dll extension) is displayed. To change the properties of the Active Control choose Properties. Available properties will be displayed in the window and can be changed by selecting the item and edit the value. Most ActiveX controls also have a native property page, which your can call using the Properties-button. Some ActiveX controls do not support HTML as programming language and will behave unexpected, so be sure you test it extensive before you publish your page.

Note:
The ActiveX component is not W3C compliant. It only works in older versions of Internet Explorer! We strongly recommend not using this component in your website. It’s only available for backwards compatibility with older versions.
File Publisher
This component automatically uploads the specified files to your web site and creates the folders once you publish this page. The files will be published to the same location as the page itself.

This object can be helpful if you want to include extra files which are part of the page (like scripts or multimedia files).

Add Files
Add one or more files to the tree.

Add Folder
Insert a complete folder and all files it contains from your local disk.

New Folder
Adds a new folder name to the tree.

Properties
Modify the properties (folder name or file location) of the selected item.

Remove
Remove the selected item from the folder tree.

Remove All
Remove all items from the folder tree.

Do not include files in Asset Manager
If the option ‘Let 90 Second Website Builder manage images and other files used by a project’ in Options is enabled then all files will be copied to the project folder by Web Builder’s Asset Manager. You can disable this behavior for this extension by enabling this option.

Note:
You can use drag & drop to re-arrange items.
Flash
With Adobe Flash files (.swf), you can create multimedia, graphics, and audio that downloads quickly. To view these files, site visitors must install the Flash plugin appropriate for their browser and platform. These plugins are available from the Macromedia Web site at www.macromedia.com. 90 Second Website Builder creates all of the code you need to add a Flash files to your site.

Movie
Enter a filename of the movie (.swf).

Alternative image
This image will be displayed if the browser does not support flash.

Version
This specifies the minimum Flash version number that the movie needs to play correctly.

Quality
To control the display quality, select a Quality option.
- **Low** favors playback speed over appearance and never uses anti-aliasing.
- **Autolow** emphasizes speed at first but improves appearance whenever possible. Playback begins with anti-aliasing turned off. If the Flash Player detects that the processor can handle it, anti-aliasing is turned on.
- **Autohigh** emphasizes playback speed and appearance equally at first but sacrifices appearance for playback speed if necessary. Playback begins with anti-aliasing turned on. If the actual frame rate drops below the specified frame rate, anti-aliasing is turned off to improve playback speed. Use this setting to emulate the View > Anti-alias setting in Flash.
- **Medium** applies some anti-aliasing and does not smooth bitmaps. It produces a better quality than the Low setting, but lower quality than the High setting.
- **High** favors appearance over playback speed and always applies anti-aliasing. If the movie does not contain animation, bitmaps are smoothed; if the movie has animation, bitmaps are not smoothed.
- **Best** provides the best display quality and does not consider playback speed. All output is anti-aliased and all bitmaps are smoothed.

Scale
To determine how the movie fits in the frame, select a Scale option.
- **Default (Show all)** makes the entire movie visible in the specified area without distortion, while maintaining the original aspect ratio of the movie. Borders may appear on two sides of the movie.
- **No Border** scales the movie to fill the specified area, without distortion but possibly with some cropping, while maintaining the original aspect ratio of the movie.
- **Exact Fit** makes the entire movie visible in the specified area without trying to preserve the original aspect ratio. Distortion may occur.

Autostart
To play the movie automatically when the site visitor opens the page, select Auto Start.

Loop
To replay the movie when it ends, select Loop.

Display Full Menu
When checked it will display the full menu, allowing the user a variety of options to enhance or control playback. When not checked it will only display a menu that contains only the Settings option and the About Flash option.

Window Mode
Specifies the window mode of the flash. Select **Transparent** if you want to display the flash movie with transparency. Otherwise select **Window** or **Opaque**.
Allow Script Access
The AllowScriptAccess parameter of the Flash Player controls the ability to perform outbound scripting from within a Flash SWF.
When AllowScriptAccess is "never", outbound scripting will always fail.
When AllowScriptAccess is "always", outbound scripting will always succeed.
When AllowScriptAccess is "samedomains", outbound scripting will only succeed within the same domain.

Allow Fullscreen
Enable this option to allow full-screen display of the Flash application. This option is supported by Flash 9.0 or higher.

Embed Adobe Flash Player content using SWFObject
SWFObject is a W3C standards-friendly method to embed Flash content, which utilizes one small JavaScript file.
If you enable this option, then 90 Second Website Builder will use the SWFObject script instead of the W3C incompliant <object> and <embed> tags.

Flash Variables
Flash variables (FlashVars) it a way to pass data or variables from html to a Flash application. FlashVars is supported by Flash Player 6 and newer. Please check the documentation of the Flash application for more details.
Flash Video Player

If you want to add movies to your page then Flash Video is probably the most reliable way to do this since most users will have the Adobe's Flash Player plug-in installed in their browser.

The Flash Movie Player is a player that can be used to play Flash Movies (FLV), but it also support many other formats like MP4 (also AVC), MOV, AVI, MP4V, M4V, F4V, VP6, VP7 and M4A (auch AAC, iPod), M4R (Audio/Ringtones for iPhone), F4A (Audio). It has many options to customize the appearance of the player.

**General**

**Video**
Specifies the video to be played.

**Image**
Specifies the 'teaser' image. This will be displayed if the video is not playing.

**Title**
Specifies the title of the video. This will be displayed in the player if the user click the 'Info' button.

**Description**
Specifies the description of the video. This will be displayed in the player if the user click the 'Info' button.

**Auto start**
To play the movie automatically when the site visitor opens the page, select Auto Start.

**Loop**
To replay the movie when it ends, select Loop.

**Show Info Button**
Specifies whether the 'Info' button should be displayed in the control bar.

**Show Fullscreen Button**
Specifies whether the 'Fullscreen' button should be displayed in the control bar.

**Show Scale Button**
Specifies whether the 'Scale' button should be displayed in the control bar.

**Show Volume Controls**
Specifies whether the volume controls should be displayed in the control bar.

**Show Time**
Specifies whether the time should be displayed in the control bar.

**Show Large Play Button**
Specifies whether the large play button should be displayed in the center of the player.

**HTML5**
To make sure your video also plays on devices that do not support Flash (like many mobile devices), you can enable the option Support both Flash and HTML5. The look and feel of the Flash Player will then be simulated by using HTML5 video, JavaScript and CSS. Note that not all browsers do support the same video formats. If you want to support as many devices as possible you should also include .mp4 and .webm versions of the video.

If you uncheck 'Show controls' then no controls will be displayed in HTML5 mode.
**Style**

**BackgroundColor**
Specifies the color of the background.

**WindowMode**
Specifies the window mode of the flash movie. Select Transparent if you want to display the flash movie with transparency. Otherwise select Window or Opaque.

**ButtonColor**
Specifies the color of buttons.

**ControlSpacing**
Specifies the spacing between controls.

**ControlBarColor**
Specifies the color of the control bar.

**ControlBarHeight**
Specifies the height of the control bar.

**DescriptionColor**
Specifies the color of the description.

**GradientColor**
Specifies the gradient color.

**SliderColor**
Specifies the color of the sliders.

**SliderHeight**
Specifies the height of the sliders.

**SliderTrackerColor**
Specifies the color of the slider tracker.

**TimeColor**
Specifies the color of the time.

**TitleColor**
Specifies the color of the title.

**TotalTimeColor**
Specifies the color of the total time.

**VolumeLength**
Specifies the width of the volume bar.
HTML
This object can be used to insert custom HTML code or JavaScript. When you add HTML using this object it will be placed at the location where you positioned the object.

Description
This is used for display in 90 Second Website Builder only. It can help you identify the code block you've added.

Type
The type property specifies how and where the HTML code will be inserted in the page.

- **Do not use <div>**
  Select this option to insert the HTML code “AS IS”, without size and position information.

- **Use <div> to set position and size of the HTML**
  Select this option to insert the HTML code inside a DIV container with size and position information added by 90 Second Website Builder.

  ```html
  <div style="left:100px;top:100px;width:200px;height:200px;position:absolute">
  <!-- your html -->
  </div>
  ```

- **Start of Page**
  The HTML will be inserted before all other code on the page.

  ```html
  <!-- your html -->
  <!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"
  "http://www.w3.org/TR/html4/loose.dtd">
  <html>
  <head>
  ...  
  <!-- your html -->
  </head>
  ```

- **Between <head></head> tags**
  The HTML will be inserted between the <head></head> tags.

  ```html
  <head>
  ...
  <!-- your html -->
  </head>
  ```

- **Inside <body> tag**
  The HTML will be inserted inside the <body> tags.

  ```html
  <body attribute=value>
  <!-- your html -->
  </body>
  ```

- **After <body> tag**
  The HTML will be inserted after the <body> tags.

  ```html
  <body>
  <!-- your html -->
  ...
  </body>
  ```

- **Before </body>**

  ```html
  <body>
  ...
  <!-- your html -->
  </body>
  ```

- **End of page**

  ```html
  <body>
  ...
  <!-- your html -->
  </body>
  ```
Overflow
This overflow can be used to control the overflow behavior of the layer.

- None
  The content of the HTML object is fully visible. No clipping will occur.
- Hidden
  The content is clipped, but the browser does not display a scroll-bar to see the rest of the content.
- Scroll
  The content is clipped, but the browser displays a scroll-bar to see the rest of the content.
- Auto
  If the content is clipped, the browser will display a scroll-bar to see the rest of the content.

HTML
Enter your custom HTML code here.

Notes:
1. For most objects you can add extra HTML before, inside of after the automatically generated HTML. Select an object and select Edit->HTML from the menu.
2. To add extra HTML before, inside of after the HEAD and BODY tags, select View->Page HTML from the 90 Second Website Builder menu.
3. If you need to add 'global' HTML to your page, it is better to add it using the Page HTML option.
Java
Java applets are an efficient way to add sound and animation, such as scrolling messages and other cool effects, to a page. Java applets are platform-independent applications with compact file sizes. Most browsers are Java-compatible, so site visitors don’t need special plug-ins to run a Java applet. The Java Object makes it easy to insert Java Applets to your page and set their properties. To choose appropriate properties settings, you should be familiar with Java before you add these types of application files to your site.

You can download JAVA applets from one of these web sites:
http://www.jguru.com/

Follow the instructions that come with these applets for more information about the parameters and other settings.
Inline Frame

Inline Frame or an iframe is allows you to open new pages inside main pages. Inline frames are also referred to as Floating frames.

General

Name
Used to set a name for the inline frame.

Link to

Web Site: display a page from an external web site. Syntax: http://www.google.com

Internal Web Page: display one of the pages of your web site.
Click 'Select' to choose a page. The Select Page window will show all the pages which are part of the current web site project. 90 Second Website Builder will automatically create to correct (relative) URL when you publish your pages.

Show border
Used to specify the whether to have a border for the inline frame or not.

Scrollbars
Used to specify whether the inline frame should have scrolling capability or not. Possible values: If Needed, Never or Always.

Alternate text
This text will be displayed by browsers which do not support inline frames.

Appearance

Scrollbars
Used to specify whether the inline frame should have scrolling capability or not. Possible values: If Needed, Never or Always.

Border Color
Specifies the color of the border around the inline frame. Set the color to 'Automatic' to display the standard 3D border.

Border Size
Specifies the size of the border around the inline frame. Set this to 0 (zero) for no border.

Lightbox
The Lightbox option makes it possible to display another page in a lightbox (using FancyBox) after clicking on a preview image. You can specify the preview image, lightbox title and width/height of the lightbox.

Box Shadow
Configure box shadow (also called drop shadow) for the inline frame. This feature requires a CSS3 enabled browser. It will not work in combination with the lightbox feature.
Layer
Layers can be used to create advanced layouts. A layer is a container for other objects. Objects can be dragged and dropped on a layer just like on a form.

Some of the cool features of layers are:
- 0...100% transparency
- Show/Hide a layer (and all its contained objects) using the layer manager or through events.
- Position and size a layer relatively
- Position a layer absolute to the right and/or bottom border of the browser window
- Several background repeat and alignment options.
- Sticky layer mode, keeps a layer visible at all times.

Opacity
Change the transparency (0 - 100%) of the layer (and all its children).

Overflow
This overflow can be used to control the overflow behavior of the layer.

- None
  The content of the layer is fully visible. In this case the size of the layer cannot be smaller the content.
- Hidden
  The content is clipped, but the browser does not display a scroll-bar to see the rest of the content.
- Scroll
  The content is clipped, but the browser displays a scroll-bar to see the rest of the content. This can be useful to create scrollable content without the need for an inline frame!
- Auto
  If the content is clipped, the browser will display a scroll-bar to see the rest of the content.

Note:
To create/update the content of the layer, you must resize it in the designer so all objects will be visible. After you’ve created/updated the layout you can resize the layer to the desired size.
You cannot scroll the contents of the layer inside 90 Second Website Builder.
Layer Mode
The Layer has 3 modes. The Default mode, Sticky Layer Mode and a Header/Footer mode.
In Default mode the layer will be positioned on the location where you've placed it during design time. If Sticky Layer mode keeps a layer visible (top/bottom/left/right) at all times. This can be useful if you want to keep a menu or image visible even if the page scrolls. Animation is also an option!

The Header/Footer mode can be useful if you are using the layer as a header or footer for your page usually in combination with the ‘relative horizontal resizing’ option.
Normally the ‘relative horizontal resizing’ (and the other relative options) will add the code after the <body> container resulting in a higher z-index. Selecting 'Header/Footer' mode will insert the code before the <body> container, so the layer will be behind all other content.

There is also the Docking layer mode which allows you to dock a layer to a specific side of the screen or in the center of the screen. The main difference between this mode and the sticky layer mode is that Docking layer mode does not use JavaScript, instead it uses standard CSS techniques. It’s just another way for you to use layers and this mode can also be useful for full page headers and footers.

With Anchored Layer you can anchor one or more sides of the layer to the sides of the page. For example if you enable ‘Anchor Left’ and ‘Anchor Right’ then then the layer will stretch if you resize the browser window (the offset to the left and right page border will remain the same).
But you can also anchor just one border (or all).

Floating Layer mode is for advanced usage. It will make the layer 'float' instead of having a fixed position. If multiple floating layers are placed on the page then they will be placed next to each other (from left to right) depending on the available screen space. If the layer does not fit on the current row then it will be wrapped to the next row. This feature may be useful (for advanced users) to create responsive websites.

The option Floating mode can be used to control the 'float behavior':
- **Default**
  The layer will be positioned to the right side of the previous floating object. If the object does not fit on the current row then it will move to the next row.
- **Clear Left**
  The layer will be forced to the next row. The layer can have other objects on the right side of the row (unless the next floating object is also set to clear left).
- **Full Width**
  The layer will use the full width (100%) of the page. No other objects can be on the same row.
  This mode can be useful for headers or footers.

Modal Layer mode will position the layer on top of everything. Other items on the page will be disabled until you close the layer. Basically this converts the layer to a jQuery Dialog but without the theming.

A Panel Layer is initially invisible, but can slide from the right or left side of the page by using events (show/hide). Display, specifies the relationship of the panel to the page contents. “Push” pushes the page over and “overlay” display the layer over the content. Dismissible, specifies whether the panel can be closed by clicking outside onto the page.


**Default Mode**

**Relative horizontal position**

Instead of using absolute coordinates, the position of the layer will now be relative to the page width. This property only has effect when the page is displayed in the browser!

**Relative vertical position**

Instead of using absolute coordinates, the position of the layer will now be relative to the page height. This property only has effect when the page is displayed in the browser!

**Relative horizontal sizing**

Instead of using absolute dimensions, the width of the layer will now be relative to the page width. This property only has effect when the page is displayed in the browser!

**Relative vertical sizing**

Instead of using absolute dimensions, the height of the layer will now be relative to the page height. This property only has effect when the page is displayed in the browser!

**Right**

Sets the position of the object relative to the right edge of the page. This will replace the 'left' attribute.

**Bottom**

Sets the bottom position of the object in relation to the bottom of the page. This will replace the 'top' attribute.

**Alignment**

Specifies the alignment of the content of the layer if Relative horizontal sizing is enabled.

- **Left**
  The content will be left aligned (default).
- **Center**
  The content will be centered.
- **Right**
  The content will be right aligned.
- **Stretch content**
  This will position and size child object relative to the layer. This option can be used to created stretchable content. Where the size of the objects is based on the size of the browser window.

**Notes about stretching content:**

This feature was primarily designed to be used for header and footers that will cover the complete width of the page.

This option will only work for simple HTML objects like images, shapes, text. It will not work for advanced objects like menus, extensions, blog, galleries etc. These objects cannot be stretched.

Stretching images may have effect on the quality of the image.

---

**Sticky Mode**

**Orientation**

Specifies to which side of the browser window the layer will 'stick'.

You can use the offset values to set the horizontal and vertical offset from the borders.

The Delay value specifies the animation delay.
Master Objects

Master Objects is a very useful feature, which allows you to re-use objects from another page (from your web site) in the current web page. A 'Master Objects' object is basically a pointer to the objects of another page (eg the 'Master Page'). These objects will be embedded in the page exactly as they are on the original page. You can even use multiple master page objects on a single page!

Let’s say you have a certain layout which is the same for all your pages and you don’t want this copy/paste it between all your pages; then simply create the layout once in page and insert the layout of that page in all your other pages using the master page object. When you want to update the layout you will only have to do this once in the original page.

Here is an example:

1. Create a new website, 90 Second Website Builder automatically add the first page called 'index'.
2. Insert a new page using the Site Manager and rename it to 'master_page'.


4. Switch back to the index page (click on the index tab) and insert a ‘Master Objects’ object.
5. Double click the object you have just inserted to select a page. Next click the Select-button to display the Select Page window and choose master_page from the list. Click OK to return to the page.

![Master Page Properties](image)

You will notice that the navigation bar of your master_page now has become a part of the index page. If you go back to the master page and you modified something in that page, it automatically is updated in the index page as well. Of course, this feature is not limited to navigation bars only; you can add any element to the master page.

**Notes:**

1. Place all objects on the master page aligned to the left and top border, so you do not have any margins.
2. If you use the master_page only for master page purposes and not as standalone page, you can enable 'Don't Publish this page' in Page Properties, so the page won't be published when the entire website is published.
3. In contrast to inline frames, when using the Master Page object, all objects from that page are merged in the current page as if they are really a part of the page. You must however edit them in the master page.
4. Master page objects do not clone the properties of a page! Only objects on the master page will be cloned.
5. Since the objects are cloned "AS IS", make sure the IDs of objects on the master page are unique. You can change the ID in the Properties Inspector. It's good practice to give them a prefix, like 'master_'. This will prevent duplicated IDs on a page.
6. Forms do not work on a master page.
7. Layer can be used on a master page. However you cannot use internal links on that layer.
8. The master page should be in the same folder as the pages than are using it. This is especially important if you are using internal links, because the links will be relative to the master page so if the page is in another folder then they are not valid.
9. The option 'Use hover state style to indicate the current page' in navigation tools will not work in combination with master objects, because there will be only one set of images for that object. The same images will be used on all pages.

**Embed master objects as a layer**

When the "Embed master objects as a layer" is selected, all of the elements that make up the master page are, in fact, on a layer. This layer will block access to any page elements "beneath" it (in the z-order). If the master objects layer is on top of a button or link, visitors to your site will not be able to click on the button or link even if it is visible.

When the "Embed master objects as a layer" box is unchecked, the elements that make up the master page are inserted as individual objects on the page (not on a layer). You can then access any objects "beneath" the master objects (as long as they are visible).
Content Place Holder

The Content Place Holder object should be inserted on a Master Frame page. It defines where the content of the page will be inserted.

Overflow

Specifies what will happen if the content of the page is larger than the size of the content place holder.

- **Expand**
  The place holder will automatically expand so that the content will fit without the need for scrollbars. All objects below and on the right side of the place holder will be repositioned.

- **Hidden**
  Content that does fit inside the place holder will be hidden.

- **Scroll**
  Scrollbars will be added if the content does not fit inside the place holder.

Align

Specifies how the content of the page will be aligned inside the place holder if it's smaller than the size of the content place holder.

Master Frames

A Master Frame is a design concept where your website has a constant frame and only the inner part of the pages changes. In 90 Second Website Builder you only have to design the frame once and then reuse it in all other pages. You can even automatically expand the layout if the content is larger than the content place holder! If the content is smaller than the place helper there is also an option to center it in the area.

A master frame page can be any page in your website. To indicate the position where the content of the master frame must go, you must insert a Content Place Holder object to the master frame page.

During preview/publish this content place holder will be replace with the actual content of the page.

To indicate that a page must use the master frame, you must configure it in the Misc settings of the Page Properties.

The master frame and content page will be merged into one page when it is preview/published. Note that the footer has been automatically repositioned because the page content was larger than the content place holder! All objects below and at the right side of the content place holder object can be repositioned automatically. You can also select to display scrollbars instead.
Result in browser window, the master frame merged with the content of the page.

Notes:

- The objects on a master frame are cloned "AS IS", so make sure the IDs of objects on the master page are unique.
- You can change the ID in the Properties Inspector. It’s good practise to give them a prefix, like master_, this will prevent duplicated IDs on a page.
- We do not recommend using a master frame as part of another master frame to prevent infinite loops.
- The option 'Use hover state style to indicate the current page' in navigation tools will not work in combination with master objects, because there will be only one set of images for that object. The same images will be used on all pages.
- The master frame should be in the same folder as the pages than are using it. This is especially important if you are using internal links, because the links will be relative to the master frame so if the page is in another folder then they are not valid.
Embedded OLE Object
You can use linking and embedding to exchange information between documents created in different programs.

Embedding means inserting information, such as text or a graphic, into another document in another program. The embedded information, or object, becomes part of the new document. To edit an embedded object, double-click it; the program in which the object was created opens. When you finish editing the object and return to your document, the document reflects all of the changes you've made; but, the original object remains unchanged.

Linking means inserting information, such as spreadsheet data, that retains a connection to the information stored in another file. Use linking when you want the information to be updated dynamically as the data in the source file changes. To link selected information, use Copy and Paste Special. Some programs do not support linking.

Use embedding when you want to edit the information separately from the source file or if you think the source file will be unavailable.

When you publish a page, which includes an embedded OLE object, 90 Second Website Builder generates each object as a .gif file. So the data becomes static once it is published.

Tip: If you double click the object while holding down the CTRL key, it will open the embedded application in a new window.
Notes

'Notes' is a design-time only object. It's an easy way to 'drop' notes/comments on the page. For example to include notes for another designer or other reminders.

The object supports the same formatting as the Text object. However the content of the object will not be included on the published page. You can quickly show/hide all notes with the 'Notes' option in the view menu.
Page Footer

The Page Footer can be used to add a full width footer to your website. Basically this object is a simplified layer, so most settings are identical and other objects can be dragged on top of this object to make them part of the footer. The footer will always be displayed at the bottom of the page.

Mode
Specifies the footer mode.

- **Default**
  The footer will be positioned at the bottom of page. Note that this is not necessarily the bottom of the browser window.

- **Fixed**
  The footer will be fixed at the bottom of the browser window.

- **Fullscreen**
  The footer will be hidden by default and become visible when the user moves the mouse over the footer. So the footer is only visible when needed. This mode also supports animations to slide or fade the footer into view. The animation can be synchronized with the header animation so both header and footer show/hide at the same time.

- **Floating**
  The position of the footer will depend on other floating objects (like layers), but it will always be at the bottom.

Stack Level
Specifies the stack level of the footer relatively to the page content. The footer can either be ‘in front of the content’ or ‘Behind the content’.

Styling, alignment and other options are the same as for the Layer object.
Page Header
The Page Header can be used to add a full width header to your website. Basically this object is a simplified layer, so most settings are identical and other objects can be dragged on top of this object to make them part of the header. The header will always be displayed at the top of the page.

Mode
Specifies the header mode.
- **Default**
  The header will be positioned at the top of the page. Note that this is not necessarily the top of the browser window.
- **Fixed**
  The header will be fixed at the top of the browser window.
- **Fullscreen**
  The header will be hidden by default and become visible when the user moves the mouse over the header. So the header is only visible when needed. This mode also supports animations to slide or fade the header into view.
- **Floating**
  The position of the header will depend on other floating objects (like layers), but it will always be at the top.

Stack Level
Specifies the stack level of the header relatively to the page content. The header can either be 'In front of the content' or 'Behind the content'.

Styling, alignment and other options are the same as for the Layer object.
Wrapping Text

One of the most requested features is the possibility to wrap text around images and other objects. Unfortunately this functionality is very complicated to implement because the size and position of text is usually not exactly the same in different browsers. The results with standard HTML/CSS are unpredictable and not what-you-see-is-what-you-get. Although future versions of HTML/CSS will support more flexibility, so we decided to simulating the wrapping functionality for now and when browsers are ready for it we will convert it to the official standard.

'Wrapping Text' is an object container (just like a layer and form) with text. By default the text will fill the entire box, but when you drag & drop objects inside the 'Wrapping Text' object then the text will wrap around it!

All text will have the same formatting which can be configured in the Style properties. Because not all fonts behave the same way in different browsers, we have added a 'font fine-tune' option which allows you to fine-tune the size of the font for the best results. Make sure you test this in all browsers!
QuickTime
Use this object to add QuickTime media files to your page.

File
Enter the filename of the movie.
QuickTime media has a .mov or .qt extension.

Hide
Select this option if you don’t want to show the movie, but want to use it only as background sound.

Controller
Select this option to display a control bar that site visitors can use to start or stop the movie.

Auto start
To play the movie automatically when the site visitor opens the page, select Auto Start.

Loop
To replay the movie when it ends, select Loop.

Keep movie in user’s cache
Select this option to store the movie in the cache on the site visitor’s system.
If the visitor leaves the page and comes back, the movie doesn’t have to be downloaded again because it is already in the system cache.
Real Player
Use this object to add RealPlayer media files to your page.

Filename
Enter the filename of the audio or video file.
A RealPlayer media file can have one of these extensions: .ra, .rm, .rv, .rmvb, .rmj, .rms, .ram, .rmm, .rax, .rvx, .rp, .rtx, .rt, .rmx.

Controls
Sets the visible components of the RealPlayer Plug-in.

- ImageWindow Displays the image window.
- All Displays the basic RealPlayer control panel.
- ControlPanel Displays a compact RealPlayer control panel.
- PlayButton Displays a play/pause button.
- PlayOnlyButton Displays a play button.
- PauseButton Displays a pause button.
- StopButton Displays a stop button.
- FFCtrl Displays a fast-forward button.
- RWCtrl Displays a rewind button.
- MuteCtrl Displays a mute button.
- MuteVolume Displays a mute button and volume slider.
- VolumeSlider Displays a volume slider.
- PositionSlider Displays a clip position slider.
- TACCtrl Displays a clip information field.
- HomeCtrl Displays the Real™ logo.
- InfoVolumePanel Displays presentation information along with the volume slider and mute button.
- InfoPanel Displays the presentation information panel.
- StatusBar Displays the status panel, which shows informational messages.
- StatusField Displays the message text area of the status bar.
- PositionField Displays the position field, which shows the clip's current place in the presentation timeline and the total clip length.

Console
Sets a console name used to link multiple RealPlayer Plug-in instances. All RealPlayer Plug-ins with the same console name work together. For example, if you have multiple Play and Stop buttons on the same page, the console name would enable them to control the same RealAudio clip. Set this property for each instance of the Play or Stop button you want to link. The console name master links to all instances. The console name unique links to no other instances.

Autostart
Sets whether or not the RealPlayer Plug-in will automatically start playing once the source data is available.

Loop
To replay the movie when it ends, select Loop.

Linking Multiple Controls
The console property defines a name that unifies RealPlayer objects so that multiple controls work together.
For example, you could create three separate RealPlayer objects to define an image window, a play button, and a stop button.
By using three different object, you can set the size of each control separately.
To tie controls together, define the same CONSOLE name within RealPlayer, or use one of these predefined names:
_master links the control to all other embedded controls on the page.
_unique links the control to no other embedded controls on the page.

You can have multiple console names for separate presentations. For a page showing two video clips, for example, you can define the console names video1 and video2. All controls linked by video1 interoperate, as do all controls linked by video2. However, a video1 volume slider, for example, will not affect the volume of a video2 clip.

Example 1:
You want to add a video file without any controls to your page
1. Add one instance of the object to your page
2. Specify the filename
3. Set the controls property to ImageWindow
4. Set the console property to video1

Example 2:
You want to add a video file with all controls visible
1. Add two instances of the object to your page
2. Specify the filename for both objects
3. Set the controls property of object 1 to ImageWindow
4. Set the controls property of object 2 to All
5. Set the console properties of both objects to video1

Example 3:
You want to add a video file with only a playbutton
1. Add two instances of the object to your page
2. Specify the filename for both objects
3. Set the controls property of object 1 to ImageWindow
4. Set the controls property of object 2 to PlayButton
5. Set the console properties of both objects to video1

For more information about the RealPlayer object visit the official website:
Media Player

Use this object to add media files to your page. This is the most common way to add media files to your web page. The Media Player now has built-in support for HTML5 audio/video!

Important note: There is currently no audio/video format which works on all browsers. Make sure you configure alternative formats to support all browsers.

Type

Specifies the type of media player.

- **Default**
  
  If this option is selected then the browser will use the default media player as configured in the user’s preferences.

  Note: In order to play a media file the visitor of your website must have installed the appropriate browser plug-in!

- **HTML5 Audio**
  
  Use this option if you want to use HTML5 audio.

- **HTML5 Video**
  
  Use this option if you want to use HTML5 video

Filename

Specifies the filename or URL of the audio/video to play.

Autostart

To play the movie automatically when the site visitor opens the page, select Auto Start.

Hide

If supported, this option will hide the player, so only the sound is played.

Loop

To replay the movie when it ends, select Loop.

Show controls

If present, controls will be displayed, such as a play button. The actual appearance of the player depends on the type of browser! Each browser will render the player differently!!

Preload media

If present, the video will be loaded at page load, and ready to run. Ignored if "autoplay" is present.

Mute audio (applies to HTML5 video only).

Specifies whether the audio should be muted.

Alternative formats (applies to HTML5 video only).

Unfortunately not all browsers do support the same audio/video formats. There is currently no format which works on all browsers. So to ensure the player will work in all browser you can specify alternative formats.

Poster

Specifies the filename or URL of an image representing the video.
YouTube
The YouTube object provides an easy way to add YouTube videos to your pages.

URL
Specifies the URL of the YouTube video. The URL should look like this:

https://www.youtube.com/v/sD7cnt9IDII

Size
Here you can select from a few predefined sizes. However, this still allows you to manually change the size of the YouTube object in the workspace. This option is just a helper tool to quickly set a specific size.

Show related videos
Specifies whether display a list of related videos.

Play in High Quality Mode
Enable this option to initially play the video in High Quality Mode when it's available.

Auto start
To play the movie automatically when the site visitor opens the page, select Auto Start.

Loop
To replay the movie when it ends, select Loop.

Enable full screen button.
Enable the 'full screen' button in the player's control bar.

Hide video control after the video start playing.
The video progress bar and the player controls will slide out of view a couple of seconds after the video starts playing. They will only reappear if the user moves her mouse over the video player or presses a key on her keyboard.

Support both Flash and HTML5 video
If this option is enabled 90 Second Website Builder will use YouTube's inline frame solution instead of the flash only player. Enable this option is you want to target browser which do not support Flash (like the iPhone or iPad).

Version
The version property allows you to specify the version of the YouTube player. Some new features (like the new theme options) require version 3, but if you wish to load an older version of the player you can set it to 1 or 2 (or leave it empty).

Lightbox
The Lightbox option makes it possible to display a YouTube video in a lightbox (using FancyBox) after clicking on a preview image. You can specify the preview image, lightbox title and width/height of the lightbox.
CSS Menu

This menu is very similar to the Navigation bar with the main difference that this menu does not use any images or JavaScript! Still the CSS menu allows you to create fancy looking menus (glossy, glass, gradients etc) using CSS3 gradients and shadows.

Select **Add** to insert a new button.
Select **Edit** to modify the properties of an existing button.
To remove an item from the CSS Menu select **Remove**.
You can rearrange the item order by using **Move Up** and **Move Down**.

**Synchronize with Site Manager**
When this option is enabled, 90 Second Website Builder automatically synchronizes the items of the CSS Menu with the content of the Site Manager. So if you add a new page, then a button is automatically added to the Text Menu. Or if you rename a page the text of the button will also be updated.

**Target**
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled.

**Level**
This value specifies which level of the Site Manager will be used to create the items.
First Level Creates buttons that will link to the children of the root level.
Parent Level Creates buttons that will link to all pages in the level above the current page in the Site Manager.
Current Level Creates buttons that will link to the current page and all other pages that share the same parent page.
Child Level Create buttons that will link to the children of the current page.

**Spacing**
This setting specifies the space between 2 items.
Go Menu
You can use the Go Menu component to easily create a drop-down navigation menu, with each menu item corresponding to a single URL or page in your web site. When the user presses the Go button the select link will be activated.

Select Add to insert a new item.

Text: Text of the item in the list

URL: The URL (Internet Address) to which the item will link.
For more information about hyperlinks please read the chapter ‘Links’ in this document.

Select Edit to modify the properties of an exiting item.
To remove a button from the Go Menu select Remove.
You can rearrange the item order by using Move Up and Move Down.

Initial Text
This is the initial text which will be displayed in the dropdown menu.

Button Text
The text of the button

Do not use button
Select this checkbox to hide the go button. In this case a dropdown menu selection will trigger the link.
Mega Menu
Mega Menus are drop down menus that contain multiple columns of links. They enable access to all links at once, rather than forcing the user to scroll or use sub-menus. One of the unique features of this Mega Menu is that you can set different drop down styles for each button. The drop down can have rows, columns, just a simple menu or no menu at all!

The Mega Menu was created using jQuery and supports the same ThemeRoller themes as the other jQuery based components. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager.

General
Here you can add, edit and remove menu items to the Mega Menu. Click ‘Add’ to insert a new button to the main menu bar. The properties of the button give you access to the submenu.

Button Text
Specifies the text of the button.

Menu Layout
Specifies how the items in the submenu will be displayed.

- **Columns only**
  All categories will be displayed in columns (1 row).
- **Rows only**
  All categories will be displayed in rows (1 column)
- **2 columns**
  Categories will be displayed in 2 columns.
- **3 columns**
  Categories will be displayed in 3 columns.
- **4 columns**
  Categories will be displayed in 2 columns
- **Simple menu**
  Displays a simple drop down menu
- **Button only**
  The button has no sub menu.

Links are organized in categories. To add a new category click the ‘Add category’ button and specify a name. To add a link to a category, first select the category name and then click ‘Add Link’.
You can rearrange the links with the ‘Move Up’ and ‘Move Down’ button or by using drag & drop.

**Style**
The menubar uses the global page theme which can be set in Page Properties->Style. Other object specific settings can be altered in the 'Style' section of the Mega Menu properties. The ‘Font name’ and ‘Font Size’ properties can be used to override the default font of the theme. The ‘Animation’ property enables the fade animation for hiding and showing sub menus.

**Button Padding**
Specifies the padding for the buttons. The Button text in combination with the padding determines the size of the button.

**Button Spacing**
Specifies the spacing between the button.

**Icon**
Specifies the icon displayed on the button.

**Icon Offset**
Specifies the position of the icon on the button.
If the value is positive, the icon will be aligned on the left side of the button.
If the value is negative, the icon will be aligned on the right side of the button.

**SubMenu Padding**
Specifies the padding for the sub menu.

**Icon**
Specifies the icon displayed on the left side of the links.
Menu Bar

The Menu bar in 90 Second Website Builder is based on Heng Yuan's JSCookMenu (http://www.cs.ucla.edu/~heng/JSCookMenu). This is a very powerful JavaScript-based menu script that can mimic complex menus found in popular GUI applications. 90 Second Website Builder provides a menu builder so you can easily add menu items, assign the links and set the style for the menu using the style tab.

Select **Add** to insert a new item to the menu bar. Select **Edit** to modify the properties of an existing item. To remove an item from the Menu Bar select **Remove**. The **Insert Split** button inserts a splitter/divider in the menu.

**Layout:** The Menu Bar can be either Vertical or Horizontal.

**Style:** To change the appearance of the menu bar either select a predefined theme or select Default to edit the menu bar colors and text formatting.

Note the effect of the selected theme will only be visible in the browser. So you'll have to preview or publish the page first.

**Synchronize with Site Manager**

When this option is enabled, 90 Second Website Builder automatically synchronizes the items with the content of the Site Manager. So if for example you add a new page, then an item is automatically added to the menu bar. Or if you rename a page the text of the item will also be updated.

**Move Up**
Move the selected item up amongst its siblings.

**Move Down**
Move the selected item down amongst its siblings.

**Move Left**
Make the selected item a sibling of its parent.

**Move Right**
Make the selected item the child of its preceding sibling.

**Tip:**
You can rearrange the items in the menu you can use drag and drop to move the items around.
Adding your own themes:
The menu bar also can be customized using Cascading Style Sheets (CSS) and custom images. The 90 Second Website Builder program folder contains several predefined themes in the 'menu bar' subfolder, but you can also add your own themes. Just create a new sub folder in the menu bar folder and copy the new style definitions in there. Take a look at the existing themes to figure out how it works). 90 Second Website Builder automatically detects new themes when there are added.

Using Theme Studio to create themes:
One of the great features of the menubar object is the support for Theme Studio menubar themes.

This tool makes it relative easy to create advanced menubar themes.
You can download Theme Studio here: [http://tapestry-jsmenu.sourceforge.net/theme-builder/](http://tapestry-jsmenu.sourceforge.net/theme-builder/)

How to add a theme created with Theme Studio to 90 Second Website Builder?
1. In the Theme Studio toolbar click 'Build'
2. Select Build Format 'Original Format'
3. Specify a Destination File, for example 'ThemeDemo.zip'
4. Unzip the theme to My Documents\90 Second Website Builder\system\menubar.

Note:
The files from the 'example' folder are not needed!

The structure will look something like this:
My Documents\90 Second Website Builder\system\menubar\ThemeDemo
My Documents\90 Second Website Builder\system\menubar\ThemeDemo\background-1.png
My Documents\90 Second Website Builder\system\menubar\ThemeDemo\background-2.png
My Documents\90 Second Website Builder\system\menubar\ThemeDemo\background-3.png
My Documents\90 Second Website Builder\system\menubar\ThemeDemo\background-4.png
My Documents\90 Second Website Builder\system\menubar\ThemeDemo\theme.css
My Documents\90 Second Website Builder\system\menubar\ThemeDemo\theme.js
Navigation bar
Adding a Navigation Bar in 90 Second Website Builder is really easy.
Just add a few buttons, assign the links and set the style for the buttons.

Select **Add** to insert a new button.
Select **Edit** to modify the properties of an existing button.
To remove a button from the Navigation Bar select **Remove**.
You can rearrange the button order by using **Move Up** and **Move Down**.

**Synchronize with Site Manager**
When this option is enabled, 90 Second Website Builder automatically synchronizes the Buttons with the content of the Site Manager.
So if for example you add a new page, then a button is automatically added to the Navigation bar.
Or if you rename a page the text of the button will also be updated.

**Target**
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled.

**Level**
This value specifies which level of the Site Manager will be used to create the buttons.
**First Level**
Creates buttons that will link to the children of the root level.
**Parent Level**
Creates buttons that will link to all pages in the level above the current page in the Site Manager.
**Current Level**
Creates buttons that will link to the current page and all other pages that share the same parent page.
**Child Level**
Create buttons that will link to the children of the current page.

**Resize buttons horizontally**
Enable this option to be able to resize navigation bar buttons horizontally. Instead of the original button width, the button will now be stretched.

**Layout Type**
The Navigation Bar can be either Vertical or Horizontal.

**Layout Space**
This option specifies the space between 2 buttons.
Navigation bar Style

**Style**
Select one of the available button styles from the drop down menu.
You can select your own images by using the 'Use Custom Image' option (the first item in the drop down list). By default 90 Second Website Builder includes a few example styles, but you can easily add your own styles: Copy your own styles (which are basically just images) to navbar folder: `My Documents \90 Second Website Builder\system\navbar`.

With the **Colorize** option you can change the color of a button to almost any color!
This gives you hundreds of additional color variations to choose from!

**Animation**
You can choose from several animations for the mouse over effects to give your menu's a modern web 2.1 look and feel.

**Use hover state style to indicate the current page.**
To give the visitors of your web site an indication of which page they currently are viewing you can give that page the same style as the hover state.
Note that this option does not work when the navigation bar is on a master page, because in that case the images for the navigation bar will be the same for all pages!

**Use page theme**
Use the page theme to style the object. More details about themes: Theme Manager.
Panel Menu

A Panel Menu is initially invisible, but can slide from the right or left side of the page by clicking the menu button. Many modern web sites use this menu type.

The general menu settings are the same as for other menu types like the navigation bar.

Text
Specifies the text of the menu button.

Icon
Image that can be displayed on the button. The icon position can be used to control the icon position relatively to the text.

Display
Specifies the relationship of the panel to the page contents. "Push" pushes the page over and "overlay" display the layer over the content.

Position
Specifies whether the panel menu will be displayed at the left or right side of the page.

Dismissible
Specifies whether the panel can be closed by clicking outside onto the page.

Width
Specifies the width of the panel. By default this value is in pixel but you can also use percentage, for example 50%.

The animation can either be none or slide. The slide animation also supports many easing options.
SiteTree

The SiteTree can display an overview of your website (a Site map) so visitors can quickly find what they’re looking for.

**Tip:**
Do not confuse this object with the SiteMap option in the tools menu, which is purely meant for search engines!

The SiteTree will display all pages of your website, with exception of the pages which you have marked 'Don’t Synchronize this Page in Navigation Objects.'.

This object has 3 display styles, each giving a completely different overview of your site:

**Alphabetical**
Displays an alphabetical list of all the pages of your website.

**Category**
Displays all the pages of your website grouped by category.
In order for this style to work correctly, you must first assign one or more categories to a page. You can either do this in the Page Properties (meta tags) or in the General Properties of the SiteTree itself.

**Treeview**
Displays all the pages of your website in a tree view based on the structure of the site in the Site Manager.

In the General Properties of this object you can quickly update the display name (is the same as the menu name property in Page Properties), the page description (Description meta tag) and the categories.
You can assign one or more categories to a page (separated with a comma).
Tab Menu

The Tab Menu is yet another way to implement your website navigation. The biggest difference between the navigation bar and the tab menu (besides its appearance) is that a tab menu item has 3 states:

1. **Normal**
   - Idle state
2. **Hover**
   - Mouse over or Roll over state
3. **Activate**
   - The selected item is the current page.

Select **Add** to insert a new tab item. In the **Name** field enter the text you want to be displayed on the tab item. **Alternate text**: this text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled.

In the **Link To** field you can select the type of hyperlink and where to link to. See also the chapter about ‘Links’.

Select **Edit** to modify the properties of an existing item. To remove an item from the Tab Menu select **Remove**. You can rearrange the order of the items by using **Move Up** and **Move Down**.

**Synchronize with Site Manager**
When this option is enabled, 90 Second Website Builder automatically synchronizes the items with the content of the Site Manager. So if for example you add a new page, then a button is automatically added to the Tab Menu or if you rename a page the text of the tab item will also be updated.

**Level**
This value specifies which level of the Site Manager will be used to create the items.

- **First Level**
  - Creates items that will link to the children of the root level.
- **Parent Level**
  - Creates items that will link to all pages in the level above the current page in the Site Manager.
- **Current Level**
  - Creates items that will link to the current page and all other pages that share the same parent page.
- **Child Level**
  - Create items that will link to the children of the current page.

**Tab Menu Style**
90 Second Website Builder includes several themes you can choose for the appearance of the tab menu. The default theme is text only and does not use any images. The other themes are defined in the tabmenu folder (`My Documents\90 Second Website Builder\system\tabmenu\`) and usually are made of 2 images. If you like you can modify these theme or create your own themes.
Text Menu

The Text Menu is a text-only version of the Navigation bar. Text menus can speed up the navigation through your website, because no images need to be loaded first before the user can navigate to another page.

Select Add to insert a new text link.
Select Edit to modify the properties of an existing text link.
To remove an item from the Text Menu select Remove.
You can rearrange the item order by using Move Up and Move Down.

Synchronize with Site Manager
When this option is enabled, 90 Second Website Builder automatically synchronizes the item of the Text Menu with the content of the Site Manager.
So if for example you add a new page, then a button is automatically added to the Text Menu.
or if you rename a page the text of the button will also be updated.

Target
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled.

Level
This value specifies which level of the Site Manager will be used to create the items.
First Level Creates buttons that will link to the children of the root level.
Parent Level Creates buttons that will link to all pages in the level above the current page.
Current Level Creates buttons that will link to the current page and all other pages that share the same parent page.
Child Level Create buttons that will link to the children of the current page.

Spacing
This setting specifies the space between 2 items.

Style

Font
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.

Background Color
Specifies the color of the background. If set to 'Automatic' the webpage background will be used.

Link Style
All hyperlinks in your webpage by default use the default HTML link colors (link: blue, visited: purple, active: red). By defining Hyperlink Styles (CSS) you can adjust the colors and formatting of an hyperlink.
Once you have defined a style you can attach it to the Text Menu by selecting it from the Link Style dropdown list. Click the Edit Styles button to add or modify the hyperlink style sheet.

Alignment
Specifies the alignment of the Text Menu.

Delimiters
Specify special characters to put before and after the link text. Common characters include {, [ and (.
Banner
A banner is an image that displays the title of a web page. A banner helps visitors understand what the page is about.

**General**

**Banner Text**
Text that will be displayed on the banner.

**Use page title**
This option automatically uses the title of the web page as the banner text. Uncheck this if you want to enter custom text.

**Font Type**
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.

**Text Style**
Style of the font such as Bold, Italic or Regular.

**Text Size**
Size of the text.

**Text Color**
Color of the text.

**Banner Size**
The size of the banner. Select one of the predefined sizes or 'Fit to layout rectangle' if you want a custom size banner.

**Horizontal Alignment**
Horizontal alignment of the text.

**Vertical Alignment**
Vertical alignment of the text.

**Style**

**Background effect**
You can select from several Fill Effects:
1. Solid Color
2. Gradient
3. Tiled or stretched image.

**Border size**
Specifies the thickness of the border around the banner. Set this to 0 (zero) for no border.

**Border Color**
Specifies the color of the border around the banner.

**Border Style**
Specifies the style (Solid, Circle, Disc, Square or Dash) of the border around the banner.
**Effects**

**Enable shadow**
Specifies whether to enable the shadow effect for text.

**Shadow Offset X**
Horizontal shadow offset

**Shadow Offset Y**
Vertical shadow offset

**Shadow Opacity**
Sets the transparency of the shadow.

**Shadow Color**
Specifies the shadow color

**Shadow Blur**
Softens the shadow's edges.

**Reflection**
Specifies the amount of reflection of the text.

**Reflection Offset**
Specifies the offset of the reflection from the bottom of the text. This value can be negative.

**Text Animation**
The Banner object can animate the individual characters of the text using built-in CSS3 animations. This makes it possible to create cool introduction to your website.
You can set a different animation for showing and hiding the characters. If you set both animations then both animation will be played continuously. If only the show animation is specified then the animation will play only once on page load.

**Note:**
Not all animations may be useful for animating characters. For example animating the border-color will not have any effect on the text or will just look weird...
Also some animations were designed for showing, while others were designed for hiding. Usually the name of the animation indicates this. For example ‘puff-in’ is for showing and ‘puff-out’ is for hiding.
But of course you can designed your own animations with the Animation Manager..

**Publish**

**Format**
Specifies the output format of the banner. You can either publish the banner as an image or as standard text with CSS3 styling.

Note however that older browsers do not support text shadow. Also note that reflection is currently not supported by CSS3, so the banner will not look exactly the same as when publish as an image.
ClipArt

ClipArt uses dingbat fonts and converts them to vector shapes. It has all the features of shapes, but it allows you to insert any type of shape to your page!
You can download thousands of free dingbats fonts from the Internet. Search for 'free dingbat fonts' to find all large collection of new shapes. After you've downloaded one or more files you can copy them to the 'clipart' folder in the 90 Second Website Builder system folder:
My Documents\90 Second Website Builder\system\clipart\n
Dingbats fonts have the file extension '.ttf'. There are also many tools available to create your own dingbat collections. The filename of the Dingbats font will be displayed as the category name in the clipart selection.

For more details about the properties of the ClipArt object see Shapes.
Curve
The Curve tool lets you draw curved lines.

To draw a curved line:
1. Click the Curve Tool on the Toolbox or click Insert->Drawing->Curve.
2. Click and release the left mouse button where you want the Curve to start, while dragging the mouse press and press/release the mouse button to add points.
3. To end the curve, double click the left mouse button or press the ESC-key.

When the curve is selected, the individual nodes can be changed by dragging them to a new position.

**Alternate text**
This text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled.

**Anti Alias**
Enable this option to improve the quality of graphics. It may slow down the performance of the application.

**Fill Effect (Closed Curve only)**
Specifies the fill effect of the polygon: Solid, Gradient, Texture, Hatch or Transparent.

**Border Width**
Specifies the thickness of the line.

**Border Color**
Specifies the color of the line.

**Border Style**
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Sor).

**Link**
For more information about linking please read the chapter ‘Links’ of this document.

**Events**
For more information about events please read the chapter ‘Events’ of this document.

**Important note:** The Curve tool is only available on systems with GDI+ installed. Read more about GDI+ in the chapter ‘GDI+ Information’ of this document.
Curved Text

With the Curved Text object you can draw text along an user defined curve.

First you will have to draw a curved line:

1. Click the Curved Text on the Toolbox or click Insert->Drawing->Curved Text.
2. Click and release the left mouse button where you want the Curve to start, while dragging the mouse press and press/release the mouse button to add points.

To end the curve, double click the left mouse button or press the ESC-key.
Then double the Curved Text to edit other properties.

For more information about adding, editing or removing nodes see ‘Edit Points’ in the Arrange Menu.

All properties of the Curved Text object are the same as the Shape object.
**Line**

The Line tool of 90 Second Website Builder gives you much control over its appearance than the standard HTML horizontal line. The Line can be drawn using any angle, color, style and can even have arrows on the start or end of the line!

To draw a line:
1. Click the Line Tool on the Toolbox or click Insert->Drawing->Line.
2. Click where you want the line to start, and hold the left mouse button down as you draw. To end the line, release the mouse button.

**Size**
Specifies the thickness of the line.

**Color**
Specifies the color of the line.

**Style**
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Sor).

**Arrow Start**
Specifies the arrow type of the start of the line (None, Arrow, Circle, Square, Diamond, Stealth or Open Arrow).

**Arrow Start Size**
Specifies the size of the arrow.

**Arrow End**
Specifies the arrow type of the end of the line (None, Arrow, Circle, Square, Diamond, Stealth or Open Arrow).

**Arrow End Size**
Specifies the size of the arrow.

**Alternate text**
This text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the mouse over the image.

**Anti Alias**
Enable this option to improve the quality of graphics. It may slow down the performance of the application.
**Connector Type**  
Specifies the connector type. Elbow and Curve connector are commonly used in flow charts.
- **Line**  
  Draws a straight line.
- **Elbow**  
  Draws an elbow line.
- **Curve**  
  Draws a curved line.

**Connector orientation**  
Specifies the connector orientation. Horizontal, Vertical or Auto.

**Link**  
For more information about linking please read the chapter ‘Links’ of this document.

**Events**  
For more information about events please read the chapter ‘Events’ of this document.

**Important note:** The Line tool is only available on systems with GDI+ installed. Read more about GDI+ in the chapter ‘GDI+ Information’ of this document.
**Polygon**
The Polygon tool lets you draw polygons with borders and several filling methods.

To draw a polygon:
1. Click the Polygon Tool on the Toolbox or click Insert -> Drawing -> Polygon.
2. Click and release the left mouse button where you want the polygon to start, while dragging the mouse press and press/release the mouse button to add points.
3. To end and close the polygon, double click the left mouse button or press the ESC-key.

When the polygon is selected, the individual nodes can be changed by dragging them to a new position.

---

**Important note:** The Polygon tool is only available on systems with GDI+ installed. Read more about GDI+ in the chapter ‘GDI+ Information’ of this document.
Scribble
The Scribble tool lets you sketch curved lines and shapes in a freeform way.

To draw a freeform line:
1. Click the Scribble Tool on the Toolbox or click Insert->Drawing->Scribble.
2. Click where you want the line to start, and hold the left mouse button down as you draw. The line will be drawn immediately and follows your mouse movements. Releasing the mouse button will draw a straight line from the point where you released the button to the current mouse position.
3. To end the line, double click the left mouse button or press the ESC-key.

When the line is selected, the individual nodes can be changed by dragging them to a new position.

Alternate text
This text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled.

Anti Alias
Enable this option to improve the quality of graphics. It may slow down the performance of the application.

Border Width
Specifies the thickness of the line.

Border Color
Specifies the color of the line.

Border Style
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Dot).

Link
Because the drawing is published as image you can also assign a link to it.
For more information about linking please read the chapter ‘Links’ of this document.

Events
Because the drawing is published as image you can also assign events to it.
For more information about events please read the chapter ‘Events’ of this document.

Important note: The Scribble tool is only available on systems with GDI+ installed. Read more about GDI+ in the chapter ‘GDI+ Information’ of this document.
Shape
The Shape object can be used to ‘draw’ a shape on your webpage. When you publish a page with shapes, 90 Second Website Builder generates each shape as a .gif file.

Type: Select the type of shape you want to be display on your web page.
- Rectangle
- Round Rect
- Ellipse
- Diamond
- Hexagon
- Octagon
- Arrows
- Signs
- Stars
- Talk Bubbles
- and many more.

Some shapes have a few variants that you can choose from.

To add a border to the Shape select ‘Enable Border’ and specify the border width and color.

You can select from several Fill Effects:
1. Solid Color
2. Gradient
3. Tiled or stretched image.
4. Transparent
5. Pattern (anti-aliased mode only)
6. Vista Glass (anti-aliased mode only)

Anti Alias
Enable this option to improve the quality of graphics. It may slow down the performance of the application.

Inner Shadow
This option will add a bevel effect (inner shadow) to the shape. A Blur value ‘0’ will disable the effect.

Note:
If anti alias is disabled it is not possible to set the transparency of the shadow.

Link
For more information about linking please read the chapter ‘Link’s of this document.
**Events**

For more information about events please read the ‘Events’ chapter of this document.

**HTML5**

Normally shapes will be published as images, for larger shapes this may have some impact on the performance of your website. However modern browsers (FireFox 5, IE9, Safari, Chrome) now have built-in support for alternatives formats like `<canvas>` and `<svg>.

90 Second Website Builder now enables you to convert your shapes into native HTML5 elements.

Select ‘Publish as `<canvas>`’ to output the shape using HTML5’s `<canvas>` element. Basically this generates an complex set of JavaScript calls to draw the shape in the browser.

Select ‘Publish as `<svg>`’ to output the shape using HTML5’s `<svg>` element. This will output SVG instructions for the browser to draw the shape as a vector based image.

Select ‘Publish as CSS3’ to output the shape using CSS3 styling. This will output a standard `<div>` with CSS3 styling (border and background color) . Note in this mode only rectangle, ellipse and rounded corner shapes are possible, because CSS does not support any other shape types.

Known limitations:
- This is a very new technique and not all 90 Second Website Builder shape features are available yet, but we will continue to improve the software when browsers will catch up;)
- Not all gradient effects are supported.
- Text on shape is not supported.
- Dotted and dashed border are not supported for `<canvas>`.
- Shadow and other images effects are not supported.
Shadow Offset X
Horizontal shadow offset.

Shadow Offset Y
Vertical shadow offset.

Shadow Opacity
Sets the transparency of the shadow.

ShadowColor
Specifies the shadow color.

Opacity
Change the transparency (0 - 100%) of the shape.

Add text to a Shape
A new feature in version 5.0 is the ability to add formatted text to a shape. Now you can create cool logos, banners or even rotate text. Text can be aligned to any edge of the shape. The available space for text within the shape may vary depending on the type of shape you’ve selected.

Note:
Text will not be visible if the object is transparent.

Rotation
To rotate a shape:
1. Select the Rotate tool on the Toolbox or click Edit->Rotate.
2. Click to select the object, hover over one of its handles until you see the rotate pointer.
3. Hold the mouse button down and drag in the direction in which you want to rotate the object, then release. Use the Shift key for 15° rotation intervals.

Notes:
• Rotating large shapes can take a long time.
• Rotating shapes may reduce the display quality of the object.

Effects
Just like images you can also apply most effects to shapes, text art and clip art. For more details see Images.
Blog

The word ‘blog’ is short for web log. A blog is a journal that’s posted on the web for other to read. The Blog object provides an easy way to implement a blog on your website without special requirements on the web server.

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est laborum

Send Comments

General

Comment Text, each blog entry will have a link on the bottom to allow readers to send comments. The default text is ‘Send Comments’, but you can change this to anything you like. If you leave this field blank, no link will be displayed.

Comment Email, specifies the email address where the comments will be sent to.

To add a new entry to your Blog, click the Add button. Give your blog entry a title and then type your blog's message in the text area. Optionally you can insert an image and a link to a related web page.

Style

The style page allows you to modify the style of the Blog, each individual item such as Comment, Date, Subject and background can have its own color and font. The Divider image can be used to separate blog entries horizontally.

RSS Feed

Optionally you can enable to generate a RSS Feed for this blog. The RSS Feed Properties are identical to those of the RSS Feed object.
Carousel

The Carousel object (also known as horizontal sliding panels) displays images or any other objects by scrolling the content from right to left using a smooth sliding animation (with several optional easing effects). Users can step to any specific panel on demand using the pagination icons or browse the carousel sequentially by using the back/next buttons. You can also think of the Carousel as a multiple layer slide show. It’s a very effective method to increase the web site usability and engage the user. You probably have seen this effect on many popular websites, such as Apple or Blackberry.

When you first insert the Carousel to your page, you will see a blank area with two buttons and a pagination control. The buttons can be used to go to the next or previous panel. The pagination control displays a ‘dot’ for each page in the carousel. You can directly jump to a specific page by clicking the dot. The colors and size of the pagination control is configurable and of course you can select your own images for the next/back buttons as well.

Advanced users can even use events to create custom buttons outside of the Carousel!

To add new content to the current page, simply drag and drop objects within the Carousel area. To add objects to another page, first go to the page (either by using the pagination controls or next/back). Another cool feature of the Carousel is support for mobile devices. On the iPhone/iPad/Android you can use slide gestures to switch between pages!

General

Pages
This will set the number of pages for the Carousel.

Pause time
Specify the number of milli seconds to pause before displaying the next panel in the sequence.

Animation duration
Specifies the duration of the slide animation in milli seconds.

Easing
You can select from more than 30 easing functions to control the animation process. This option can be used to (for example) create bounce or elastic effects.

Enable navigation buttons
Specifies whether to display the navigation buttons.

Previous button
Specifies the image to be used for the ‘Previous’ button. If you leave this field empty a default image will be used.
Next button
Specifies the image to be used for the 'Next' button. If you leave this field empty a default image will be used.

Margin
Specifies the margin between the border of the Carousel and the buttons.

Enable pagination
Specifies whether to display the pagination controls. The pagination controls will be displayed on the bottom of the Carousel. The user can click the icons to quickly go to the specific panel.

Color
Specifies the color of the pagination icons.

Border color
Specifies the border color of the pagination icons.

Size
Specifies size of the pagination icons.

Padding
Specifies the padding around the pagination icons.

Style
In this section you can modify the appearance of the object. For more details about object styling please read Style.

How to control the slides through events?
You can use the Slideshow Next and Slideshow Previous actions in events to create external navigation.

It's also possible to directly jump to a specific page:
1. Add the Carousel object to your page.
2. Take note of the ID. The default value is 'Carousel1'.
3. Add an image, shape or other object with event support to the page.
4. Open the properties and select the 'Events' tab.
5. Click 'Add' to insert a new event.
6. Select 'Event': OnClick and set the 'Action' to JavaScript function.
To show the dialog enter this JavaScript:
```javascript
$('#Carousel').carousel('goto,1');
```

where Carousel1 is the ID of the Carousel.
goto,1 jumps to the first slide
goto,2 jumps to the second slide.
etc....

To show the next slide you can also use this JavaScript:
```javascript
$('#Carousel').carousel('next');
```

To show the previous slide use:
```javascript
$('#Carousel').carousel('prev');
```
Image Map
You can create an (client-side) image map that divides an image into different areas that each link to a different web page. Creating an image map is useful for images such as a floor, campus map or world map that you want to contain links to different pages. You can define each clickable area (hotspot) on the map using three shape values: rectangle, circle or polygon (irregular shape). To add images use the Image map object. Drag the object to the page and a file dialog will popup to select the image. 90 Second Website Builder supports jpg, gif, bmp and png (XP only) files.

Filename: enter the path and filename of the image/picture or select Browse to find an image on your local drive.

Notes:
1. This property specifies the location of the local image, when you publish the page the image will automatically be copied to location as specified in Tools->Options->Publish->Images Sub Folder.
2. You can also specify absolute URLs like this https://www.paypalobjects.com/en_US/i/logo/paypal_logo.gif
3. To make a (backup) copy of the images used in your page enable Tools->Options->Folders->Make a copy of images to this folder when documents are saved. This will copy all images to the specified folder, so they are all stored in one place. It also prevents having duplicate image names in your web site.

Alternate text: this text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the mouse over the image.

Title: In modern browsers this title appears as a ToolTip when you move the mouse over the image.

Use original size: Select this if you want the image to appear at its original size.

Fit to layout rectangle: Select this if you want to manually specify the image size.

Border thickness: Specifies the thickness of the border around the image. Set this to 0 (zero) for no border.

Border Color: Specifies the color of the border around the image.
**Adding Hotspots**
There are two ways to add hotspots to an image map:
1. Manually entering the coordinates in the hotspot tab of the image map properties
2. Visually modifying the coordinates using the mouse

**Manually entering the coordinates**
Open the image map properties and click the Hotspots tab to insert the coordinates of an hotspot.
You can insert three types of hotspots:
1. Circle, here you enter the x and y coordinates of the center and the radius of the circle.
2. Rectangle, here you enter the x (left) and y (top) coordinates and the width and height of the rectangle.
3. Polygon (Irregular Shape), here you enter each point (x, y coordinates) on the polygon.

**Visually modifying the coordinates using the mouse**
A more efficient way to modify the coordinates of the hotspots is by visually dragging them.
1. Right click the image map to display the context menu
2. Select the hotspot type you want to insert (Add Circle Hotspot, Add Rectangle Hotspot or Add Polygon Hotspot)
3. A window will popup where you can set the initial coordinates, the URL and alternate text of the area. By default, 90 Second Website Builder will insert the shape in the center of the image map.
4. After you have clicked OK, the shape will be inserted to the image map, you can now select it and drag it around or change its size using the size handles.
5. To edit or remove the hotspot, right click the area to display the context menu and select Edit Hotspot or Delete Hotspot.
Photo Gallery
The Photo Gallery object is gives you a tool to create a Photo gallery with only a few mouse clicks.

Add
Add one or more images to the photo gallery.

Remove
Remove the selected image(s) from the photo gallery.

Remove All
Remove all selected images from the photo gallery.

Move Up
Move the selected image one place up.

Move Down
Move the selected image one place down.

Thumbnail title
Enter the text that will be displayed under the thumbnail image. To enable titles make sure you selected the 'Include title' option in the Text Page.

Thumbnail size
Specifies the size of the thumbnail images.
Select 'Variable' to dynamically determine the thumbnail size.

Columns
The number of images per row.

Horizontal alignment
Alignment of the thumb images. This option has no effect when the Maintain aspect ration option is off.

Vertical Alignment
Alignment of the thumb images. This option has no effect when the Maintain aspect ration option is off.

Cell Padding
Enter how much space you want between the contents and inside edges of cells, in pixels.

Cell Spacing
Enter how much space you want between the cells in the table, in pixels.

Maintain aspect ratio
Select this option if you want to maintain the aspect ratio of the image in the thumbnail.
If this option is not selected the thumbnail will be resized to fit whole rectangle.
**Gallery Mode**
Specifies what happens if the user clicks on an image.

- **Open in the same browser window**
The larger version of the image will be displayed in the same browser window.

- **Open in a new browser window**
The larger version of the image will be displayed in a new browser window.

- **Open in a popup window**
The larger version of the image will be displayed in a popup browser window. The popup window will have the size of the full image.

- **Open in another window**
The larger version of the image will be displayed in another window. For example in an inline frame. You can specify the name of the target window in the Name field.

- **Open in a jQuery Dialog**
The image will be displayed in a jQuery Dialog. Use the Settings button to modify the appearance of the dialog.

- **Light Box Gallery**
If you select this option then clicking on one of the images will start a lightbox slideshow. You can select one of built-in slideshows: slimbox, prettyphoto, fancybox.

To customize the behavior of the lightbox, you can add extra options through the 'Settings'. Please consult the documentation or website of the specific lightbox for more details about possible configuration options.

- **Use Links**
This option allows you to assign links to images, instead of opening the image.

**Generate thumbnail images**
By default 90 Second Website Builder will generated a preview window which displays the original images. If the size of these images is large it can take a long time before the page is loaded in the browser. Instead you can enable **Generate thumbnail images** which will generate a smaller version of the images so the page will load faster.

**Prefix**
Prefix used for naming the thumbnail images.

**Include title**
Include the title of the image under the thumbnail. You can also change the font type, size, style and color of the title.

**Frame**
Specifies which style of frame to use. The 'Default' type adds a simply frame where you can specify the width and color. 90 Second Website Builder includes a few predefined frame styles, but you can easily add your own styles. Copy your own styles (gif, jpg or png) to gallery folder, where each style has its own folder. My Documents\90 Second Website Builder\system\gallery\yourstyle\[folder]

Frame Styles are made out of 8 images (note that you can also use the extensions jpg and png!): bottom.gif, bottomleft.gif, bottomright.gif, left.gif, right.gif, topleft.gif, topright.gif
**Polaroid mode**
The Photo Gallery also has Polaroid mode which uses CSS3 and has a few cool effects like rotated or variable sized polaroids. To enable Polaroid mode select (Polaroid) as the frame style. For the best effect set the frame width to 20 or more and use ‘white’ as the color. Also adding a little shadow with give it a more realistic effect.

Rotate polaroids will randomly rotate the images to simulate a photo stack. You can also give each photo a different size.

For advanced users who want to have more control over the angles and individual scaling of the image: Hold down the SHIFT key while clicking the checkbox options. This will bring up a dialog where you can specify an array of angles or scales. If these values do not make sense to you then please don’t edit them!

**Polaroids are draggable**
Adds the ability to reposition the Polaroids around the page. Just like ‘real’ Polaroids on a stack.

**Animate polaroids on page load**
Animates the Polaroids to a random position on the page.
Ready to use Java Scripts

This feature can be useful if you want to brighten up your web pages with some cool Java Scripts. Click 'Insert JavaScript' and select one of the predefined scripts. Some of the scripts have properties to change the behavior of the script. To see the effect of the Java Script you will need to preview or publish the web page.

Notes:

- These scripts are not created by BlackWire Marketing, LLC. Where possible, the appropriate copyrights are displayed.
- Depending on the configuration of the Internet browser some of these scripts might not work on all systems.
- It is not recommended to use more than one Java Script per page.
Rollover image
Rollover images change swap images on rolling over it (onMouseOver event) and reverts back to the original image on rolling out of the object (onMouseOut event).

Initial image
Select the image that will be displayed initially.

Mouseover image
Select the image that will be displayed when the mouse is over the object.

Alternate text
This text, usually a short description, appears in place of the object in browser when images are unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the mouse over the image.

Title
In modern browsers this title appears as a ToolTip when you move the mouse over the image.

Animation
Specifies the animation effect for the rollover image:
- None
- Fade
- Slide Left
- Slide Right
- Slide Up
- Slide Down
- Zoom
- Scale, uses CSS3 to display a larger version of the image. Uses transformation, CSS3 box shadow, a nice image caption when possible (experimental).
- Sliding Door. This makes it looks like the image is splitted into half and one goes left and the other one goes right.

Duration
Duration of the animation in milliseconds.

Easing
The slide animations also support easing. You can select from more than 30 easing functions to control the animation process. This option can be used to (for example) create bounce or elastic effects.

Link
For more information about linking please read the chapter ‘Links’.
Rollover Text

The Rollover Text object displays a text (title and description) banner over an image on mouse over.

**Filename**
Select the image that will be displayed initially.

**Title**
Title of image.

**Description**
Description of the image.

**Link text**
The banner can also contain a link. Here you can specify the text for this link. The URL for the link can be configured in the 'Link' tab.

**Position**
Specifies the position of the text banner.
- **Top**
  The banner will be displayed at the top of the image.
- **Bottom**
  The banner will be displayed at the bottom of the image.
- **Full**
  The banner will be displayed over the full size of the image.

**Animation**
Specifies the animation effect for the rollover text banner:
- **None**
- **Fade**
- **Slide Left**
- **Slide Right**
- **Slide Up**
- **Slide Down**

**Duration**
Duration of the animation in milli seconds.
RSS Feed
With the RSS Feed object you can add a RSS Feed to your website in only a few mouse clicks!

What does RSS mean?
RSS stands for Really Simple Syndication, and is used to describe the technology used in creating feeds.

What is a feed (RSS)?
Feeds, also known as RSS feeds, XML feeds, syndicated content, or web feeds, contain frequently updated content published by a website. They are usually used for news and blog websites, but are also used for distributing other types of digital content, including pictures, audio files, or video. At its most basic, RSS generates a list of links, to various resources on your site with a description of the content for each link.

The contents of a RSS feed can be read in different ways. A variety of tools, both fee based and free, to read RSS feeds are available on the Internet. The latest browsers (Internet Explorer 7.0, Safari, FireFox 2.1 and Opera) also have build-in RSS feed support.

The RSS Feed extension lets you define a RSS channel with a set of headlines. When you publish the web page, which includes the RSS extension, a RSS (XML) file will be generated in the same folder as the HTML page. A small RSS icon will be displayed on your web page with a link to this file. Some browsers will display a special icon in the toolbar, which lets the users easily subscribe to your RSS channel.

**General**

**Title**
The name of the channel. It is how users refer to your service. If you have an HTML website that contains the same information as your RSS file, the title of your channel should be the same as the title of your website.

**Description**
Phrase or sentence describing the channel.

**URL**
The URL to the HTML website corresponding to the channel.
For example: http://www.90secondwebsitebuilder.com

**Include publication date for headlines.**
The extension can automatically update the publication date of the headlines (based on the creation or modification timestamp). To include the publication date in the RSS feed, enable this option. If you leave this option off, the publication date will not be included.

**Filename**
The filename of the generated RSS xml file. By default, this file is named ‘rss.xml’, but you can rename it to anything you like. Common file extensions for feeds are .xml and .rss

**Logo**
Specifies which logo will be displayed on the webpage.
**Headlines**

**Add**
Add a new headline.
The Subject and Description should be written to describe the content.
The **Podcast** property provides a way of attaching multimedia content to the RSS feeds, such as an MP3 file. The **URL** field should reference the webpage that contains that actual content. This can be an internal or external link.

**Edit**
Edit the selected headline.

**Remove**
Remove the selected headline.

**Optional**
**Category**, Specify one or more categories that the channel belongs to.
Example: Newspaper

**Copyright**, Copyright notice for content in the channel. Example: Copyright 2015, BlackWire Marketing, LLC

**Editor**, Email address for person responsible for editorial content
Example: yourname@yourwebsite.com (Your Name)

**Webmaster**, Email address for person responsible for technical issues relating to channel
Example: webmaster@yourwebsite.com (Web Master)

**Language**, The language the channel is written in. This allows aggregators to group all Dutch language sites, for example, on a single page.

**Image**, Specifies a GIF, JPEG or PNG image that can be displayed with the channel.

**Refresh time**, Specifies the number of minutes that indicates how long a channel can be cached before refreshing from the source.
News Feed Ticker

The News Feed Ticker or Headline rotator displays RSS feeds (local or from another website), Twitter messages, Flickr images, Myspace blogs or other news sources on your website.

You can also think of this object as a Slide Show for text with many different animations and display types like static, scroller, slideshow, paginate and ticker.

**Note:**
You must publish your page to a web server otherwise the information will not be displayed due to security restrictions of the browser.

### General

**Data source**
The news feed ticker supports many data source types. It uses jQuery to fetch the data.

- **User Defined**
  This option allows you to specify the headlines manually.

- **RSS Feed**
  Select this if the data source is a RSS feed. This can be a feed on your own website or an external website. Enter the location of the RSS feed in the URL field. For local feeds (like the one created with the RSS feed object), enter ./rss.xml
  For feeds from external websites you should enter the full URL: http://www.90secondwebsitebuilder.com/rss.xml

  To overcome security problems due to cross domain restrictions we've included several data retrieval options:

  **Load data using a HTTP GET request**
  Use this option for feeds retrieved from your own domain. This option uses AJAX (Asynchronous JavaScript and XML) to fetch the data and doesn't required PHP. However AJAX requests cannot be made to a different site than the one hosting the page being viewed.

  **Load data through proxy** (this option requires PHP support on the server!)
  This option uses a PHP proxy script to fetch the data. This basically tricks the browser into thinking that the feed came from your own server. A PHP script will pull the content of the news feed to your server by using the PHP function file_get_contents() and then relay the data to the news feed ticker. This script will be automatically generated and uploaded by WYSIWYG Web Builder, so you do not have to worry about that.

  **Load data through cURL** (requires PHP)
  Some web-hosting providers may not allow the use of the PHP file_get_contents() function to fetch remote files because of security concerns. If your host supports cURL then this may be a good alternative. Consult the documentation of your host for more details. Note that here also the PHP script will be automatically generated and uploaded by 90 Second Website Builder.

- **Twitter**
  Uses JSON to get the latest messages from a specific Twitter account.

- **Flickr**
  Displays images based on the specified Flickr search query. Enter the Flickr search query in the Flickr Parameters field. For example: tags=vegas&tagmode=any, which will search for the latest images tagged with 'vegas'
Facebook
This option uses Facebook's Graph API to get status updates, photos and links from your Facebook account. To get data from the Graph API you need to enter your Facebook ID and an Access Token. You can read more about sharing Facebook data here: https://developers.facebook.com/docs/getting-started/graphapi/

Viewer type
The viewer type specifies how the headlines will be displayed:

• Default
  The items will be displayed as a static list. If the list is longer than the available space, scrollbars will be added.

• Continuous Scroll
  The items will be scrolled like a (vertical) news feed ticker. The scroller will pause on mouse over.

• SlideShow
  The items will flow into view one at a time, pause for a few seconds and then slide up to show the next item. The 'Pause for' property specifies the pause between the headlines in seconds.

• Paginate
  Paginate displays a small subset of the items art any one time, while allowing the user to move through it with navigation buttons. The 'Item per page' property specifies how many items will be displayed per page. Click the Style button to change the appearance of the paginate buttons.

• Ticker
  Uses ticker-like animations to fade and slide items into view. This effect is frequently used on new web sites.

Max items
Specifies the maximum number of items that will be retrieved from the data source.

Sort order
Specifies the order in which the items will be displayed.

Speed
Specifies the scroll speed of the text for Continuous Scroll mode.

Animation
Specifies the animation effect for the slide show mode: None, Fade, Slide Left, Slide Right, Slide Up or Slide Down

Duration
Specifies the duration of the animation.

Link Target
Specifies the target for links in the news feed ticker. For example:
  _blank, opens the link in a new window
  _self, open the link in the current frame
  _parent, open the link in the parent frame
  _top, loads the linked document in the topmost frame
Slide Show
You can use the Slide Show object to display different images in succession in the same place on the web page. For example, you could rotate among several images that advertise new products or display advertisements for other web sites. To add an image, click the Add-button. You can also assign a link to each the image. Click Edit to change the properties of an image or Remove to remove it from the list.

You specify the number of seconds to pause before displaying the next image in the sequence. If you set this value to 0 (zero), the images will not rotate automatically, but instead you can use Events to display the next or previous image. This means you can use shapes, images, text or any other object which supports events to walk through the images! There are two special Event actions defined for this purpose: SlideShow Next and SlideShow Previous. See the chapter ‘Events’ for more details.

Move Up
Move the selected image one place up.

Move Down
Move the selected image one place down.

Type
Specifies the type of slideshow
- **Sequence**
  The images will be rotated in sequence.
- **Random**
  The images will be displayed in random order.
- **Light Box Gallery**
  If you select this option then clicking the image will start a lightbox slideshow. You can select one of built-in slideshows: slimbox, prettyphoto, fancybox.
  To customize the behavior of the lightbox, you can add extra options through the 'Settings'. Please consult the documentation or website of the specific lightbox for more details about possible configuration options.
- **Conveyer Belt**
  This option creates an image slideshow which scrolls the images from right to left in a "conveyor belt" fashion.

Effect
Specifies the effect that will be used for image transitions. There are more than 25 animation effects!

Easing
The slide animations also support easing. You can select from more than 30 easing functions to control the animation process. This option can be used to (for example) create bounce or elastic effects.

Border style
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset.

Border size
Specifies the thickness of the border around the image. Set this to 0 (zero) for no border.

Border color
Specifies the color of the border around the image.

Tip:
To insert multiple images in one action hold SHIFT-key while pressing Add.
Site Search

90 Second Website Builder has basic built-in 'search engine' functionality, so visitors can search for specific words within your website. The search option does not have any special server requirements because it uses javascript, so it's very easy to insert this component to your page(s).

Note:
Before you add this object to your page, make sure you have enabled 'Generate Search Index' in Menu->Tools->Search Index otherwise the search index will not be created and the search will not work!

Hint text
The hint (or 'cue') text will displayed inside the search field if it doesn't have the focus. When the user moves their focus to the field, the label will be hidden.

Enable auto complete
The auto complete feature will allow users to type the beginning of a search term and be presented with all the possible terms that begin with the typed string (just like the Google Search engine).

No results
Specifies the text that will be displayed if the search query has no results.

Keywords
The text for the Keyword label in the search results.

Description
The text for the Description label in the search results.

Advanced tip:
To display the keyword and description label in bold, you can put them between <b> tags:
<b>Keywords:</b>.

Close button
The text on the close button

The Font name and Font Size properties can be used to specify the fonts of the result text.

Display description
Specifies whether to display the description in the search results.

Display keywords
Specifies whether to display the keywords in the search results.

Padding
Sets the amount of space between the results and the border.
Results
The search results can be displayed on the page in several different ways:

- **Show results in a new Browser Window**
  The results will be displayed in a new browser window. You can configure the properties of this window via the 'Settings' button.

- **Show results in an Inline Frame**
  The results will be displayed in an inline frame on the same page. Note that you will have to insert an inline frame object first before you select its name in the Frame property.

- **Show results in jQuery Dialog**
  The results will be displayed in a jQuery Dialog. Use the Settings button to modify the appearance of the dialog.

- **Show results in another object.**
  The results will be displayed inside another object (for instance a layer on the same page). It will replace the current content of that object. Make sure the overflow mode of that object is set to 'scroll' otherwise you may not see all results!

*How to add a 'Search button' to the search field?*
Insert an advanced button
Open the properties and select button type 'OnClick'
Select OnClick action 'Execute javascript function'
Enter 'searchPage()' in the OnClick Value field.

Note that you can basically trigger the searchPage() function from any object supporting events.

**Tip:**
If you have selected 'Show results in a new Browser Window' then you must specify the popup window settings in searchPage's arguments like this:

```
searchPage('scrollbars=yes,resizable=yes')
```

More details about the available arguments here:
[http://www.w3schools.com/jsref/met_win_open.asp](http://www.w3schools.com/jsref/met_win_open.asp)
Timer
The Timer object makes it possible to trigger actions based on timer events. For example show or hide an object after x milliseconds. Timers can also start/stop other timers! All event actions are supported (animate, show/hide, rotate, media, JavaScript etc). The possibilities are endless!

General
The Timer object supports two types:

• Interval
  Executes a function, over and over again, at specified time intervals.

• Timeout
  Executes a function, once, after waiting a specified number of milliseconds.

Interval
Specifies the interval in milliseconds.

Auto start
Specifies whether to automatically start the timer. If this option is not enabled you can start the timer through events (for example on click of a button).

Note that you can also stop the timer through events (Timer Stop).

Events
In Events you can configure what will happen when the timer expires. For example you can display or hide an object, play a media file, animate something etc.

For more information about events please read the chapter ‘Events’ of this document.
PayPal eCommerce Tools

The PayPal eCommerce Tools are the quickest and easiest way to add eCommerce to your web site. You can easily create payment buttons and basic shopping cart functionality for your web site with only a few mouse clicks! Accept payments from anyone, all you need to set up a PayPal account is an email address!

PayPal is one of the leading and more respected payment services on the Web. Best of all, it costs nothing to set up an account.


The following tools are available:

- **Buy Now Button**
  Enable e-commerce on your website by letting customers quickly buy one item at a time.

- **Add to cart Button**

- **View cart Button**
  These buttons are part of PayPal’s shopping cart solution. With the 'Add to cart' Button users can add one of more items to their shopping cart. The 'View Cart' button lets users check their cart whenever they'd like.

- **Subscription Button**
  Useful for subscriptions and recurring payments. Accept recurring payments with flexible, automated billing.

- **Donation Button**
  Accept credit card and bank account donations on your website or via email.

**Options**

You can attach 6 optional form controls so the buyer can select (for example) the size or color of a product. An option field can be either a ComboBox or an EditBox. The Label property can be used to assign a label to the option. If you leave this field empty then the object’s ID will be used.

**Step 1**
Insert a ComboBox or EditBox to the page.

**Step 2**
Select the ID of the object in the dropdown list above

Notes:
The selected options fields should not be part of another form. 90 Second Website Builder will make sure they are attached to the PayPal button and rename the objects if necessary.
Buy Now Button
When you use PayPal's Buy Now Buttons, you can sell individual items from your website. Buy Now Buttons is a low-cost way for you to accept bank account payments, and can be fully integrated with your website in a few easy steps.

General
PayPal Account: Email address for your PayPal account.
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom Image' if you want to specify a custom image.
Enable Sandbox: PayPal provides a Sandbox to allow you to test your site without actually making payments. Uncheck this option when publishing the live version of your site! More information about the PayPal's sandbox: https://developer.paypal.com/
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. Make this field empty if you want the PayPal website to open in the current window.

Details
Item name/service: Description of item. This field is optional. If omitted customers can enter an item name at time of purchase.
Item ID/number: Pass-through variable for you to track purchases passed back to you at payment completion. This field is optional. If omitted no variable is passed back to you.
Price: The price or amount of the purchase, not including shipping, handling, or tax. If omitted customers can enter an amount at time of purchase.
Tax: Transaction-based tax override variable. Set this to a flat tax amount to apply to the transaction regardless of the buyer’s location. This value overrides any tax settings set in your Profile. Default: Profile tax settings (if any) apply.
Currency: The currency of the payment. Defines the currency in which the monetary variables (amount, shipping, shipping2, handling, tax) are denoted.
Allow customers to edit quantity: When this option is enabled it allows the buyer to specify the quantity.

Shipping
Base shipping: The cost of shipping this item if you have enabled item-specific shipping costs. This field is optional.
Extra shipping: The cost of shipping each additional item. This field is optional.
Handling costs: Handling charges. This is not quantity-specific. The same handling cost is charged regardless of the number of items purchased. This field is optional.
Require shipping information: Specifies whether to prompt the customer for a shipping address.
Allow customer note: Specifies whether to prompt the customer to include a note with the payment.

URLs
Successful Payment URL: The URL to which the customer’s browser is returned after completing the payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted the customer is taken to the PayPal website.
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for example, a URL on your website that displays a “Payment Canceled” page. If omitted the Browser is directed to the PayPal website.
Buyer's Country: Defines the buyer’s language for the Login page only.

**PayPal Shopping Cart**

When you use PayPal’s free Shopping Cart on your website, your customers can purchase multiple items with a single payment, browse your entire selection, and view a consolidated list of all their items before purchasing. The PayPal Shopping Cart is a low-cost way for you to accept credit card and bank account payments, and can be fully integrated with your website in a few easy steps. When a buyer clicks the “Add to Cart” button, a new window will appear listing the contents of the buyer’s PayPal Shopping Cart, including the item just added. To make the purchase, the buyer clicks “Checkout” from this window.

**Add to Cart Button**

The Add to Cart button can be used to add an item to the shopping cart.

**General**

- **PayPal Account**: Email address for your PayPal account.
- **Button Image**: Specifies the button image that will be displayed on your webpage. Select ‘Custom Image’ if you want to specify a custom image.
- **Enable SandBox**: PayPal provides a Sandbox to allow you to test your site without actually making payments. Uncheck this option when publishing the live version of your site!
- **Target Window**: Specifies the browser window where PayPal’s website will be opened. Default: PayPal. Make this field empty if you want the PayPal website to open in the current window.

**Details**

- **Item name/service**: Description of item. This field is optional. If omitted customers can enter an item name at time of purchase.
- **Item ID/number**: Pass-through variable for you to track purchases passed back to you at payment completion. This field is optional. If omitted no variable is passed back to you.
- **Price**: The price or amount of the purchase, not including shipping, handling, or tax. If omitted customers can enter an amount at time of purchase.
- **Tax**: Transaction-based tax override variable. Set this to a flat tax amount to apply to the transaction regardless of the buyer’s location. This value overrides any tax settings set in your Profile. Default: Profile tax settings (if any) apply.
- **Currency**: The currency of the payment. Defines the currency in which the monetary variables (amount, shipping, shipping2, handling, tax) are denoted.
- **Allow customers to edit quantity**: Allows the buyer to specify the quantity.

**URLs**

- **Successful Payment URL**: The URL to which the customer’s browser is returned after completing the payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted the customer is taken to the PayPal website.
- **Cancel Payment URL**: A URL to which the customer’s browser is returned if payment is cancelled; for example, a URL on your website that displays a “Payment Canceled” page. If omitted the Browser is directed to the PayPal website.
- **Buyer’s Country**: Defines the buyer’s language for the Login page only.

**View Cart Button**

The View Cart button can be used to view the contents of the shopping cart.

**General**

- **PayPal Account**: Email address for your PayPal account.
- **Button Image**: Specifies the button image that will be displayed on your webpage. Select ‘Custom Image’ if you want to specify a custom image.

More information:

**Subscription Button**

When you use PayPal Subscriptions and Recurring Payments, your customers can purchase automatically recurring subscriptions from your website.

Subscriptions and Recurring Payments is a low-cost way for you to accept credit card and bank account payments for content site subscriptions, newsletter fees, club dues, or recurring donations, and can be fully integrated with your website in a few easy steps. Subscriptions and Recurring Payments are only available for Business or Premier accounts.

**General**

**PayPal Account**: Email address for your PayPal account.

**Button Image**: Specifies the button image that will be displayed on your webpage. Select 'Custom Image' if you want to specify a custom image.

**Enable Sandbox**: PayPal provides a Sandbox to allow you to test your site without actually making payments. Uncheck this option when publishing the live version of your site!


**Target Window**: Specifies the browser window where PayPal’s website will be opened. Default: PayPal. Make this field empty if you want the PayPal website to open in the current window.

**Details**

**Subscription name**: Enter the name of the subscription you wish to sell in the Subscription name field. If you do not enter anything in this field, your customers can complete it.

**Reference Item Number**: If you have an ID or tracking number for your item, enter it in the Reference Item Number field. This field will not be displayed to your customers at the time of payment, but they will see it in their transaction details on the PayPal website.

**Currency**: Choose the currency in which you would like this payment to be denominated. This field will default to the currency of your primary balance.

**Bill the subscriber for**: Enter your regular subscription rate.

**Length of each billing cycle**: Specifies the regular billing cycle.

**Would you like to stop the recurring payments after a certain number?**

Enable this option if you would like to end your customers’ subscriptions after a certain number of payments at your regular rates. This means that once a customer has made the specified number of payments at your regular rate, his subscription will be completed. If you disable this option your customers’ subscriptions will continue unless it is cancelled manually or by payment failure.

**Trial periods (optional)**

You may enter a trial period and rates for your subscription. To create a free trial period, enter an amount of 0. Trial periods can be entered as a number of days, weeks, months, or years.

**Reattempt on Failure**

Enable this option if you would like PayPal to automatically reattempt failed payments. Payments will be reattempted three days after the failure date. After a second failure, PayPal will try once more five days later. A third failure will lead to an automatic cancellation of the subscription.

Payments made with bank accounts are automatically reattempted once, three days after PayPal notifies the user that the payment failed. If you select No, failed payments will result in the automatic cancellation of the subscription.

**Require shipping information**: Specifies whether to prompt the customer for a shipping address.

More information:

**Donation Button**
Collect donations from a button on your website.
PayPal Donations is a low cost way for you to accept credit card and bank account donations. Integrate PayPal Donations with your website in a few easy steps.

**General**
- **PayPal Account**: Email address for your PayPal account.
- **Button Image**: Specifies the button image that will be displayed on your webpage. Select 'Custom Image' if you want to specify a custom image.
- **Enable SandBox**: PayPal provides a Sandbox to allow you to test your site without actually making payments. Uncheck this option when publishing the live version of your site!
  
- **Target Window**: Specifies the browser window where PayPal's website will be opened. Default: PayPal. Make this field empty if you want the PayPal website to open in the current window.

**Details**
- **Donation name/service**: Enter a description for the donation. If you do not enter anything in this field, your customers can complete it.
- **Donation ID/number**: If you have an ID or tracking number for your item, enter it in the Donation ID/number field. This field will not be displayed to your customers at the time of the donation, but they will see it in their transaction details on the PayPal website.
- **Currency**: Choose the currency in which you would like this payment to be denominated. This field will default to the currency of your primary balance.
- **Require shipping information**: Specifies whether to prompt the customer for a shipping address.
- **Allow customer note**: Specifies whether to prompt the customer to include a note with the payment.

**URLs**
- **Successful Payment URL**: The URL to which the customer’s browser is returned after completing the payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted the customer is taken to the PayPal website.
- **Cancel Payment URL**: A URL to which the customer’s browser is returned if payment is cancelled; for example, a URL on your website that displays a “Payment Cancelled” page. If omitted the Browser is directed to the PayPal website.
- **Buyer’s Country**: Defines the buyer’s language for the Login page only.

More information:
PHP Login Tools

Important Note:
The login tools are a set of advanced PHP forms and scripts. Please take your time to become familiar with tools. First read all available documentation and study the demo template before using them in your own project.

90 Second Website Builder has a complete built-in (PHP) login system to password protect one or more pages. Key features:

- Protect a page simply by dragging the Protect Page object to the page.
- Login and Logout forms.
- An Administrator section to add, edit or remove user accounts.
- A Signup form to allow users to sign up for an account.
- A Change Password form so users can change their password.
- A Password Recovery form, to reset the user's password.
- Custom profile fields.
- Supports both MySQL and a plain text database.
- No custom coding needed, everything is 'drag & drop'!

Requirements:
The login tools require a web server with PHP support, so the first step to start using the login tools of 90 Second Website Builder is to check whether your web host supports PHP.

Tip:
We strongly advise to use only one form per page to prevent conflicts between the scripts.

Convert to Form
All login forms include an option to convert the predefined/fixed form to a standard form (right click on the login form to display the context menu). This allows you to convert the static form into native 90 Second Website Builder objects so you can fully customize the layout and code if you like.

Note that customizing the PHP code requires knowledge of PHP. Making changes to the code without knowing what you're doing will result in undefined behavior.

Demo Template
A fully functional example template is included in the 'Demo' category of the standard Templates. This template demonstrates how to use the Login tools of 90 Second Website Builder.

Please first take your time to study the demo template before including the login tools in your own project. The most common reason for the login tools not to work on a website is due to configuration mistakes of the user.

To open the demo template:
1. Select Menu->New Website from Template
2. Select the 'Demo' category
3. Click 'Login' and the press the OK button.
4. Save the newly generated project to a folder of your choice.

Start by reading the information of the 'Getting started' page in template.

To test the completely working example you must publish all pages to a web server with PHP support. Also don’t forget to create the user database first.
User database
The login tools use a database file on the server to store the user information. The data will be stored in a semicolon separated text file or in a MySQL table. The passwords will be hashed using md5 so they will be securely saved.

The following login tools will use this database file:
- Admin
- Change Password
- Login
- Password Recovery
- Signup
- Edit Profile

Tip:
You should set the same database name for all login tools.

How do I automatically create a user database on the server?
All objects mentioned above do have a button in their properties window called 'Create database'.

1. Click the 'Create database'
2. Enter a name for the database, for example 'usersdb.php'. Click Next.
3. Select the publish location where you are going to publish this website to. Click Next.

Note:
If you do not see any publish locations, then you should add them first in the Publish window.

4. The wizard will make a connection with the server and show the folder structure.
5. Select the folder where the database should be created.
6. Click 'Finish' to create the file.
90 Second Website Builder will automatically change the permission of the file so that it's write enabled, so new users can be added.

How do I manually create a user database on the server?
A user database is basically just a text file on the server. So if for whatever reason the instructions above fail, you can try to upload the file manually yourself.

1. Open notepad or any other plain text editor and create an empty file named 'usersdb.php'.
2. Upload the file to the same folder as your protected pages. To upload the file you can use then built-in FTP tool or any other FTP application.
3. After the file has been uploaded you must modify the permissions so that the PHP script can write data to it. The correct permissions are 757 or 777.
4. Alternatively you can use the file transfer tool of your host's control panel. There should be an option in your web hosting control panel to set write permissions. If it's not present, you may can contact your web hosting service and request the write permissions for the file.

How do I prevent that user can view or download the user database from the server?
By default the user database of the login tools can be accessed by anyone that knows the file name. And although the passwords are encoded the email addresses are not hidden.

So the first thing you should do is to make sure you give the user database a unique name that can not easily be guessed.
For example: A6gr8JDaTa.php
To make the user database completely inaccessible you can create a .htaccess file in the folder on the server with the following content:

```html
<Files "usersdb.php">
  Order deny,allow
  Allow from xxx.xxx.xxx.xxx
  Deny from all
</Files>
```

...where usersdb.php is the name of the database and xxx.xxx.xxx.xxx is your IP address. See also: http://www.javascriptkit.com/howto/htaccess.shtml

**Using a MySQL database to store the user information (for advanced users only!)**

As alternative for the plain text user database you can also choose to store the users in a MySQL database. Each object has a special MySQL Database category, where you can configure the properties of the MySQL database. Before you can use this option you must create the table on the server.

Log in to your MySQL administrator utility. Create the USERS table using this SQL query:

```sql
CREATE TABLE `USERS` (  `id` int(10) NOT NULL auto_increment,  `username` varchar(50) NOT NULL,  `fullname` varchar(75) NOT NULL,  `password` varchar(50) NOT NULL,  `email` varchar(75) NOT NULL,  `active` tinyint(1) NOT NULL,  `code` varchar(75),  PRIMARY KEY (`id`) ) ENGINE=MyISAM AUTO_INCREMENT=1;
```

If you have added custom profile fields to any (or all) of the login objects then you must also create these fields in the database. Custom profile fields must be named extra1, extra2, extra3 etc!

The following SQL query generates a table with 5 extra custom profile fields:

```sql
CREATE TABLE `USERS` (  `id` int(10) NOT NULL auto_increment,  `username` varchar(50) NOT NULL,  `fullname` varchar(75) NOT NULL,  `password` varchar(50) NOT NULL,  `email` varchar(75) NOT NULL,  `active` tinyint(1) NOT NULL,  `code` varchar(75),  `extra1` varchar(100),  `extra2` varchar(100),  `extra3` varchar(100),  `extra4` varchar(100),  `extra5` varchar(100),  PRIMARY KEY (`id`) ) ENGINE=MyISAM AUTO_INCREMENT=1;
```
Admin
The Administrator object allows you to add, edit or remove users from the user database online. To enable scrolling for a large list of users, the administrator form will be displayed inside an inline frame.

**BackgroundColor**
Specifies the color of the background.

**BorderColor**
Specifies color of the border around the object.

**BorderWidth**
Specifies width of the border around the object.

**Font**
Specifies the font used to display text in the object.

**HeaderColor**
Specifies the header color.

**HeaderTextColor**
Specifies the header text color.

**Text Color**
Color of the text.

**AdminPassword**
Specifies the administrator’s password.

**CustomProfileFields**
This option can be used to add additional fields to the signup form.
New fields can be of type 'text' or 'option'. A text field adds a standard editbox, while the option fields adds a combobox to give the user multiple choices.
You can also mark a field as 'Required'.

The 'Apply to All' button can be used to apply the custom profile fields to all Login tools within the project, so you do not have to manually synchronize them.

**Important Notes:**
All login tool objects in the project should have the same custom profile fields!
When adding custom profile fields and you use a MySQL database then you must also add these fields to the database!

**Database**
Specifies the user database. This value will be ignored if you are using MySQL!

**FrameName**
The 'FrameName' property specifies the name of this inline frame.

**MySQL Database (for advanced users only)**
As alternative for the plain text user database you can also choose to store the users in a MySQL database. This requires you to create a new table on the MySQL Server. See User Database for more details.

**EnableMySQL**
Specifies whether to use a MySQL database
**Database**
Specifies the MySQL database name.

**Password**
Specifies the MySQL password.

**Server**
Specifies the MySQL database server.

**Table**
Specifies the MySQL table name.

**UserName**
Specifies the MySQL username.
**Change Password**
The Change Password object allows users to change their password. The user must be logged in to be able to change the password.

**Important Note:**
The page must have the File Extension 'php'! You can change the file extension in the Page Properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BackgroundColor</strong></td>
<td>Specifies the color of the background.</td>
</tr>
<tr>
<td><strong>BorderColor</strong></td>
<td>Specifies border color.</td>
</tr>
<tr>
<td><strong>BorderWidth</strong></td>
<td>Specifies border width.</td>
</tr>
<tr>
<td><strong>ButtonImage</strong></td>
<td>Specifies the image to be displayed for the button when the ButtonType property is set to 'Image'.</td>
</tr>
<tr>
<td><strong>ButtonText</strong></td>
<td>Specifies the text to be shown for the button when the ButtonType property is set to 'Button' or 'Link'.</td>
</tr>
<tr>
<td><strong>ButtonType</strong></td>
<td>Specifies the type of the button. You can choose from 3 types: Button, Image or Link.</td>
</tr>
<tr>
<td><strong>ConfirmPasswordErrorText</strong></td>
<td>Specifies the text to be shown when the password and confirm password do not match.</td>
</tr>
<tr>
<td><strong>ConfirmPasswordLabelText</strong></td>
<td>Specifies the text that identifies the confirm password text box.</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Specifies the font used for text within the object.</td>
</tr>
<tr>
<td><strong>NewPasswordInvalidErrorText</strong></td>
<td>Specifies the text to be shown when the new password is invalid.</td>
</tr>
<tr>
<td><strong>NewPasswordLabelText</strong></td>
<td>Specifies the text that identifies the new password text box.</td>
</tr>
<tr>
<td><strong>NotLoggedInErrorText</strong></td>
<td>Specifies the text to be shown when the user is not logged in.</td>
</tr>
<tr>
<td><strong>OldPasswordInvalidErrorText</strong></td>
<td>Specifies the text to be shown when the old password is invalid.</td>
</tr>
<tr>
<td><strong>PasswordLabelText</strong></td>
<td>Specifies the text that identifies the password text box.</td>
</tr>
<tr>
<td><strong>Spacing</strong></td>
<td>Specifies the spacing between controls.</td>
</tr>
<tr>
<td><strong>TextColor</strong></td>
<td>Specifies text color.</td>
</tr>
</tbody>
</table>

185
TitleBackColor
Specifies background color of the title.

TitleColor
Specifies text color of the title.

TitleText
Specifies the text shown for the title.

Database
Specifies the user database. This value will be ignored if you are using MySQL!

DestinationPage
Specifies the page that the user is directed to upon successful login.

MySQL Database
As alternative for the plain text user database you can also choose to store the users in a MySQL database. This requires you to create a new table on the MySQL Server. See User Database for more details.

EnableMySQL
Specifies whether to use a MySQL database

Database
Specifies the MySQL database name.

Password
Specifies the MySQL password.

Server
Specifies the MySQL database server.

Table
Specifies the MySQL table name.

UserName
Specifies the MySQL username.
**Login**
The Login object provides a standard form to login to the protected pages.

<table>
<thead>
<tr>
<th>Important Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The page must have the File Extension 'php'! You can change the file extension in the Page Properties.</td>
</tr>
</tbody>
</table>

**BackgroundColor**
Specifies the color of the background.

**BorderColor**
Specifies border color.

**BorderWidth**
Specifies border width.

**ButtonImage**
Specifies the image to be displayed for the button when the ButtonType property is set to 'Image'.

**ButtonText**
Specifies the text to be shown for the button when the ButtonType property is set to 'Button' or 'Link'.

**ButtonType**
Specifies the type of the button. You can choose from 3 types: Button, Image or Link.

**PasswordLabelText**
Specifies the text that identifies the password text box.

**RememberMeText**
Specifies the text to be shown for the remember me checkbox.

**Spacing**
Specifies the spacing between controls.

**TitleBackColor**
Specifies background color of the title.

**TitleColor**
Specifies text color of the title.

**TitleText**
Specifies the text shown for the title.

**UsernameLabelText**
Specifies the text that identifies the user name textbox.

**Database**
Specifies the user database. This value will be ignored if you are using MySQL!

**DestinationPage**
Specifies the page that the user is directed to upon successful login.

**ErrorPage**
Specifies the page that the user is directed to upon failed login.

**DisplayRememberMe**
True if the remember me checkbox is displayed.
Logout
The Logout object gives the user the option to login.

Important Note:
The page must have the File Extension 'php'!
You can change the file extension of a page in the Page Properties.

BackgroundColor
Specifies the color of the background.

BorderColor
Specifies border color.

BorderWidth
Specifies border width.

Font
Specifies the font used for text within the object.

ButtonImage
Specifies the image to be displayed for the button when the ButtonType property is set to 'Image'.

ButtonText
Specifies the text to be shown for the button when the ButtonType property is set to 'Button' or 'Link'.

ButtonType
Specifies the type of the button. You can choose from 3 types: Button, Image or Link.

TextColor
Specifies text color.

LogoutPage
Specifies the page that the user is directed to upon log out.
**Password Recovery**
The Password Recovery object allows users to reset their password. An email message will be sent with the new (random) password. If the user wants to change the password, he can use the Change Password form.

<table>
<thead>
<tr>
<th>Important Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The page must have the File Extension 'php'! You can change the file extension in the Page Properties.</td>
</tr>
</tbody>
</table>

**BackgroundColor**
Specifies the color of the background.

**BorderColor**
Specifies border color.

**BorderWidth**
Specifies border width.

**ButtonImage**
Specifies the image to be displayed for the button when the ButtonType property is set to 'Image'.

**ButtonText**
Specifies the text to be shown for the button when the ButtonType property is set to 'Button' or 'Link'.

**ButtonType**
Specifies the type of the button. You can choose from 3 types: Button, Image or Link.

**Spacing**
Specifies the spacing between controls.

**TitleBackColor**
Specifies background color of the title.

**TitleColor**
Specifies text color of the title.

**TitleText**
Specifies the text shown for the title.

**EmailLabelText**
Specifies the text that identifies the user name textbox.

**Database**
Specifies the user database. This value will be ignored if you are using MySQL!

**SuccessPage**
Specifies the page that the user is directed to after the action has succeeded.

**Email From**
Specifies the from email address.

**Email Message**
Specifies the email message.

**Email Subject**
Specifies the email subject.
Protected Page
To protect any page from your website, simply drag & drop the 'Protected Page' object to the page. If the user is not logged in he will be redirected to the 'Access Denied Page'.

<table>
<thead>
<tr>
<th>Important Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The page <strong>must</strong> have the File Extension 'php' ! You can change the file extension in the Page Properties.</td>
</tr>
</tbody>
</table>

Access Denied Page
Specifies the page that the user is directed to if not logged on.

AllowUsers
Specifies the users who can access the page. You can enter a list of comma-delimited users:
Bill,Steve,Gary
If you leave this property empty, then all registered users can access the page.
**Signup**
The Signup object allows users to sign up for a new user account. The new account will be created immediately after the user has completed the form. An email message will be sent to the specified email address with the login details.

Note that anyone can create an account, so use this object only for public pages!

<table>
<thead>
<tr>
<th>Important Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The page must have the File Extension 'php'! You can change the file extension in the Page Properties.</td>
</tr>
</tbody>
</table>

- **BackgroundColor**
  Specifies the color of the background.

- **BorderColor**
  Specifies border color.

- **BorderWidth**
  Specifies border width.

- **ButtonImage**
  Specifies the image to be displayed for the button when the ButtonType property is set to 'Image'.

- **ButtonText**
  Specifies the text to be shown for the button when the ButtonType property is set to 'Button' or 'Link'.

- **ButtonType**
  Specifies the type of the button.

- **CaptchaEnabled**
  Specifies whether CAPTCHA should be enabled.

- **CaptchaLabelText**
  Specifies the text that identifies the CAPTCHA field.

- **ConfirmPasswordErrorText**
  Specifies the text to be shown when the password and confirm password entered by the user do not match.

- **ConfirmPasswordLabelText**
  Specifies the text that identifies the confirm password text box.

- **EmailInvalidErrorText**
  Specifies the text to be shown when the email address entered by the user is invalid.

- **EmailLabelText**
  Specifies the text that identifies the email text box.

- **Font**
  Specifies the font used for text within the object.

- **FullnameInvalidErrorText**
  Specifies the text to be shown when the full name entered by the user is invalid.

- **FullnameLabelText**
  Specifies the text that identifies the full name text box.
**PasswordInvalidErrorText**
Specifies the text to be shown when the password entered by the user is invalid.

**PasswordLabelText**
Specifies the text that identifies the password text box.

**Spacing**
Specifies the spacing between controls.

**TextColor**
Specifies text color.

**TitleBackColor**
Specifies background color of the title.

**TitleColor**
Specifies text color of the title.

**TitleText**
Specifies the text shown for the title.

**UsernameAlreadyUsedErrorText**
Specifies the text to be shown when the username already exists.

**UsernameInvalidErrorText**
Specifies the text to be shown when the username entered by the user is invalid.

**UsernameLabelText**
Specifies the text that identifies the user name text box.

**Behavior**

**Account activation**
Specifies whether to enable account activation by the administrator. If this option is ‘Administrator’, new accounts will not be activate until the administrator enables them.
If this option is “Automatic' then the account will be enabled immediately after the user has completed the form.
If the ‘Email’ verification option is selected then the user must activate the account via a link in the confirmation email before it will be activated. This makes sure the specified email is valid.

**Tip:**
If you enable email verification then you probably want to include some instructions in the email message to tell the user to use the activation link in the message to activate the account!
**CustomProfileFields**
This option can be used to add additional fields to the signup form. New fields can be of type 'text' or 'option'. A text field adds a standard editbox, while the option fields adds a combobox to give the user multiple choices. You can also mark a field as 'Required'.

The 'Apply to All' button can be used to apply the custom profile fields to all Login tools within the project, so you do not have to manually synchronize them.

**Important Notes:**
All login tool objects in the project should have the same custom profile fields!
When adding custom profile fields and you use a MySQL database then you must also add these fields to the database!

**Database**
Specifies the user database. This value will be ignored if you are using MySQL!

**SuccessPage**
Specifies the page that the user is directed to after the action has succeeded.

**Email**
**AdminEmailAddress**
Specifies the email address of the administrator. This can be left empty.
A copy of the signup confirmation email will be send to this address.

**Email From**
Specifies the from email address.

**Email Message**
Specifies the email message.

**Email Subject**
Specifies the email subject.

**Edit Profile**
The Edit Profile object allows a user to edit his/her account settings. The user must be logged on to be able to access the profile.

This object is very similar to the Sign Up object and most properties are the same.
Content Management System

Important Note:
The Content Management System tools are a set of advanced PHP forms and scripts. Please take your

time to become familiar with tools. First read all available documentation and study the demo template

before you start using them in your own project!

90 Second Website Builder has a complete built-in (PHP based) content management system to allow

you or your customers to manage content online. The basic idea is that the content of the page will be
display inside a fixed area on the page, this is the CMS View. You can think of this as an inline frame or
content place holder, although the content will be dynamically merge with the rest of the page when the
page is requested from the server. Basically this means that you can have only one page for the whole
website and the rest of the content is managed on the server. Although you can mix dynamic and fixed
content! The layout of the page (also called the master border) can be designed with the standard 90
Second Website Builder tools. The navigation (CMS Menu) will be automatically generated based on the
site structure on the server, so you don't have to fill the menus manually.

Note:
It's important to understand that this Content Management System is not a replacement for online
solutions like Joomla, Drupal or WordPress. The CMS was designed as a supplement, not a replacement
for 90 Second Website Builder websites. So you will create the layout in the software and the content
online.

Also a CMS is not an online HTML editor. You do not edit the entire page, only the content area!

Key features:
- Online administrator panel to add/edit/copy and remove pages.
- The administrator panel supports several popular editors like CKEditor, TinyMCE and CLEditor.
  It also has a simple built-in editor.
- You can hide pages from the menu structure which currently under construction.
- CMS has several individual 'design blocks' to give you as much flexibly as possible, so you can
easily integrate the tools into your existing layouts.
- A CMS View object, which is a place holder for the online content.
- A CMS Menu object, which can be used to navigate between online pages. The menu has many
customizable options.
- A CMS search object, which can be used to search online content. The search index will
  automatically be created/updated by the CMS.
- A CMS label object, this can be used to display the title of the page, the creation date, author,
  page views etc anywhere on the page.
- CMS integrates with the login tools so you can assign different users to the CMS but also have a
  global admin.
- The CMS supports external pages, so you can mix online content with standard pages. Or even
  pages from other websites.
- Includes a simple File Manager which can be used to upload and manage online files (like
  images).
- Supports plug-ins to extend the functionally of the CMS with (for example a guestbook,
  comments, password protection, a web shop etc).

Requirements:
The login tools require a web server with PHP support and MySQL, so the first step before you start
using the CMS tools of 90 Second Website Builder is to check whether your web host supports PHP/
MySQL!

A fully functional example template is included in the 'Demo' category of the standard Templates.
CMS Database

The Content Management System requires a database to store the page data and other related information. This system uses MySQL, so your hosting account must have access to a MySQL database. Most payed hosting accounts do have database support included. And otherwise please contact your host to upgrade your existing hosting plan.

After checking if your website supports MySQL you should either create a new database or write down the details of an existing database. Please consult the documentation of your host for more details on how to create a database. This is different for each host so there are no generic instructions we can give you for that. To be able to use the CMS tools you will need to following information:

- **Server**
  Specifies the MySQL database server.

- **Database**
  Specifies the MySQL database name.

- **UserName**
  Specifies the MySQL username.

- **Password**
  Specifies the MySQL password.

The CMS will automatically create the required tables if they do not exists, so you do not have to create the tables manually. The following tables will be created (note that the table prefix 'CMS_' is configurable):

**CMS_PAGES**
This table contains the page information like page title, content, created/updated date, view count etc.

**CMS_SEARCH_WORDS**
This table is part of the search index and contains all unique words.

**CMS_SEARCH_WORDMATCH**
This table is part of the search index and contains the word to page relationship.

Although these tables will be automatically created the first time you login to the CMS Admin, you can also create them manually.

```sql
-- Table structure for table `CMS_PAGES`

CREATE TABLE `CMS_PAGES` (    `id` int(10) unsigned NOT NULL auto_increment,    `category_id` int(11) NOT NULL,    `name` varchar(255) NOT NULL,    `content` text NOT NULL,    `home` tinyint(1) NOT NULL default '0',    `visible` tinyint(1) NOT NULL,    `create_date` timestamp NOT NULL default CURRENT_TIMESTAMP on update CURRENT_TIMESTAMP,    `created_by` varchar(255) NOT NULL,    `last_update_date` timestamp NOT NULL default '0000-00-00 00:00:00',    `last_update_by` varchar(255) NOT NULL,    `views` int(11) NOT NULL,    `menu_index` smallint(4) NOT NULL,    `url` varchar(255) NULL,    `extra_data` varchar(255) NULL,    `title` VARCHAR(100),    `description` VARCHAR(255),    `keywords` VARCHAR(255),    `seo_friendly_url` VARCHAR(100),    PRIMARY KEY (`id`));
```
```
-- Table structure for table `CMS_SEARCH_WORDMATCH`

CREATE TABLE `CMS_SEARCH_WORDMATCH` (  
    `page_id` int(10) unsigned NOT NULL,  
    `word_id` int(10) unsigned NOT NULL,  
    PRIMARY KEY (`page_id`,`word_id`));

-- Table structure for table `CMS_SEARCH_WORDS`

CREATE TABLE `CMS_SEARCH_WORDS` (  
    `id` int(10) unsigned NOT NULL auto_increment,  
    `word` varchar(50) NOT NULL,  
    PRIMARY KEY (`id`));
```
CMS Admin

Important Note:
The Content Management System tools are a set of advanced PHP forms and scripts. Please take your time to become familiar with tools. First read all available documentation and study the demo template before you start using them in your own project!

The CMS Administrator object allows you to add, edit or remove pages online. You can (optional) install your favorite online HTML editor (like CKEditor, TinyMCE and CLEditor) to make the CMS tools even more powerful.

<table>
<thead>
<tr>
<th>Name</th>
<th>Created by</th>
<th>Last update</th>
<th>Visible</th>
<th>Home page</th>
<th>Views</th>
<th>Order</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Page</td>
<td>admin</td>
<td>2011-09-22 06:30:40</td>
<td>Yes</td>
<td>Yes</td>
<td>147</td>
<td>Down</td>
<td>Edit</td>
</tr>
<tr>
<td>Another comment</td>
<td>admin</td>
<td>2011-08-24 09:20:02</td>
<td>Yes</td>
<td>No</td>
<td>25</td>
<td>Up</td>
<td>Down</td>
</tr>
<tr>
<td>Pretty cool stuff!</td>
<td>admin</td>
<td>2011-08-13 04:10:03</td>
<td>Yes</td>
<td>No</td>
<td>41</td>
<td>Up</td>
<td>Down</td>
</tr>
<tr>
<td>Inline frame test</td>
<td>admin</td>
<td>2011-08-13 04:31:42</td>
<td>Yes</td>
<td>No</td>
<td>32</td>
<td>Up</td>
<td>Down</td>
</tr>
<tr>
<td>pagina 1</td>
<td>admin</td>
<td>2011-08-12 11:18:18</td>
<td>Yes</td>
<td>No</td>
<td>59</td>
<td>Up</td>
<td>Down</td>
</tr>
<tr>
<td>new stuff!</td>
<td>admin</td>
<td>2011-08-13 10:39:10</td>
<td>Yes</td>
<td>No</td>
<td>5</td>
<td>Up</td>
<td>Down</td>
</tr>
<tr>
<td>Lorem ipsum</td>
<td>admin</td>
<td>2011-08-12 11:12:39</td>
<td>Yes</td>
<td>No</td>
<td>52</td>
<td>Up</td>
<td>Down</td>
</tr>
</tbody>
</table>

Appearance

Background Color
Specifies the color of the background.

Border Color
Specifies color of the border around the object.

Border Width
Specifies width of the border around the object.

Font
Specifies the font used to display text in the object.

Title Color
Specifies the title color.

Title Text Color
Specifies the title text color.

Text Color
Color of the text.

Behavior

Admin Password
Specifies the administrator’s password.

 Allow Users
Specifies the users who can access the admin section. You can enter a list of comma-delimited users: Bill,Steve,Gary. These users should exist in your Login Tools configuration! If you leave this property empty, then all only the administrator can login (using the password specified under AdminPassword).
Asset Folder
Specifies the (online) folder where new files will be uploaded to.
If you specify ./files then a folder with the name 'files' should exist in the current folder on the server
and it should have write permissions. The folder can/will not be automatically created so you must
create this yourself on the server.

Frame Name
To enable scrolling for a large list of pages, the CMS administrator will be displayed inside an inline
frame. The 'FrameName' property specifies the name of this inline frame. Normally you do not have to
edit this.

You can 'breakout' of the frame by directly linking to the script file like this:
./cmsadmin.php
or using the full URL:
http://www.yourwebsite.com/cmsadmin.php

In that case the full browser window ill be used.

Disable Page Management for users
Enable this option to hide "Create new page", "Copy", "Delete", "Set homepage" and "Order" for
standard users. The options will still be available for the administrator.

Enable Error Reporting
If you enable this option the script will activate detailed PHP error reporting. This may be helpful is you
are experiencing problems with the CMS scripts on the server. If PHP Error Reporting is enabled more
details about the error will be displayed.

Session timeout
The administrator will be logged out automatically if the session is idle (based on the specified timeout).

MySQL Database
Please read CMS Database for more details.

Database
Specifies the MySQL database name.

Password
Specifies the MySQL password.

Server
Specifies the MySQL database server.

Table Name
Specifies the MySQL table name prefix. The required tables will be automatically created in the specified
database.

User Name
Specifies the MySQL username.
Editor

In this section you can specify which editor will be used for editing the online content. 90 Second Website Builder supports several popular editors like CKEditor, TinyMCE and CLEditor. It also has a simple built-in editor.

Note:
Due to license restrictions we are not allowed to distribute some of these editors with 90 Second Website Builder so you will have to manually install them on your computer before you will be able to use them. However once installed on your computer, 90 Second Website Builder will take care of publishing and configuring the editors.

Editor Height
Specifies the height of the editor.

Editor Type
Specifies the editor type. The CMS Admin object has built-in support for the following editors:

- **Textarea**
  Standard plain text editor. No special requirements.

- **WWB Editor**
  A simple online text editor created by the 90 Second Website Builder team. Supports basic text formatting and has configurable toolbar.

- **CLEditor**
  CLEditor is an open source jQuery plugin which provides a lightweight, full featured, cross browser, extensible, HTML editor.
  http://premiumsoftware.net/cleditor

- **TinyMCE (jQuery version)**
  TinyMCE is a platform independent web based Javascript HTML editor control released as Open Source under LGPL by Moxiecode Systems AB.
  http://www.tinymce.com/

- **CK Editor**
  CKEditor is a text editor to be used inside web pages. It’s a WYSIWYG editor, which means that the text being edited on it looks as similar as possible to the results users have when publishing it. It brings to the web common editing features found on desktop editing applications like Microsoft Word and OpenOffice.
  http://ckeditor.com/

Disclaimer:
Although we’ve added support for third party online editors, we do not and cannot give support on their functionality. Most online editors make use of the built-in HTML edit functionality of the browser, so you may notice different behavior between browsers. Unfortunately we have absolutely no control over that. We found that Internet Explorer currently has the most stable implementation of online editing.
The editors must be installed in the My Documents\90 Second Website Builder\system\cms folder.

Each editor has its own folder:
My Documents\90 Second Website Builder\system\cms\ckeditor
My Documents\90 Second Website Builder\system\cms\cleditor
My Documents\90 Second Website Builder\system\cms\tinymce
My Documents\90 Second Website Builder\system\cms\wwbeditor

**Editor Settings**

Specifies additional editor settings.

Most editors have many configuration options. To keep this solution as generic as possible we added this option so you can fine-tune the editor if you wish. Consult the documentation of the specific editor for more details.

Here’s an example for the WWB Editor which allows you to modify the toolbar. For the full toolbar you can use the following settings:

```javascript
buttons:
{
    'undo': false,
    'redo': false,
    'bold': true,
    'italic': true,
    'underline': true,
    'strikethrough': true,
    'justifyleft': true,
    'justifycenter': true,
    'justifyright': true,
    'justifyfull': true,
    'insertorderedlist': true,
    'insertunorderedlist': true,
    'indent': true,
    'outdent': true,
    'createLink': true,
    'unlink': true,
    'insertimage': true,
    'inserthorizontalrule': false,
    'cut': false,
    'copy': false,
    'paste': false,
    'forecolor': true,
    'hilitecolor': true,
    'br': true,
    'formatblock': true,
    'fontname': true,
    'fontsize': true
}
```
Or for a basic toolbar you can use:

```javascript
buttons:
{
'undo': false,
'redo': false,
'bold': true,
'italic': true,
'underline': true,
'strikethrough': true,
'justifyleft': false,
'justifycenter': false,
'justifyright': false,
'justifyfull': false,
'insertorderedlist': false,
'insertunorderedlist': false,
'indent': false,
'outdent': false,
'createLink': false,
'unlink': false,
'insertimage': false,
'inserthorizontalrule': false,
'cut': false,
'copy': false,
'paste': false,
'forecolor': true,
'hilitecolor': true,
'br': true,
'formatblock': true,
'fontname': true,
'fontsize': true
}
```

Here's another example for tinymce. This code enables the 'advanced theme:

```javascript
theme : "advanced"
```

and this example enables various plugins:

```javascript
theme : "advanced",
plugins :
"pagebreak,style,layer,table,save,advhr,advimage,advlink,emotions,iespell,inlinepopups,insertdatetime,preview,media,searchreplace,print,contextmenu,paste,directionality,fullscreen,noneditable,visualchars,nonbreaking,xhtmlxtras,template"
```

Multiple options must be separated by commas (the last item does not have a comma! at the end):

```javascript
option1 : "string_value",
option2: true,
option3 : numeric_value
```

**Publish editor files**

Specifies whether to publish the editor files.

If this option is enabled then WWB will publish/upload all files from the editor to your website. Note that some editor use a lot of files so this may take a while.

In general you enable this option the first time you published your website and after that disable it so the files will be published the second time.

If you are an advanced user you can also upload the editor manually by using your favorite FTP client.
**How to add a new page?**

1. Log into the admin section online. Either use the AdminPassword or log in by using a username/password from the login tools (in that case you must login using the login form).
2. Add a new page by clicking the 'New page' option.
3. In the Name field enter the name of the page. This name will be displayed in the CMS Menu.
4. The Content field contains the content of the page. If you have setup one of the editors then you will see a What-You-See-Is-What-You-Get editor. Otherwise you will see the standard text input which allows you to either enter plain text or HTML code.
5. The External URL field can be used to specify a link to an external page. This field should empty for standard pages! See 'How to include external pages' for more details.
6. The Extra data field can be used to assign extra data to a page and make it part of the layout. See 'How to assign extra data and display it on the page?' for more details.
7. Visible specifies whether the page should be displayed in the CMS Menu.
8. Click Save to save the new page.

**How to include external pages in the CMS?**

1. Add a new page by clicking the 'New page' option in the Administrator.
2. Give the new page a name for example 'External page'.
3. Leave the content area empty.
4. Enter the URL of the external page in the URL field. This can either be an external page: http://www.wysiwygwebbuilder.com/ or an internal page: ./internalpage.html

**How to assign extra data and display it on the page?**

You can assign extra data to a page and make it part of the layout. While in page editor mode of the administrator you will notice the 'Extra data' field, here you can write some text like a slogan which applies to the page.

In your page layout you can then use the CMS label object to display this text anywhere in the layout by using the $cms_extra_data variable.

**CMS Plug-ins**

Plug-ins can add new commands to the plug-in menu (like the User Manager and File Manager). Or add new functionality to the page. For instance, the 'Comments' plug-in adds the ability for users to post comments on a page.

Plug-ins for the CMS are stored in the folder My Documents\90 Second Website Builder\system\plugins\Advanced users can modify the standard plug-ins to suit them to their needs or create new plug-ins. We have created a few plug-ins to demonstrate the new functionality and we will improve them in a future release if users find them useful.

Here's a list of plug-ins that are current available. They can be enabled through the 'plugins' property of the CMS Admin object. Enabled plug-ins will be uploaded to the server and placed in a sub folder (plugins) of the current folder.

You can enable/disable plug-ins online with the plug-in manager or by renaming the folder name (insert an underscore in front of the folder name. For example rename filemanager to _filemanager). Or simply remove the entire folder from the server.

**Important:**

Only publish the plug-ins you really need because all plug-ins will be loaded/processed by all pages even if they are not enabled for the page. So having too much plug-ins on the server may slow down the performance of the CMS.
**User Manager plug-in**
Add/Edit/Remove users online. This makes it possible to manage users without the need to integrate with WWB’s login tools. Added users will be able to add or edit their own pages.

**Comments plug-in**
Adds the ability to post comments on a page.

**Discussion plug-in**
The Discussion plug-in enables you to add comments functionality to the page. Users can comment on the content of the page and other users will be able to post replies to the comment to start a discussion.

**Downloads plug-in**
Automatically creates a list of links from files in a folder.

**FAQ plug-in**
Create a simple Frequently Asked Questions (FAQ) page.

**Password plug-in**
Protect the CMS page with a password. This can be configured per page and each page can have its own password.

**File Manager plug-in**
Implements a basic file manager to upload files to the CMS.

**File Manager Plus plug-in**
A ‘plus’ version of the File Manager. Can be used to upload, rename and remove files and folders. Only for advanced users!

**Form plug-in**
Dynamically create forms online. Supports basic form validation (based on the selected input type) and reCAPTCHA. Submitted data can be sent in email and/or stored in a database and exported to CSV later.

**Guestbook plug-in**
Basic guestbook that can be integrated in the CMS.

**Mailing list plug-in**
Collect and manage email addresses in a mailing list. Users can subscribe to the mailing list by submitting their email address in the standard form. A confirmation email is sent to verify the email address. The admin can send messages to the subscribed users.

**Photo album plug-in**
The Photo Album plug-in is a basic online photo album solution for the CMS. It will display images from a folder on the server.

**Slideshow plug-in**
The Slide Show plug-in adds a slideshow to the CMS page.

**Plug-in Manager**
The plug-in manager can be used to enable/disable CMS plug-ins online.

**Poll plug-in**
A simple poll plug-in.

**Tell-a-friend plug-in**
Adds a basic tell-a-friend form to the CMS page.
Notes about plug-ins:
Each plug-in will automatically generate one or more database tables on the MySQL server! Tables will not be removed when you remove the plug-in!

The generated tables contain the plug-in configuration and other data (for example the guestbook plug-in will store messages). So you should only install the plug-ins you actually need otherwise you will end up with a lot of (unused) database tables.
CMS Label

The CMS label object must be on the same page as the CMS View object!
This object can be used to display the title of the current page, the creation date, author, page views etc anywhere on the page. It's a standalone object so you can position it individually of the CMS view object, for example as a page header or side bar.

General

Text

Specifies the text to be display in the label. The following variables are available:

- $cms_views
  The number of times the page has been viewed.
- $cms_name
  The name of the page.
- $cms_created_by
  The name of the creator of the page.
- $cms_create_date
  Displays the creation date of the page.
- $cms_last_update_date
  Displays the date the page was last modified.
- $cms_extra_data
  Displays the 'extra data' field of the page, which you can assign in the administer tool.

These variables will be replaced by the actual data from the CMS database and are directly related the the currently displayed pages inside the CMS View.
Note that the variables can be mixed with standard text, so for example you can use:
This pages was last modified on $cms_last_update_date by $cms_created_by

Alignment

Specifies horizontal alignment of the text.

Style

In this section you can modify the appearance of the object. For more details about object styling please read Style.
CMS Menu
The CMS Menu object must be on the same page as the CMS View object!
This object can be used to navigate between pages which are displayed inside the CMS View object. The CMS menu has many styling options. The items in the menu are driven by the CMS database, so you don’t have to configure the links manually.

General
Layout mode
The menu can be either vertical or horizontal.

Button size
Specifies the whether the button size is fixed or variable.
If fixed is selected, you can specify the width/height of the buttons through the width and height properties. If variable is selected then the size of the button depends on the text size in combination with the padding settings.

Spacing
This settings specifies the space between 2 buttons.

Use SEO friendly links
If you enable this option the menu will use SEO (Search Engine Optimization) friendly links in the navigation:
instead of

Note that the link names are based on the page title as specified in the CMS Admin. So you must specify a title in the administrator before this option can be used.

Style
In this section you can modify the appearance of the menu items. For more details about object styling please read Style.

Style Hover
In this section you can modify the appearance of the menu items when the mouse hovers over the object.
CMS Search
The CMS Search object must be on the same page as the CMS View object!

This object can be used to search online content. 90 Second Website Builder’s CMS will automatically add search words to the search index every time a page is created or updated. The search index table keeps track of all unique words within the system and stores references to the pages containing these words for fast search results. The results of the search query will be displayed inside the CMS view object.

General
Hint text
The hint (or ‘cue’) text will be displayed inside the search field if it doesn’t have the focus. When the user moves their focus to the field, the label will be hidden.

Results
Defines the appearance of the result inside the CMS view object.

No results
Specifies the text that will be displayed if the search query has no results.

Font
Specifies the font family of the text, such as Comic Sans, Times New Roman, and Courier New.

Font size
Specifies the size of the text.

Text Color
Specifies the color of the text.

Background color
Specifies the background color of the results.

Link color
Specifies the color of links.

Padding
Sets the amount of space between the results and the border.
CMS View
The CMS View object is a place holder for the online content. This is the most important part of the Content Management System because all page content will be displayed inside this area. You will navigation between pages by using the CMS Menu object. The CMS View object will also be used to display the result of a search query of the CMS Search Object. Normally your website will have only one CMS View object and there will be only one page in the Site Manager used for the system (or two if you have a separate page for the CMS Admin).

MySQL Database
Please read CMS Database for more details.

Database
Specifies the MySQL database name.

Password
Specifies the MySQL password.

Server
Specifies the MySQL database server.

Table Name
Specifies the MySQL table name prefix. The required tables will be automatically created in the specified database.

User Name
Specifies the MySQL username

General
Mode
Specifies the mode of the CMS view.

• Variable Content (default)
The content of the CMS View will be controlled by the navigation. The visitor of the website decides which page will be displayed (via the CMS Menu). A page can only contain one CMS View that is set to 'Variable'!

• Fixed Content
The content of the view is fixed and is not controlled by the visitor through navigation. The view will always display the same page (as specified by the page id property). This option can be useful if you want to display a fixed header or footer where the content is loaded from the CMS database. You can use multiple "Fixed content' CMS views per page. For instance for a header text, footer or other content.

Since this option requires you to specify a (valid) page ID, you must first create the content of the page in the online CMS Admin. You always may want to set the visible option of the page to 'hidden'. So that it will not be displayed in the menu, but only will be used for the fixed view.

Note: You can view the page id in the admin section. For instance: hover with your mouse over the 'edit' link (or any of the other actions) and note the page id in the status bar of the browser.
Overflow
The overflow property can be used to control the overflow behavior of the view.

- None
  The content of the view is fully visible. No clipping will occur.
- Hidden
  The content is clipped, but the browser does not display a scroll-bar to see the rest of the content.
- Scroll
  The content is clipped, but the browser displays a scroll-bar to see the rest of the content.
- Auto
  If the content is clipped, the browser will display a scroll-bar to see the rest of the content.

Use AJAX to load content
Allow the user to quickly navigate between pages without have to reload the whole page! Only the content will be refreshed. Note that this uses jQuery in the background, so JavaScript must be enabled.

Use title and meta tags from database for Search Engine Optimization.
Enable this option to use the title, description and keywords from the CMS database (specified in CMS Admin) instead of the title/meta tags configured in Page Properties.
This makes it possible to optimize the pages for SEO, because now each page will have its own title and metatags.
jQuery Accordion

The jQuery Accordion object is named after the musical instrument, in the way the expansion of one area leads to the contraction of another. Typically, accordions are fixed so that only of the areas is visible at same time. This object is based on the Accordion Widget of the jQuery UI library: [http://jquery.com/](http://jquery.com/).

Adding objects to the Accordion’s Panels

You can easily add objects to the accordion panels by dragging them on the component. This works the same way as for layers or forms.

To be able to drag & drop objects to the accordion first make sure it's large enough so the objects can be dragged on it (the accordion object should be larger than the object you're adding!).

A blue border around the panel will indicate that the dragged object will become part of the accordion.

To add items to another panel simply click the header to make it active.

General

In the General page you can add, edit and remove panels.

Note:
Removing a panel will also remove all objects that are part of this panel!

Style

You can control the appearance of the Accordion widget in Style Properties.
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: [http://jqueryui.com/themeroller/](http://jqueryui.com/themeroller/).

The **Font name** and **Font Size** properties can be used to override the default font of the theme.

Padding

The padding properties control the text padding of the headers.

Icon Offset

The expand/collapse icon offset can be with Icon Offset.

Animation

The Animation property enables the slide animation for hiding and showing panels.

Activate on Mouseover

Activate on Mouseover can be enabled to change the active panel on mouse over instead of the standard mouse click.
jQuery Auto Complete

AutoComplete can replace a standard editbox. It enables users to quickly find and select from a pre-populated list of values as they type. The list can be either local or from a remote location (AJAX). The jQuery AutoComplete is based on the AutoComplete Widget of the jQuery UI library: http://jquery.com/.

General

Data Source
Specifies the source for the auto complete items.
- Local
  Uses an local array as the data source. The items can be added, edited or removed by using the 'Add', 'Edit and Remove' buttons.
- Remote
  Select this option if you want to get the data from an external data source, like a database. You must also specify the URL in this case. This option is for advanced user only!

Delay
The delay in milliseconds the Autocomplete waits after a keystroke to activate itself. A zero-delay makes sense for local data (more responsive), but can produce a lot of load for remote data, while being less responsive.

Min Length
The minimum number of characters a user has to type before the Autocomplete activates. Zero is useful for local data with just a few items. It should be increased when there are a lot of items, where a single character would match a few thousand items.

Data
If the data source is local, then you must specify the auto complete data in this list. Use the 'Import' button to select from a predefined list of item or import the items from an external file where each item must be on a new line.

URL
When a remote data source is used, the Autocomplete object expects that the page returns JSON data. It can be on the same host or on a different one (must provide JSONP). The request parameter "term" gets added to that URL. More details are available on the jQuery website: http://jqueryui.com/demos/autocomplete/

ThemeRoller theme
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: http://jqueryui.com/themeroller/.

The **Font name** and **Font Size** properties can be used to override the default font of the theme.

Style
Here you can control the appearance of the edit box. See the description of the Edit box properties for more details.
jQuery Button

The jQuery Button enhances standard button (normal, submit, reset or anchor/link) to themable buttons with appropriate mouseover and active styles. The button can be used as a submit button on a form or as a stand-alone button for navigation. The Button type property determines the behavior of the button.

### General

**Name**

Name of the button.

**Value/Label**

Caption of the button.

### Button Type

- **Submit**
  
  When activated, a submit button submits a form.

- **Reset**
  
  When activated, a reset button resets all controls to their initial values.

- **Normal**
  
  Normal (Push) buttons have no default behavior. Each push button may have client-side scripts associated with the element’s event attributes. When an event occurs (e.g., the user presses the button, releases it, etc.), the associated script is triggered.

- **Link Button**
  
  If this button type is selected the button will act as a navigation button/link. You can specify the link properties in the 'Link' page.

- **Checkbox**
  
  The button will act as a checkbox, so it can be used as a replacement for the standard checkbox element in forms.

- **Radio Button**
  
  The button will act as a radio button, so it can be used as a replacement for the standard radio button element in forms. Give multiple buttons the same name to make them part of a group.

- **Split Button**
  
  Adds a drop down menu to the button. Each sub menu can have its own link.

- **Button Set**
  
  Adds the ability to define multiple buttons to create a themed navigation menu.

### Access Key

This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

### Disabled

The disabled option disables the control for user input.

### Tab Index

Specifies the tab index of the button (in a form).

### Style

The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: [http://jqueryui.com/themeroller/](http://jqueryui.com/themeroller/).
jQuery DatePicker

The jQuery DatePicker offers a sophisticated and feature-rich UI component for inputting dates into a form. The object provides a graphical calendar that pops up if you click inside the form field.

The jQuery DatePicker is based on the DatePicker Widget of the jQuery UI library: http://jquery.com/
The appearance of the jQuery DatePicker object is customizable through ThemeRoller themes.

General
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: http://jqueryui.com/themeroller/.

The Font name and Font Size properties can be used to override the default font of the theme.

Use current date
This will automatically set the initial value to the current date.

Date format
The format for parsed and displayed dates. For a full list of the possible formats see the formatDate function:
http://docs.jquery.com/UI/Datepicker/formatDate

Change month
Specifies whether the user can change the month by selecting from a drop-down list.

Change year
Specifies whether the user can change the year by selecting from a drop-down list.

Show button panel
Specifies whether to show the button panel.

Custom options (for advanced users only)
The jQuery DatePicker has many more options. The custom options field allows you to include one or more of these options.
Check the jQuery documentation for more details.

Style
Here you can control the appearance of the edit box. See the description of the Edit box properties for more details.
jQuery Dialog

A dialog is a floating window that contains a title bar and a content area. You can drag & drop objects to the dialog to make them part of the window. The jQuery Dialog is based on the Dialog Widget of the jQuery UI library: http://jquery.com/

The appearance of the jQuery Dialog object is customizable through ThemeRoller themes.

You can easily add objects to the dialog by dragging them on the component. This works the same way as for layers or forms.

General

ThemeRoller theme
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: http://jqueryui.com/themeroller/.

The Font name and Font Size properties can be used to override the default font of the theme.

Title
Specifies the title of the dialog.

Icon Offset
The 'Close' icon offset from the right side of the header can be with Icon Offset.

Width
Specifies the width of the dialog.

Height
Specifies the height of the dialog.

Show animation
Specifies the effect to be used when the dialog is opened.

Hide animation
Specifies the effect to be used when the dialog is closed.
**Horizontal alignment**
Specifies where the dialog should be displayed: ‘left’, ‘center’, ‘right’.
Select ‘Absolute position’ to use the current x position in the workspace.

**Vertical alignment**
Specifies where the dialog should be displayed: ‘top’, ‘center’, ‘bottom’.
Select ‘Absolute position’ to use the current y position in the workspace.

**Modal**
If enabled, the dialog will have modal behavior; other items on the page will be disabled (i.e. cannot be interacted with). Modal dialogs create an overlay below the dialog but above other page elements.

**Resizable**
If enabled, the dialog will be resizable.

**Draggable**
If enabled, the dialog will be draggable by the titlebar.

**Close on escape**
Specifies whether the dialog should close when it has focus and the user presses the escape (ESC) key.

**Show dialog automatically**
When this option is enabled the dialog will open automatically when dialog is called. Otherwise it will stay hidden until .dialog("open") is called on it.

**Q: How can I show or hide the dialog via JavaScript?**
**A:** It’s very easy to show or hide the dialog from JavaScript.
Add the dialog widget to your page.
Take note of the ID. The default value is ‘dialog’.
Add an image, shape or other object with event support to the page.
Open the properties and select the ‘Events’ tab.
Click ‘Add’ to insert a new event.
Select ‘Event’: OnClick and set the ‘Action’ to JavaScript function.
To show the dialog enter this JavaScript:
```javascript
$('#dialog').dialog('open');
```
where dialog is the ID of the dialog.

To hide the dialog enter this JavaScript:
```javascript
$('#dialog').dialog('close');
```
… or you can simply use the Show and Hide event actions!

**Advanced**
The advanced page contains a few properties to fine tune the appearance of the dialog. For example you can control the padding of the title.

You can also add one or two buttons to the dialog. To enable a button give the Button1Text and/or Button2Text a value. Button1Function/Button2Function specifies the (JavaScript) function for the button.
If you do not specify a function the button will act as a close button.
jQuery Menu
Themeable (multi level) menu with mouse and keyboard interactions for navigation.
The jQuery Menu object is based on the Menu Widget of the jQuery UI library: http://jquery.com/.

General
Select Add to insert a new item to the menu. Select Edit to modify the properties of an existing item. To remove an item from the MenuBar select Remove.

Move Up
Move the selected item up amongst its siblings.

Move Down
Move the selected item down amongst its siblings.

Move Left
Make the selected item a sibling of its parent.

Move Right
Make the selected item the child of its preceding sibling.

Layout
The Menu Bar can be either Vertical or Horizontal.

Orientation
Identifies the position of submenus in relation to the associated parent menu item.

Synchronize with Site Manager
When this option is enabled, 90 Second Website Builder automatically synchronizes the items with the content of the Site Manager. So if for example you add a new page, then an item is automatically added to the menubar. or if you rename a page the text of the item will also be updated.

Target
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled.

Style
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager.

Menu mode
In 'Standard menu' mode the menu will be displayed at the same position as in design mode. In 'Context menu' mode the menu will behave as a context menu. The menu will be displayed on right click at the current mouse position.
jQuery Tabs
Tabs can be used to break content into multiple sections that can be swapped to save space, much like the accordion. The jQuery Tabs is based on the Tabs Widget of the jQuery UI library: http://jquery.com/

You can easily add objects to the tab panels by dragging them on the component. This works the same way as for layers or forms. To add items to another panel simply click on the tab header to make it active.

General
In the General page you can add, edit and remove tab pages.

Style
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: http://jqueryui.com/themeroller/.

The Font name and Font Size properties can be used to override the default font of the theme.

Tab Width
Tab Width specifies the width of the tabs. Use ‘0’ for a variable tab width.

Sortable
If the Sortable property is enabled then the user can sort the tabs dynamically using drag & drop, a cool feature of jQuery:)

Activate On Mouseover
Enable this option to change the active tab on mouse over instead of the standard mouse click.

Use fade transition effect
The Use fade transition effect property enables the fade animation for hiding and showing tab panels.

Collapsible
Enable Collapsible to allow an already selected tab to become unselected again upon reselection.

Enable automatic rotation through tabs
This enables automatic rotation through tabs with configurable duration.

Continue the rotation after a tab has been selected by a user.
Specified whether or not to continue the rotation after a tab has been selected by a user.

Duration
The amount of time in milliseconds until the next tab in the cycle gets activated.

Advanced
The advanced page contains a few properties to fine tune the appearance of the dialog. For example you can control the padding of the title.
jQuery Progressbar

The progress bar is designed to simply display the current % complete for a process. For example as part of a customized upload script or to display the status of an Online Survey. The range of the progressbar is from 0 to 100.

**Note:**
The value of progressbar is usually updated through JavaScript. It does not do anything by itself!

**General**

**Initial Value**
Specifies the initial value of the progressbar. Typically this is '0'.

**Style**
You can control the appearance of the Tab widget in Style Properties.

**ThemeRoller theme**
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: http://jqueryui.com/themeroller/.

**Example**
Here is an example how to update the value of the progressbar through JavaScript.

1. Add the progressbar widget to your page.
2. Take note of the ID. The default value is ‘jQueryProgressbar1’.
3. Add an image, shape or other object with event support to the page.
4. Open the properties and select the ‘Events’ tab.
5. Click ‘Add’ to insert a new event.
6. Select ‘Event’: OnClick and set the ‘Action’ to JavaScript function.

To update the value (0 - 100) of the progressbar the following code

```javascript
$('#jQueryProgressbar1').progressbar('option', 'value', 75);
```

where jQueryProgressbar1 is the ID of the progressbar.
jQuery Slider
The slider widget represents a value that is selected by dragging the thumb along the background.
It’s a simple widget, comprised of two main elements: the slider handle (also called the thumb) and the slider background.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value of progressbar is usually updated through JavaScript. It does not do anything by itself!</td>
</tr>
</tbody>
</table>

**General**

**Orientation**
Specifies whether the slider has the min at the left, the max at the right (= horizontal) or the min at the bottom, the max at the top (= vertical).

**Animation**
Specifies whether to slide handle smoothly when user click outside handle on the bar.

**Initial Value**
Specifies the initial value of the slider.

**Minimum Value**
Specifies the minimum value of the slider.

**Maximum Value**
Specifies the maximum value of the slider.

**Range**
Changes the appearance of the slider. A min range goes from the minimum value to the handle. A max range goes from the handle to the maximum value.

**Height/Width**
Specifies the height (if the orientation is horizontal) or width (if the orientation is vertical) of the slider background.

**Handle Width**
Specifies the width of the slider handle.

**Handle Height**
Specifies the height the slider handle.

**Style**
You can control the appearance of the Tab widget in Style Properties.

**ThemeRoller theme**
The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager or by visiting the ThemeRoller website: http://jqueryui.com/themeroller/.
**Events**

Events can be used to update other parts of the page based on the current state of the slider.

The following events are supported:

**slidestart**
This event is triggered when the user starts sliding.

**slide**
This event is triggered on every mouse move during slide.
Use `ui.value` to obtain the value of the current handle.

**slidechange**
This event is triggered on slide stop, or if the value is changed programmatically (by the value method).

**slidestop**
This event is triggered when the user stops sliding.

**action**
Specifies the action to be taken when the event is triggered.

- **Set value**, sets the value of a form element (for example editbox, button or textarea)
- **Custom code**. Here you can implement your own code that will be inserted inside the callback function.

```javascript
function(event, ui)
{
    // your custom code will be inserted here...
}
```

Use `ui.value` to obtain the value of the handle.

Example:

```javascript
$('#Editbox1').val(ui.value);
```

**Example**

Here is an example how to update the value of an editbox.

1. Add an Editbox to the page.
2. Take note of the ID. The default value is ‘Editbox1’.
3. Add the slider widget to your page.
4. Open the properties of the Slider and select the ‘Events’ tab.
5. Click ‘Add’ to insert a new event.
7. In Target select the editbox (‘Editbox1’).
jQuery Spinner
Enhance a text input for entering numeric values, with up/down buttons and arrow key handling. Note that this object is normally used on a form as a replacement for the standard editbox.

The jQuery Spinner object is based on the Spinner Widget of the jQuery UI library: http://jquery.com/

General
Name
Enter an identifier for the field.

Initial Value
Value that is initially displayed in the field.

Minimum Value
The minimum allowed value.

Maximum Value
The maximum allowed value.

Steps
The size of the step to take when spinning via buttons.

Incremental
Controls the number of steps taken when holding down a spin button. When set to true, the stepping delta will increase when spun incessantly. When set to false, all steps are equal (as defined by the step option).

Disabled
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the form.

Access Key
This attribute assigns an access key to the object. An access key is a single character. Pressing the access key gives focus to the element.

Tab Index
All elements (except hidden elements) in a form are part of the form's tab order. When the user presses the Tab key, the browser shifts the input focus from element to element in order the elements appear in the HTML code. However, sometimes you want the tab order to flow a little differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the element is skipped when the user tabs around the form.

Title
Specifies the tooltip displayed by the browser.
jQuery Tooltips

Customizable, themeable tooltips, replacing native tooltips. The tooltip supports text formatting and can be assigned to any WWB object.

The jQuery Tooltip object is based on the Tooltip Widget of the jQuery UI library: [http://jquery.com](http://jquery.com)

**General**

**Object ID**
Specifies the ID of the associated object. The tool tip will be displayed when the user hovers over the specified object.

**Animation**
Specifies the animation that is used to show/hide the tooltip: None, Fade or Slide.

**Track the mouse**
Specifies whether the tooltip should track (follow) the mouse.

**Content**
Specifies the context (text) of the tooltip. The text can be formatted by using the style tools.

**Position**
Identifies the position of the tooltip in relation to the associated parent object.

**Style**

The look and feel of this object is defined by the page theme. You can set the theme for the whole in Page Properties->Style->Theme. Themes can be created/edited with the built-in Theme Manager.
jQuery Mobile

jQuery Mobile is a framework for creating mobile web applications. jQuery Mobile works on all popular smartphones and tablets. 90 Second Website Builder uses jQuery Mobile as the basis for (responsive) mobile web pages. When you create a mobile page, you will have a dedicated set of tools for mobile web design. And although most of the objects have the same names, most of them have been optimized for mobile web design and therefore will behave slightly different than in a standard layout.

One of the main differences is the styling of objects. Unlike in a standard page, in jQuery mobile all objects are styled by themes and swatches.

Theme

The jQuery Mobile theme provides the CSS framework necessary for providing a consistent and touch-friendly look and feel for your widgets across platforms. It supports many CSS3 properties, such as rounded corners, shadows, and gradients. It also provides a lightweight icon set, which can be used in objects like buttons, menus etc. You can select the theme for the page in the Page Properties.

Swatches

A swatch is one of several color schemes provided by your theme. A theme can support up to 26 swatches, each identified with a single-letter (A, B, C, D etc). The built-in jQuery Mobile Theme Manager allows you to create any number of swatches for a custom theme.

jQuery Mobile objects

The following objects are only available for mobile web pages.

- Collapsible
- Flip Switch
- Layout Grid
- Listview
- Nested Menu
- Panel
- Popup Menu
- Responsive Table
- Slider
- Tabs

Standard objects optimized for jQuery Mobile

The following standard objects have been optimized for jQuery Mobile. Their appearance is also affected by the jQuery Mobile theme.

- Button
- Checkbox (supports multiple items)
- Comboxbox
- Editbox
- Go Menu
- Login
- Logout
- Navigation Bar
- News Feed Ticker
- Radio Button (supports multiple items)
- Site Search
- Text Area
- Text Menu
Common jQuery Mobile properties

The following properties are available in most jQuery Mobile objects.

**Corners**
Applies the theme border-radius if set to true.

**Full Width**
Specifies whether the object should use the full width of the page. If this option is set to false then the object will have a ‘fixed’ width, which is usually the total of the text, padding and margin of the object.

**Inset**
By setting this option to false the element will get a full width appearance without corners.

**Mini**
Sets the size of the element to a more compact, mini version.

**Swatch**
By default the appearance of a jQuery Mobile object is determined by the page theme (as set in the page properties). But each theme can have up to 26 variations (swatches).
In the Swatch property you can select one of those variations. Note that you can change the style of themes and swatches in the Mobile Theme Manager.

**Use Field Container**
Specifies whether to wrap the object in a field container to help visually group it in a longer form. The container aligns the label and form controls correctly and adds a thin border to act as a field separator.
The layout of the label and control is automatically defined based on the device’s width. If the device width is small then the label is placed at the top of the form control. If not then the label is placed at the left in a 2-column layout.

**Icons**
jQuery Mobile provides a number of icons that can be used by objects that support them like Buttons, Listviews, Collapsible etc.
jQuery Mobile Collapsible

The Collapsible object is based on the Collapsible widget from the jQuery Mobile framework:
http://api.jquerymobile.com/collapsible/

Collapsible creates a collapsible blocks of content. The Collapsible object can have multiple panels which are containers for other objects. These panels can be expanded or collapsed by clicking on the header icon.

Icon Collapsed
Sets the icon for the header of the collapsible container when in a collapsed state.

Icon Expanded
Sets the icon for the header of the collapsible container when in an expanded state.

jQuery Mobile Flip Switch

The Flip Switch object is based on the Flip Switch widget from the jQuery Mobile framework:
http://api.jquerymobile.com/flipswitch/

The flip switch is an alternative look to the checkbox. It can be toggled by a click or a swipe.

jQuery Mobile Slider

The Slider object is based on the Slider widget from the jQuery Mobile framework:
http://api.jquerymobile.com/slider/

Slider is an alternative look to the editbox for numeric values. Specify min and max attribute values to set the slider’s range. If you want to constrain input to specific increments, then set the step attribute.
jQuery Mobile Layout Grid
The Layout Grid object is based on Responsive Grid from the jQuery Mobile framework:
http://api.jquerymobile.com/responsive-grid/

You can use a layout grid to place objects next to each other in your web page. The layout grid creates column cells with equal width. For example if the layout grid has two columns then they both will be 50% of the page width. The grid will always use the full width of the page and can be have up to 5 columns, although it's not recommended to use too many columns for smaller screens.

To add an object to the layout grid simply drag & drop it on a cell. A cell can have multiple objects which will be aligned according to the specified alignment (left, center, right).

The layout grid is responsive. This means that on smaller screens the layout will swap to stacked layout.

jQuery Mobile Tabs
The Tabs object is based on the Tabs widget from the jQuery Mobile framework:
http://api.jquerymobile.com/tabs/

Tabs is a single content area with multiple panels, each associated with a header in a list. You can easily add objects to the tab's panels by dragging them on the component. This works the same way as for layers or forms. To add items to another panel click the header/tab to make it active.
jQuery Mobile Footer
The Footer object is based on the Toolbar widget from the jQuery Mobile framework: http://api.jquerymobile.com/toolbar/ A footer is usually the last element inside each mobile page and it typically contains a combination of text and (navigation) buttons.

Fixed Position
Causes the footer to float above the content via CSS position.

Full Screen
Sets whether the footer should be hidden entirely when the page is tapped.

Header tag
Specifies the header tag (H1...H6) that will be used for the footer.

Title
Specifies the title of the footer.

Navigation bar
Here you can (optionally) configure navigation buttons that will be part of the footer. Each button can have text, an icon and a link. 'Icon position' positions the icon in the button. Possible values: left, right, top, bottom, none.
jQuery Mobile Header
The header is a toolbar at the top of the page that usually contains the page title text and optional buttons positioned to the left and/or right of the title for navigation or actions. Headers can optionally be positioned as fixed so they remain at the top of the screen at all times instead of scrolling with the page.

The title text is normally an H1 heading element but it’s possible to use any heading level (H1-H6) to allow for semantic flexibility.

**Fixed Position**
Causes the footer to float above the content via CSS position.

**Full Screen**
Sets whether the toolbar should be hidden entirely when the page is tapped.

**Header tag**
Specifies the header tag (H1...H6) that will be used for the footer.

**Title**
Specifies the title of the header.

**Navigation bar**
Here you can (optionally) configure navigation buttons that will be part of the footer. Each button can have text, an icon and a link. 'Icon position' positions the icon in the button. Possible values: left, right, top, bottom, none.
jQuery Mobile Listview

The Listview object is based on the Listview widget from the jQuery Mobile framework: http://api.jquerymobile.com/listview/

A listview is a themed list of items which can have images, links and even a search filter.

**Items**
Manage the items in the list. Linked items will have a right arrow indicator. It's also possible to insert dividers between the items to create groups.

**Thumbnail Size**
Set the size of the thumbnail images. All images in the list must have the same size.

**Place Holder**
Specifies a short hint to help the user to fill out the input field. The text will disappear as soon as the user enters some text.

**Search Filter**
Add a search filter bar to the listview.
jQuery Mobile Nested Menu

The Nested Menu object is based on the Popup widget from the jQuery Mobile framework:
http://api.jquerymobile.com/popup/

Initially the nested menu displays a single button on the page. When the user clicks the button a popup menu will appear. This is a combination of the Collapsible and Listview objects. The menu items can be categorized and each category can be collapsed/expanded.

jQuery Mobile Popup Menu

The Popup Menu object is based on the Popup widget from the jQuery Mobile framework:
http://api.jquerymobile.com/popup/

Initially the popup menu displays a single button on the page. When the user clicks the button a popup menu will appear. The menu can also include dividers to create groups.
jQuery Mobile Panel

The Panel object is based on the Panel widget from the jQuery Mobile framework: http://api.jquerymobile.com/panel/

A Panel is initially invisible, but can slide from the right or left side of the page by clicking the menu button. The content of the panel can either be a listview/menu or another page!

Close Button Text
Specifies the text to be shown on the button.

Content
Specifies whether to use a listview/menu or page for the content.
If you select 'listview' then the panel will act as a menu. If you select 'page' then you can select another page. In that case all object from that page will be embedded in the current page.

Display Mode
Specifies the relationship of the panel to the page contents.
- **reveal**
  Push the page over.
- **push**
  Re-flow the content to fit the panel content as a column.
- **overlay**
  Sit over the content.

Position
Specifies whether the panel menu will be displayed at the left or right side of the page.

Dismissable
Specifies whether the panel can be closed by clicking outside onto the page.

Fixed Position
Sets whether the panel has fixed positioning so the contents are in view even if the page is scrolled down. This also allows the page to scroll while the panel stays fixed.

Swipe Close
Specifies whether the panel can be closed by swiping left or right over the panel.
jQuery Mobile Responsive Table

The Responsive Table object is based on the Table widget from the jQuery Mobile framework: 
http://api.jquerymobile.com/table/

One of the biggest challenges in responsive web design (RWD) is presenting tabular data. Large tables with lots of columns don’t fit on smaller screens and there isn’t a simple way to re-format the table content with CSS and media queries for an acceptable presentation. To address this, the jQuery Mobile framework offers two different options for presenting tables responsively. Each has benefits and tradeoffs, the right choice will depend on the data being presented.

Reflow mode - Re-formats the table columns at narrow widths so each row of data is presented as a formatted block of label/data pairs. This is ideal for tables with product or contact information with more complex or lengthy data formatting that doesn’t need comparison across rows of data. In reflow mode you can set the breakpoint for when the table will switch to stacked layout. The default value (-1) will convert from tabular presentation to the stacked presentation at 560px (35em).

<table>
<thead>
<tr>
<th>Rank</th>
<th>Movie Title</th>
<th>Year</th>
<th>Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Citizen Kane</td>
<td>1941</td>
<td>100%</td>
</tr>
<tr>
<td>2</td>
<td>Casablanca</td>
<td>1942</td>
<td>97%</td>
</tr>
<tr>
<td>3</td>
<td>The Godfather</td>
<td>1972</td>
<td>97%</td>
</tr>
<tr>
<td>4</td>
<td>Gone with the Wind</td>
<td>1939</td>
<td>96%</td>
</tr>
<tr>
<td>5</td>
<td>Lawrence of Arabia</td>
<td>1962</td>
<td>94%</td>
</tr>
</tbody>
</table>
**Column toggle mode** - Selectively hides columns at narrower widths as a sensible default but also offers a menu to let users manually control which columns they want to see. This mode is better for financial data tables that have compact values and need to maintain comparisons across columns and rows of data. It can also be used for building things like product comparison tables.

The table works by hiding and showing columns based on two inputs: available screen width or by the user checking and unchecking which columns to display in a column picker popup. Add data-priority attributes to each of the table headers of columns you want to responsively display and assign a priority (1 = highest, 6 = lowest).

The first thing you will need to do is define the table structure. For each column you can set the column name, priority and alignment. The priority (1 = highest, 6 = lowest) is used only in Column toggle mode. Columns will be displayed based on the available screen width and priority.

After you have defined the structure, you can add data. You can either manually insert the items or import data from a comma separated file.
Publish your website
You can publish your web pages using the build-in Publish tool. Select File->Publish to launch the publish dialog.

There are two ways to publish your pages:
1. Publish to a local folder.
2. Publish to a remote FTP server.

Publish to a local folder
Click Add to add a new location to the list. Enter a name for the location and select Local as type.

![Add Publish Location dialog](image)

Enter the folder where you want to publish the active document. Click OK to save the data and then click Publish to save the files to the specified folder. If you do not want to copy images or other components along with the HTML file, select the Only publish HTML files option. Otherwise, all images, ActiveX controls, java applets etc. will be copied to the same folder.

![Publish Web Site dialog](image)
Publish to a remote FTP server.
Click Add to add a new location to the list.

![FTP Server Settings](image)

Enter a name for the location a select Remote/FTP Server as type and fill in the following fields:

**Host**
The Host Address field contains the location of the FTP server.
You can either specify a URL or IP address.

**Port**
The default Port of a FTP connection is 21, but if necessary you can configure something else.

**PASV mode**
PASV mode is useful for certain types of firewalls that do not allow FTP servers to initiate data connections back to the connected client.

**Username**
This is where you enter the username of the FTP account that allows you to logon to the FTP Server (also see anonymous setting).

**Password**
Enter the password of the FTP account.

**Remote Folder**
Specifies the folder on the FTP server where the files are uploaded. The default is your root directory.
Common remote folders locations are:
/www
/public_html
/html

**Important note:** Unfortunately this value is different for each webhost, so consult your webhost's documentation for more details.

**Test Connection**
This command can help you determine if the specified hostname, username and password are correct.
It also verifies if your firewall allows the connection to the server.

The 'Explore' button in publish settings give you access to your published files. Clicking this button will launch the Built-in FTP Client to manage your online files.
The built-in FTP client also introduces an easy way to find the remote publish folder. Simply login to your account, browse to the folder and click 'Make Home'. 90 Second Website Builder will now use that folder as the root of your website!

To modify the permissions of any file or folder. Select the file/folder and click the 'Permissions' button.
This feature is only supported on UNIX based servers.
Pages to Publish
Select which page or pages you want to publish.
**Entire Web Site**, publishes all pages of the web site (except the pages which have enabled 'Don't Publish this Page' in Page Properties)
**Select Page Only**, publishes the select page, click Select to specify the page to be published.
**Select Page and Sub Pages**, publishes the select page and all of its sub pages (if any).

Files
Specifies which files will be published.
- **Publish all files**
  All files of the selected page(s) will be published
- **Publish HTML files only**
  Select this option if you do not want to upload images or other components along with the HTML file.
- **Publish changed files only**
  Select this option if you want to published the files that were changed since the last time you've published your web site. What exactly will be published depends on the changes you've made. For example, if you've only changed the position of an object, then only the HTML file was changed, but if you've changed the size of a shape, then the shape image needs to be regenerated and therefore the HTML and the image file will be published.

More information about publishing
To make your web pages available for other users you have to publish them to a web server. Users of 90 Second Website Builder are offered a discount on hosting services provided by BlackWire Marketing, LLC. Discount coupon and information can be found in the Members Area of the 90 Second Website Builder website. The BlackWire Hosting service is at:
http://blackwirehosting.com

Make sure you choose a web host, which supports FTP, which makes it much easier to publish your pages from 90 Second Website Builder. Once you have registered to a web host, you will receive a server address, username and password. Enter this information into 90 Second Website Builder by selecting: File->Publish. Click Add and select Type Remote. Sometimes you also need to specify a remote folder like 'public_html'. If you have a firewall/router select 'Use passive mode for transfers'. Click OK to save. Now you can publish each page simply by selecting Publish. If you want to view the results of the file transfer, you can view the log file via: Tools->Options->Publish->View Log.

How to publish on host that offer free web hosting that do not support FTP?
Instead of publishing your web pages directly via FTP, you can also publish your pages to a local folder. Click Add and select Type Local.
Enter a Name and specify a location using the browse (...) button.
Click OK to save.
Now if you press the Publish button, the files will be generated to the local folder.
Next select all the files in the local publish folder and upload them using the File Manager of your web host (e.g. geocities, yahoo...).

What to do in case of publishing errors?
1. Make sure your ftp address (host) is correct
2. Is your username and password ok?
3. Does your firewall block the FTP connection of 90 Second Website Builder?
4. Enable 'Use passive mode for transfers'
5. Increase the connection timeout to 120 seconds (Tools->Options->Publish)
6. For a list of all possible error codes and their descriptions go here:
**Links**

(Hyper)links are text or images that can be clicked to bring the user to another web file such as a web page, images or any other file. They are the essence of the World Wide Web as they link pages within sites and web sites to other web sites.

**Highlight** the text or image that will be the link and select Insert->Link from the menu bar or pressing CTRL+K. This will display the Insert Hyperlink window.

**Link to a page on another web site**

Set the **Link To** option to **Web Site**.

Enter the full URL (Internet Address) of the destination page in the URL box. External URLs MUST begin with "http://" or they will not work.

For example, to link to the 90 Second Website Builder home page, type "http://www.90secondwebsitebuilder.com/" instead of "www.90secondwebsitebuilder.com".

**Link to a page on your own web site**

Set the **Link To** option to **Internal Web Page**.

Click 'Select' to choose a page. This will list all pages which are part of the current project. Select one of the pages and a relative link will automatically be created (eg ./products.html).

Notes:

- You must publish all pages you have linked to in order to be able to test relative links.
- Internal links do not work in Preview mode, unless you have set the **Preview Scope** to Entire Web Site (Tools->Options->Preview)

**Link to an email address**

Select **Email Address** from the Link To dropdown list.

The URL box will automatically be updated with the **mailto:** prefix. Now enter the destination email address. For example:

mailto:webmaster@yourdomain.com

or

mailto:webmaster@yourdomain.com?subject=Website Feedback

**Link to a file**

Set the **Link To** option to File.

Browse for the file you wish to create a link for. 90 Second Website Builder will automatically upload the local file to your website, when you publish your page.

**Note:** When linking to large files, it may take a while a while before the file is transferred to your website!
**Smart Links**

Smart links can be used to link to the next, previous, parent or child of the current page. If you change the structure of your website, these links will automatically update to represent the current state.

The following smart link options are available:
- **Parent Page**: Link to the parent of the current page.
- **Child Page**: Link to the first child of the current page.
- **Next Page**: Link to the sibling to the right of this page.
- **Previous Page**: Link to the sibling to the left of this page.
- **Back**: Go back to the previous page in the browser's history.
- **Close the current browser window**: Close the current browser window, this feature is not supported by all browsers!
- **Print the current page**: Clicking the link will print the current page.
- **Reload Page**: Clicking the link will reload/refresh the current page.

**Other link types**

- **FaceTime**: Launch the FaceTime app and initiate a call to the specified user. Example: facetime:14085551234 or facetime:user@example.com
- **Phone Number**: Call the specified number. Example: tel:+1200229933
- **SMS**: Send an SMS. Example: sms:+3290322111
- **Skype**: Launch the Skype app and initiate a call to the specified user. Example: skype:skype_user

**Target Window or Frame**

- **Open in the same browser window**, this option will set the target of the link to _self
- **Open in a new browser window**, this option will set the target of the link to _blank
- **Open in another window or frame**, this option lets you specify a custom target.

Examples:
- _parent
  open the link in the parent frame
- _top
  loads the linked page in the topmost frame
- iframe1
  specify the name of an inline frame, to open the linked page in an inline frame.

**Open in a popup window**, this option will open the linked page in a (javascript) popup window. Click 'Settings' to specify the properties of the popup window:
- **Left**: Specifies the left position, in pixels. This value is relative to the upper-left corner of the screen. The value must be greater than or equal to 0.
- **Top**: Specifies the top position, in pixels. This value is relative to the upper-left corner of the screen. The value must be greater than or equal to 0.
- **Height**: Sets the height of the window in pixels. The minimum value is 150 for Internet Explorer!
- **Width**: Sets the width of the window in pixels. The minimum value is 250 for Internet Explorer!
- **Status Bar**: Enable the status bar at the bottom of the window.
- **Tool Bar**: Enable the standard browser toolbar, with buttons such as Back and Forward.
- **Location Bar**: Enable the Location entry field where you enter the URL.
- **Menu Bar**: Enable the menu bar of the window.
- **Resizable**: Allow/Disallow the user to resize the window.
- **Scrollbars**: Enable the scrollbars if the document is bigger than the window.
**Bookmarks (Jump to another part of the page)**

Text and images can be set as bookmarks (also called "anchors") that can be linked to within a page. For example, if a page has several new items, the news titles for each item can be set as bookmarks and a row of links can be added to the top of the page that will each skip down to those bookmarked sections. This method of using bookmarks allows visitors to your site to quickly access information by not having to scroll down the page to view the information they want.

**Step 1**
You can create a Bookmark by using the Bookmark tool from the Insert menu.

**Step 2**
Move the bookmark icon to the position where you want the page to jump to if the user clicks the link. In this case let’s jump to the top of the page.

**r (Creating Hyperlinks)**

When a site visitor clicks the hyperlink, the destination links can also link to pictures, multimedia files, particular items, and programs. Besides being represented as text, a link in Web Builder follow the instructions below.

**Step 3**
Make sure you give the bookmark a unique name.
Step 4
Once you have placed the bookmark icon on your page, it can be selected from the Bookmark dropdown list.

Appearance
All hyperlinks in your webpage by default use the default HTML link colors (link: blue, visited: purple, active: red). By defining Hyperlink Styles (CSS) you can adjust the colors and formatting of an hyperlink. Once you have defined a style you can attach it to the hyperlink by selecting it from the Style dropdown list. Click the Edit Styles button to add or modify the hyperlink style sheet.

Hyperlink Style Sheet
By default, all text hyperlinks in your webpage use the default HTML link colors (link: blue, visited: purple, active: red). However, since CSS (Cascading Style Sheets) were introduced, more and more websites use different colors to create better looking layouts. 90 Second Website Builder gives you the option to customize the way hyperlinks will be displayed in the browser by introducing the Hyperlink Style Sheet Editor.
Click **Add** to add a new hyperlink style. Each hyperlink style allows you to customize the colors for all four hyperlink states:

- **Linked** (default: blue, underlined)
- **Visited** (default: purple, underlined)
- **Active** (default: red, underlined)
- **Hover** (default: blue, underlined)

Besides the colors, you can also change the bold, underline and italic formatting.

Each style must be saved with a unique name. In the Link Properties window you can attach this name to a link.

Click **Edit** to modify an existing style and **Remove** to delete it from the list.

Example: Removing the underlining from a link.
1. Create a new style and clear the underline checkbox for all four states.
2. Name the style 'no_underline'
3. Click OK to save.
4. Select a link and change the **Style** from the dropdown list to 'no_underline'
5. Publish or preview the page to view the effect.

**Note:** The link style becomes active when you publish or preview your page. 90 Second Website Builder will always show links in blue.

**Transition**

Specifies transition duration to go from one state to another. This makes it possible to animate the link state change. Read more about transitions here: CSS3 Animations and Transitions.
**Site Manager**

The Site Manager can be used to manage the structure of your web site. When your web site has more than one page they **must** all be part of the same 90 Second Website Builder project file. The Site Manager can be used to add, edit, remove pages and organize your web site. There is also a button to open the properties of the selected page. The New Folder command gives you the possibility to organize your pages in folders.

In the picture above, you see an example of a web site structure. The filename of this example web site is called 'mywebsite.wbs', this name is always displayed at the root of web site tree. The root can have one or more pages and each page can also have sub pages.

Web sites always have a **home page**, which is often called **index**, so for this reason 90 Second Website Builder automatically adds this page to each new project. The names of the items (pages) in the site tree are the actual file names of the target HTML files, so if you named a page 'index' it will publish as `index.html`.

**Adding a new page**

1. Select the position where you want to insert the page, for example select the root (the top level item) to insert the page to the first level.
2. Click the first button on the toolbar (New Page)
3. 90 Second Website Builder adds the new page to your project and will automatically open it, so you can start building the page.

To insert a new page as child of an existing page or folder, first select the parent and click 'New Page'

**Tip:**

You can also use the context menu (right mouse click) to add new pages to the web site or you can select Page->New Page from the 90 Second Website Builder menu.
Adding a new folder
1. Select the position where you want to insert the folder, for example select the root (the top level item) to insert the page to the first level.
2. Click the second button on the toolbar (New Folder).
3. 90 Second Website Builder adds the new folder to your project.

Open an existing page
1. Select the item (page name) you want to edit.
2. Click the third button (from the left) on the toolbar (Edit Page).

Inserting an external file
This option can be useful if you want to make an external file part of the project, so you can easily link it or make it part of the sitemap.
And although this option was designed to include HTML files, it can basically used for any type of file. Note however that it will only be a link to the file. You will not be able to edit the file directly in 90 Second Website Builder.

Cloning an existing page
To make an exact copy of an existing page, select the item (page name) you want to clone and click the fourth button (from the left) on the toolbar to insert a copy of that page.

Remove a page/folder
Select the item (page or folder name) you want to remove and click the remove button on the toolbar or press the Delete key on the keyboard. You cannot remove the last page in your web site.
**Rename a page/folder**
Select the item (page or folder name) and press F2 to enter the new name.
You can also use the context menu (right mouse click) to select and rename a page/folder.
When you have linked to the page, you are renaming (from any page within the web site), 90 Second Website Builder automatically updates all the links for you, so you don't have to redo all the internal links.

**Notes about page names**
While building your web site, 90 Second Website Builder saves the project file with the .wbs extension. This is a project file used by 90 Second Website Builder to simplify the building process. One project file can contain multiple web pages. Once your pages are ready you must export or publish them as HTML. The name of the output HTML file is taken from the name you have specified in the Site Manager. So if you named the page index then the output file will be called index.html. If the page needs another extension like .php, you can configure this in the Page Properties.

Here are some guidelines how to name your web pages:
6. Do not add .html or .htm extension to the page name. 90 Second Website Builder will automatically add the .html extension (or .php, .asp) when it publishes (or exports) the HTML code.
7. Always name your homepage: "index", this is the most common name for a homepage.
8. Always use lowercase filenames, most web servers are case sensitive and might fail to find your page if you have called it "Index" or "INDEX"
9. Do not use space or other special characters in the name, keep them simple like: "page1"
   or
   "my_products"
10. Use underscores to connect words.

**Edit Page Properties**
To edit the page properties without having to open the page:
1. Select the item (page name)
2. Click the Properties button on the toolbar or right click for the context menu and select Page Properties.
Arrange Items
You can arrange items by using drag and drop, select the item and drag it to the position where you want to move it to. Dropping an item on another item will automatically make it a child of this item. To prevent this you can hold down the CTRL key, this will move the item below the drop item.

Another way to arrange items is using the context menu:
1. Select an item
2. Right click to display the menu.
3. Select Arrange and one of the available items: Move Up, Move Down, Move Left or Move Right.

Import HTML Page
Although 90 Second Website Builder is NOT an HTML editor, you can import existing HTML pages. Select Page->Import->Import HTML Page from the menu to display the Import HTML page window.

You can either select an HTML page from your local drive or specify a URL of an online website. Click OK to start importing the page. 90 Second Website Builder will automatically copy all images to your local drive.

Important notes about importing HTML:
• 90 Second Website Builder is not an HTML editor, but an HTML generator! 90 Second Website Builder imports the HTML by rendering the contents of an existing page and then attempts to convert the layout to 90 Second Website Builder’s internal object format.
• The import feature currently only imports text, images, form elements and body attributes (link colors, background images, meta tags). Tables, scripts, style sheets and multimedia components are not imported. But in most cases this is good enough to get you started.
• 90 Second Website Builder does not parse style sheets, so is some cases the text may look different than the original page.
• 90 Second Website Builder currently doesn’t support framesets. If you want to import a web page that is using frames you’ll have to import all individual pages separately.
• It is very difficult to support all different types of HTML. Even the popular browsers will interpret HTML differently, so don’t expect miracles. If a page fails to be imported it probably contains code that 90 Second Website Builder doesn’t understand and you still have to start importing texts pages created with 90 Second Website Builder will give the best results!

Import a page from another project
This option makes it possible to import page from another 90 Second Website Builder project.

Position and size of the Site Manager
You can place the Site Manager anywhere you like (docked or floating):
1. ‘Grab’ the title bar of the site manager with your mouse to move the window to another location.
2. To make the Site Manager auto hide, click the pushpin in the top-right corner. When you move the mouse away from the window it will auto hide, only display a small tab where the windows hides. Move the mouse to that tab to make the window visible again.
Object Manager

The Object Manager gives an overview of all objects in the current page; you can make object invisible, lock/unlock objects, change the z-order or remove a specific object. Double click an object in the list to select it in the workspace.

The Object Manager also provides some advanced features through the context menu (right click on an object in the list):

**Rename Object**
Allows you to modify the ID property of the object. Note that you can also modify the ID in the Property Inspector.

**Allocated Filenames**
Many objects dynamical generate images. For example shapes, navigationbars, but also images with effects (like shadows).
90 Second Website Builder will automatically generate unique filenames for these images, to make sure there are no conflicts.
The automatically generated names are determined by the settings in the Publish options.
To view or edit the automatically generated filenames for an object you can select Allocated Filenames from the context menu.
Not all objects do support this option. It's only useful for object that dynamically generate images!
More about the z-order of objects

90 Second Website Builder uses CSS positioning to create pixel perfect layouts in HTML. CSS operates in three dimensions - height, width and depth. In 90 Second Website Builder each object (element) of your web page is placed on a separate layer, which makes it possible to overlap these objects something which can not be done using standard HTML/dynamic page layout). For that purpose, you can assign each element a number (z-index). Elements with a higher z-index overlap an element with a lower z-index. The z-order is the order in which objects will be displayed by the browser.

WB automatically generates the z-index for each object you add to your page. So the first element will have z-index '0', the next object '1' etc. To change the z-index of objects you can use the arrange tools (Layout->Arrange) or the Object Manager. The following arrange tools are available:

**Move To Front**
Move object to front of the page

**Move To Back**
Move object to back of the page

**Move Forward**
Move object to next position in z-order

**Move Back**
Move object to previous position in z-order

Let’s say you want to display the objects in a particular order.
1. Select all objects one by one in the order you want them to be displayed.
2. After you have selected an object, click Layout->Arrange->Move to Front
Properties Inspector

Use the Properties Inspector window to view and change the properties of selected objects. You can also use the Properties Inspector window to modify page properties. The changes will be visible immediately in the workspace.

To display the Properties Inspector window click Properties Inspector on the View menu. The Properties window typically displays in the bottom right corner of 90 Second Website Builder, under the Site Manager, but you can move and resize the window.

Object name (Drop-down box)
Lists the currently selected object or 'Page' if no object is selected. Only objects from the active page are visible. When you select multiple objects, only properties of the first selected object appear.

Categorized (Toolbar Button)
Lists all properties and property values for the selected object, by category. You can collapse a category to reduce the number of visible properties. When you expand or collapse a category, you see a plus (+) or minus (-) to the left of the category name. Categories are listed alphabetically.

Alphabetic (Toolbar Button)
Alphabetically sorts all properties for selected objects.

Property Page (Toolbar Button)
Displays the Property Pages dialog box for the selected item. Property Pages displays a subset, the same or a superset of the properties available in the Properties window.

Properties/Values
Displays the properties and their values of the select object.

Description pane
Shows the property type and a short description of the property.

Note: It's also possible to manually modify the size and position of the selected object by changing the Position and Size properties.
**Style Manager**

The Style Manager (Menu->Format->Styles) is a central place to add, edit or remove style definitions for the entire website. Updating a specific style will affect all objects using that style. For example you can update all fonts of your website in one operation.

There are six standard heading styles (H1, H2, H3, H4, H5, H6), which normally are used for text headers only. Other styles can be used for all other objects that support them, like form elements and tables.

When you add a new style all attributes of the style are empty (= default). You do not have to specify values for all attributes. It's also possible to define custom style attributes. You may have noticed that we did this for the header styles (CustomStyle is display: inline;), to make sure it is displayed correct in all browsers.

**Notes:**
Not all style attributes apply to all objects! For example margins and padding are current ignored by most 90 Second Website Builder objects. These attributes where only added to fix browser incompatibility issues for header styles.

Header styles (H1, H2 ...) can only be applied to text.

**Gradient Style Manager**

In the Gradient Style Manager you can add, edit and remove global (multi color) gradients effects. These effects can be used by shapes, cliparts, textart and the drawing tools.

The definitions of the gradient styles are stored in a XML file ‘gradients.dat’ in the program folder. If you have defined custom styles and want to use the same styles on another computer, then you should copy this file.
**Events**

In 90 Second Website Builder images, shapes and form controls have an Events Property Page, to easily add actions to object events, like OnClick, OnMouseOver etc.

![Add Event](image)

Predefined actions include: Show, Hide, Move, Set Image, Play, Pause, Stop and JavaScript Function. Multiple events can be assigned to a single object.

![Add Event](image)

To add an event click Add. Next, select the event, action and specify the target. Based on the object one or more of these events can be selected:

- **onBlur**  
  Fires when the object loses the input focus.

- **onChange**  
  Fires when the contents of the object or selection have changed.

- **onClick**  
  Fires when the user clicks the left mouse button on the object.

- **onDbClick**  
  Fires when the user double-clicks the object.

- **onFocus**  
  Fires when the object receives focus.

- **onKeyDown**  
  Fires when the user presses a key.

- **onKeyPress**  
  Fires when the user presses an alphanumeric key.

- **onKeyUp**  
  Fires when the user releases a key.

- **onLoad**  
  Fires immediately after the browser loads the object or page.

- **onMouseDown**  
  Fires when the user clicks the object with either mouse button.

- **onMouseMove**  
  Fires when the user moves the mouse over the object

- **onMouseOut**  
  Fires when the user moves the mouse outside the boundaries of the object.

- **onMouseOver**  
  Fires when the user moves the mouse pointer into the object.

- **onMouseUp**  
  Fires when the user releases a mouse button while the mouse is over the object.

- **onReset**  
  Fires when the user resets a form.

- **onScroll**  
  Fires when the user repositions the scroll box in the scroll bar.

- **onSelect**  
  Fires when the current selection changes.

- **onSubmit**  
  Fires when a FORM is about to be submitted.

- **onUnload**  
  Fires immediately before the object or page is unloaded.
These actions can be assigned to the event above:

**Show**  Show the object as specified in the Target field

**Hide**  Hide the object as specified in the Target field

**Move**  Move the object as specified in the Target field to position Left, Top.

**Set Image**  Set the image of object 'Target' as specified in Filename

**JavaScript Function**  Execute a custom JavaScript function (eg. `alert('enter your message');`)

These actions can be used in combination with the Windows Media Player object

- **Play**  Start the WMP file.
- **Pause**  Pause the WMP file.
- **Stop**  Stop the WMP file.

The following actions can be used in combination with the Slide Show object

Make sure you select a valid slideshow object as the target and set the interval to 0!

- **SlideShow Next**  Display the next image of a slide show.
- **SlideShow Previous**  Display the previous image of a slide show

**ShowWithEffects**  Show the object as specified in the Target field while using one of the cool effects like fading, sliding, blinds, explode, puff drop etc....

Give your website amazing 'web 2.0' effects, with only a few mouse clicks!

**HideWithEffects**  Hide the object as specified in the Target field.

**Animate**  Perform a custom animation of a set of CSS properties.

The following properties can be animated:

- **Left**, this will animate the object to the specified horizontal position (in pixels).
- **Top**, this will animate the object to the specified vertical position (in pixels).
- **Width**, this will animate the object to the specified width (in pixels).
- **Height**, this will animate the object to the specified height (in pixels).
- **Opacity**, this will animate opacity of the specified object (in a range between 0.0 - 1.0)

**Note:**
Events that are not listed above can be inserted using the custom HTML tools.
CSS3 Animations and Transitions

90 Second Website Builder has built-in support for CSS3 animations and transitions. Animations and transitions are supported by all modern browsers (Firefox/Safari/Opera/Chrome/IE10), but NOT by Internet Explorer 9 or older!

Animation

A CSS3 animation is an effect that lets an element gradually change from one style to another without using JavaScript or Flash. Animation effects can be applied to a wide variety of CSS properties, including background-color, width, height, opacity, transforms (rotate, skew, scale, translate) and many more. The Animation Manager can be used to define animations. These animations can be assigned to an object in the CSS3 Animation section of the object’s properties.

Currently animations are supported by the following objects:

- Image
- Text
- Shape
- Clip Art
- Text Art
- Curves
- Polygon
- Line
- Banner
- Marquee
- Button
- Combobox
- Editbox
- Text Area

Note however that not all animations are useful for all objects. For instance animating the background color of an image or shape will not do anything because there is no background in that case!

You can also associate an animation to a style (in the Style Manager). This makes it possible to dynamically assign an animation to an object (through events -> set style).

Animation Properties

Animation

Specifies the animation (as created in the Animation Manager) to use for the object.

Duration

Specifies the duration of the animation in milliseconds.

Delay

Delay causes the very first run of the animation to wait for the specified amount of time (in milliseconds) before beginning to execute. Note that the delay will not occur during animation repeats. It will only be used for the first iteration of the animation.

Iteration count

You can configure how many times you would like the animation to play, or you can even make it repeat infinitely by using -1.

Direction

Set this to normal to play the animation from start to finish. Or use alternate to play it forward and then backwards.
Timing
The animation-timing-function specifies the speed curve of the animation. The speed curve defines the time an animation uses to change from one set of CSS styles to another. The speed curve is used to make the changes smoothly. The animation-timing-function uses a mathematical function, called the Cubic Bézier curve, to make the speed curve.

- linear
  The animation has the same speed from start to end

- ease
  The animation has a slow start, then fast, before it ends slowly

- ease-in
  The animation has a slow start.

- ease-out
  The animation has a slow end

- ease-in-out
  The animation has both a slow start and a slow end

Transition
A CSS3 transition is an animation that moves a property between two states. Transitions are an implicit animation, which means they are triggered by a state change like ‘hover’ or ‘focus’, unlike an animation which run continuously. You can add multiple transitions to an object. This makes it possible to animate multiple properties at the same time.

Trigger
Specifies which state change will trigger the transition. Commonly used triggers are ‘hover’ and ‘focus’.

Duration
Specifies the duration of the transition in milliseconds.

Delay
Specifies when the transition will start.

Timing
The timing-function specifies the speed curve of the animation. See 'animation properties' for more details.

Property
Specifies the name of the CSS property to which the transition is applied.

Value
Specifies the new value of the CSS property.
**Animation Manager**
The Animation Manager can be used to define animations (with key frames). We have included a few example animations to help you get started.

**Important:**
Not all animations are useful for all objects. For instance animating the background color of an image or shape will not do anything because there is no background in that case. Also animating left/top/width/height/margin/etc will not work for most objects because these values are usually fixed. If you want to animate the size or position of an object it’s better to use transforms. See the examples for more details.

The first step in creating animations is to define 'key frames'. A key frame is a point that defines the start and end of a transition. The most simple animation will have two key frames - one at the start (0%) and one at the end (100%) - whereas more complex animations will have more key frames in between. In the key frame you set the position (in percentages) along the duration of the animation. You must specify at least two key frames (0% and 100%), but you can have many as you like. Each key frame defines a property (and value) that is applied to the element at the specified stage of the animation.

Example:
First key frame: 0% -> background color #000000
Last key frame: 100% -> background color #FFFFFF
This will smoothly animate the background color of an object from black to white.
Note that the timing is defined in the animation properties of the object, not in the animation itself. This way you can reuse an animation in different objects with different timing settings.

**Note**
You can animate multiple CSS properties at the same time by using multiple key frames with same position. See the include examples for more details.

**Animation Timeline**
The Animation Timeline option is available in the Page menu. The Animation Timeline displays all animations on the page, you can also add, edit and remove animations. It’s also possible to drag & drop/move animations on the timeline, so you can easily control the timing of the animations.
**Mobile Web Design**

90 Second Website Builder has a built-in designer for mobile web pages. This makes it easy to create a mobile version of your pages without the need to external software. Mobile pages have a different toolset and creating a mobile website is slightly different that a regular website.

Mobile pages are based on jQuery Mobile ([http://jquerymobile.com/](http://jquerymobile.com/)), which is a framework for creating mobile web applications. jQuery Mobile works on all popular smartphones and tablets.

jQuery Mobile has been designed to work within a responsive context. All the widgets are built to be 100% flexible in width to fit easily inside a responsive layout.

To make a web page 'responsive' it needs to be constructed in a different way. Unlike in standard 90 Second Website Builder layouts where you can drag & drop objects anywhere and where object have a fixed size and position, mobile objects need to adjust to the width of the screen. In most cases this means that the object will use the full width of the page. But it's also possible to set 'full width' to false in which case the objects will be 'inline', so they have a fixed width. By default all objects are placed next to each other (they are floating in the document), but there is also a layout grid available to arrange objects in rows and columns.

Another difference is the styling of objects. Unlike in a standard page, all jQuery mobile objects are styled by themes and swatches.

**Creating a mobile web page**

In the Ribbon or Site manager click 'New Mobile Page'.

Note that the workspace will initially be smaller and the toolbox will get different tools (although many will look familiar). You can still drag & drop objects from the toolbox to the page, but you cannot control the exact position of the object because it will be added to the 'flow' of the page. That means that the first object will be in the upper left corner of the page and the next object will be right after it. If the object is set the full width then the next object will be below the object.

You can control the alignment (left, center, right) of the objects in the page properties. Containers like Collapsible, Layout Grid and Tabs have their own alignment option.

To get an good idea what a mobile page will look like, drag & drop a Header, Footer and a Listview to the page. You will notice that the header will automatically be added at the top of the page and the footer at the bottom. The Listview (and all other objects) will be added between the header and the footer. More advanced layouts can be created with the Layout Grid.

The theme of the page and objects can be set in the Page Properties. Most objects also have an option to change the theme swatch to give it a different style than the rest of the page.

Now preview the result in the browser and notice that all objects fill up the entire width of the browser!

If you have linked to another jQuery Mobile pages then you can also see the page transitions.

---

**Note**

90 Second Website Builder also supports Responsive Web Design, where you can design different layouts within the same page.
Responsive Web Design

With the increase in popularity of browsing on mobile phones and tablets it is becoming essential to create web sites that are optimized to the needs of these users. Previously you had to create different versions of the website and use scripts to redirect the visitor to the mobile version of the page. 90 Second Website Builder 10 introduces 'Responsive Web Design' which allows you to create a single HTML page containing different variants of the layout, each optimized for specific device widths. Your website will dynamically respond to the screen size of the visitor and display the layout most appropriate to their device. These different variants are called 'breakpoints' and uses CSS3's media queries.

A breakpoint is separate ‘view’ of the page in 90 Second Website Builder. A page can have multiple breakpoints, each one optimized for a specific screen width. For example, you can have the standard desktop layout, one for tablets (1024 px) and another one for mobile phones (320 px). Common breakpoints are:

- 320 px, Mobile portrait
- 480 px, Mobile landscape
- 768 px, Tablet portrait
- 1024 px, Tablet landscape/Netbook
- 1280 px and greater, Desktop

Of course you can define your own widths and have as many breakpoints as you like (max 25), although usually you will have no more than 3. To add or edit breakpoints click the 'Manage Breakpoints' option in the Page menu. To switch between breakpoints click the 'Breakpoints' drop down menu and select the desired breakpoint. To go back to the default layout, select "Default".

The different variants share the same content (text, images etc) and you can change the position and size of the object for each breakpoint. You can also add unique content for specific screen widths, which makes it possible for example to hide objects on smaller screen.

The following objects are not responsive; this means that they cannot have a different size in breakpoints. See also ‘Important notes about Responsive Web Design’.

- Banner
- Curve
- Curved Text
- Line
- Navigation Bar
- OLE
- Polygon
- Shape
- Table
- Text Art
- Wrapping Text

If you need different sizes in breakpoints then you will need to create a copy of the object.
Important notes about Responsive Web Design

Objects can have a different size, position and visibility state per breakpoint. However all other properties will be exactly the same! For example if you change the color of an object then it will be changed in all breakpoints (because the object is shared between all views).

Although objects can have different sizes in breakpoints, there are a few exceptions. For example shapes and other drawing tools will have the same size in all breakpoints. The reason for this is because only one image will be published and if you change the size of that image in one breakpoint then it would look distorted in another breakpoint. But you can use multiple shapes, one for each breakpoint and hide the ones you do not use in other breakpoints.

If you share text between multiple breakpoints then set the 'output format' in the compatibility option to 'Default', because the other options optimize the text for a specific width. If you really need to use one of the compatibility options then consider using a separate text object for each breakpoint, so it can be optimized for that specific width.

Objects can only be part of one Layer (and Form, Carousel, Tabs, Accordion, Dialog). So if you move an object to a layer in one breakpoint then it will automatically be part of the same layer in other breakpoints.

If you add a new object to a breakpoint then it will initially be hidden on all other breakpoints. You can use the Object Manager to unhide it if you also want it on other breakpoints.

If you delete an object from a breakpoint then it will be removed from all other views as well. If you want to hide the object then you can use the Object Manager.

You can test breakpoints in your desktop browser. Resize the browser window to activate breakpoints.

Some browsers also have dedicated tools for testing responsive web sites. For example, FireFox has a Responsive Design View which is great to test breakpoints. Consult the documentation of the browser for more details.

Browsers that do not support CSS3 media queries, will display the default layout.
One of the best new features of 90 Second Website Builder Version 10 is the Responsive Web Design tools that are part of the software. These tools introduce the ability to create different web page layouts for different device and browser window sizes.

The concept is simple, but may require a different way of thinking if you have tried to create a responsive website in a more conventional way through writing code or with a standard HTML/CSS editor. (e.g.: Dreamweaver, etc.).

Below are some frequently asked questions about Responsive Web Design, that may help you learn this process better.

**What is Responsive Web Design?**
Responsive web design is a web design style that allows the development of websites that can provide an optimal viewing experience—easy reading and navigation with a minimum of resizing, panning, and scrolling—across a wide range of devices (from mobile phones to desktop computer monitors). It works by allowing the page itself to accommodate the size of the end user’s device or browser window the page is being viewed on.

**How can I design a responsive website with 90 Second Website Builder?**
For an introduction to Responsive Web Design in 90 Second Website Builder please watch this video tutorial:


**What are breakpoints?**
A breakpoint is different ‘version’ of the same page in 90 Second Website Builder. A page can have multiple breakpoints, each one optimized for a specific screen width. For example, you can have a standard desktop layout (1024 - 1280 px), one for tablets (768 px) and another one for mobile phones (320 px). Common breakpoints are:

- 320 px, Mobile portrait
- 480 px, Mobile landscape
- 768 px, Tablet portrait
- 1024 px, Tablet landscape/Netbook
- 1280 px and greater, Desktop

**Which breakpoints should I add to my web page?**
There is no set rule for implementing breakpoints. This depends on your design and what you want to accomplish. The idea behind breakpoints is that any layout will ‘break’ at certain resolutions or screen sizes. For example, where text is no longer readable, the menu is too small or the browser displays a horizontal scrollbar, a breakpoint can cause the layout for that page to change to something more appropriate for that device.

Where the page ‘breaks’ can be different for each and every page. One web page may look fine on all displays all the way down to 320px ... and then it breaks. That would mean that you would only need a breakpoint at 320. Another design may break at all sorts of different resolutions. This, then, would require multiple and differing breakpoints.

When planning a responsive page, you can start designing from smallest to largest or largest to smallest, but it is usually best to start with the default layout (desktop size).

**Once you have an initial design, you then test it at various sizes to see when and where it breaks. Once you have that screen resolution you can then create a breakpoint and adjust. Then you move on from there.**
What is 'max-width'?'
'max-width' specifies the maximum width of the rendering surface of the output device (such as the width of the browser window).

90 Second Website Builder uses the max-width in CSS3 media queries to control the size, position and visibility of objects.

For example if you add a breakpoint and set the max-width to 320px then this layout will be used if the browser window is less than or equal to 320 pixels.

What are 'responsive objects'?'
'Responsive objects' are objects than can have a different size at different breakpoints. Not all objects are responsive, for example shapes and other drawing tools will have the same size in all breakpoints. The reason for this is because only one image will be published for the shape and if you change the size of that image in one breakpoint then it would look distorted in another breakpoint. But you can use multiple shapes, one for each breakpoint and hide the ones you do not use in other breakpoint layouts.

Which objects are not responsive?
Although we have done our best to make most objects responsive, not all objects can have different sizes at different breakpoints due to their 'fixed size' nature.
The following objects are not responsive:
- Banner (*)
- Carousel
- Curve
- Curved Text
- Flash Video Player
- Line
- Navigation Bar
- OLE
- Polygon
- Shape (*)
- Table
- Text Art
- Wrapping Text

(*) Note: Shapes and Banners can be made responsive if you set the output format to: “Publish as CSS3” in the objects properties settings.

If you add a new object to a breakpoint then it will initially be hidden on all other breakpoints. You can use the Object Manager to unhide it if you also want it on other breakpoints. This behavior can be disabled in:

Tools->Options->General->Hide new objects on other breakpoints

If you delete an object from a breakpoint then it will be removed from all other views as well. If you want to hide the object then you can use the Object Manager.

Can objects have different properties at different breakpoints?
Objects can have a different size, position and visibility state in each breakpoint. However all other properties will be exactly the same.

For example, if you change the color of an object then it will be changed in all breakpoints (because the same object is shared between all views). But you can have different objects on different breakpoints so if you want to use a different menu then you hide the menu in the breakpoint and add another one to the current breakpoint.
Why isn't my text responsive?
Text is only responsive if the output format is set to 'Default' (in the compatibility properties of the text object).

If the output format is set to 'use <div> for each line' or 'use <div> with position for each line' then the text is optimized for one size only. Text is also not responsive when you are using line spacing.

Is there a quick way to see which objects on my page are responsive?
Yes, you can use the keyboard combination Shift+Ctrl+R to outline all non-responsive objects on the page. The outline color is currently fixed to red.

Where do you place the "hidden" objects (e.g.: menus)? Should they be within or outside the borders of the breakpoint?
It's recommended to place them inside the page boundaries of the breakpoints, so the objects do not affect the page width.

Can I use breakpoints in master pages and master frames?
Yes, but make sure you use the same breakpoints values in both the master page/frame and content page.

How can I test my responsive designs?
There are many dedicated websites to test responsive designs. For example: http://responsivepx.com/
But some browsers also have built-in test tools. For example in Firefox you can press CTRL+SHIFT+M to go into responsive test mode.

Are there any alternative ways to create a responsive website?
90 Second Website Builder has several other methods for creating flexible and responsive websites. For example you can create multiple versions of your pages where each version is optimized for a different target resolution. You can then use one of the redirect scripts in the 'Ready-to-use-JavaScripts' (available in the toolbox and Insert menu) to redirect the user to the right version of the page.

It's also possible to use layers to create stretchable or floating layouts. See this tutorial for more information:


90 Second Website Builder also includes a dedicated environment for designing mobile websites with the built-in jQuery Mobile Site Builder. This is a very powerful environment, not only useful for mobile pages but also a great way to create flexible layouts.

Why are newly added objects hidden in other breakpoints?

New objects will be set invisible in other breakpoints. This is usually the best option because new objects generally do not have the same position in different breakpoints, so it would clutter the layout if they were added at a 'random' position.

You can use the Object Manager to make the object visible in other breakpoints and move them to the desired position.

It is also possible to change this 'auto-hide' behavior by disabling the option 'Hide new objects on other breakpoints (Responsive Web Design)' in:

Tools->Options->General

When using events, the visibility is affected by breakpoints. In Responsive Web Design, the software will automatically generate code for controlling the position, size and visibility of objects (with CSS3 media queries).

However in some cases controlling the visibility can conflict with other features on the page (like events that show or hide objects).

The option 'Include Visibility' in the context menu of the object makes it possible to exclude the visibility attribute from the media query, so it will not affect the state of the object when using events. Note that if 'Include Visibility' is not active then the object will have the same visibility state in all breakpoints.

You can control the default value of this property in:
Tools->HTML->Use 'Include visibility' as default for new objects in Responsive Web Design.

After I started using breakpoints extensions or custom HTML no longer works.

When using Responsive Design/breakpoints, the software will move all inline styles of objects to the <style> section in the header of the page. This makes it possible to use CSS3 media queries to control the position, size and visibility of objects for different breakpoints. However in some cases this may affect the behavior of an object, HTML or extension.

To control this behavior, we have added a special option in:
Tools->Options->HTML->Keep inline styles with Responsive Web Design (use !important)

If you enable this option, the software will not touch inline styles, but will add !important to overwrite the position, size and visibility of objects with media queries.

When do I use 'Include min-width in CSS3 media queries'?

This option in available in the Manage Breakpoints window. It changes the way breakpoints behave in the browser. By default, breakpoints will be triggered if width of the browser window is the same or smaller than the defined breakpoint.

If Include 'min-width' in CSS3 media queries is enabled, the breakpoint will be triggered if the width of the browser window is the same or larger than the current breakpoint and smaller than the next breakpoint. This can be useful if you want to center the layout if the screen width is wider than the current breakpoint.
Form Validation
90 Second Website Builder has some very powerful validation tools to validate the user input for the EditBox, Combobox, Radio Button, Checkbox, CAPTCHA and TextArea before it's submitted in a Form. Besides JavaScript based validation, there is also native HTML5 validation support built-in!

- **Default**
  Displays a standard JavaScript message.

- **Info bubble (real-time)**
  Select this option to enable real-time validation. The input field will be validated as soon as it loses the focus without the need for the user to press the submit button first. Real-time validation uses info balloons instead of the standard message box, this give your forms a professional look and feel. To configure the style of the balloons click the 'Settings' button. You can configure the colors, font, bubble type, position and animation effect.

- **HTML5**
  Select this option to use native HTML5 form validation. Note that this feature is not available in all browsers yet.

CAPTCHA validation
Error message
This message will be displayed if the user did not enter a value in the CAPTCHA field.

Enable Real-Time Validation through AJAX
If you enable this option then the value of the CAPTCHA field will be validated on the server as soon as the field loses the focus, without the need to submit the form.

Checkbox validation
Error message
This message will be displayed when the user enters the wrong data.

Selection required
Enable this option if the checkbox must be checked before the user can submit the form.
Editbox and TextArea validation

Date Type

- **No Constraints**
  All input is accepted
- **Text**
  The input field is a text field. Use Text Format to specify which characters are allowed
- **Number**
  The input field is a number field. Use Numeric Format to specify which numbers are allowed.
- **Email Address**
  The input field is an email address field.
- **All Major Creditcards**
  - Creditcard - American Express
  - Creditcard – Dinersclub
  - Creditcard – Discover
  - Creditcard – Mastercard
  - Creditcard – Visa
    These options verify common credit card formats.
- **Date – ddmyyyy**
- **Date - mmddyyyy**
- **Date – yyyymmdd**
  These options verify common date formats.
- **IP Address**
  The input field is an IP address.
- **URL**
  The input field is an URL.
- **AJAX**
  This option is for advanced users(!) who wish to validate a value on the server, for example in a database. Use the URL field to specify the validation script on the server. For example: http://www.yourwebsite.com/validate.php

The validate.php script in its simplest form could look something like this:

```php
<?php
$username = $_POST['data'];
// TODO: lookup username in database...
if ($username == 'user')
{
    echo "true";
}
else
{
    echo "false";
}
?>
```

- **Custom**
  Select the Custom option to specify your own regular (JavaScript) expression.

Error message

This message will be displayed when the user enters the wrong data.
Text Format
Select the types of characters to allow in the field Letters, Digits, Whitespace (spaces, tabs, carriage returns, and line feeds), or Other (different characters, such as commas and hyphens).

Numeric Format
Specify to use a comma or period for Decimal points.

Data Length
Required; require the user to type an entry in a edit box or text area field.
Minimum; specifies the minimum number of characters to allow in the text box.
Maximum; specifies the maximum number of characters to allow in the text box.

Data Value
This option can be used to specify a value limitation. In the Field must be list, select a constraint: Don't care, Less than, Greater than, Less than or equal to, Greater than or equal to, Equal to or Not equal to. In the Value box, type the value for the constraint. To specify a second constraint, select And must be, click a condition, and then type a value.

Match
This option allows you to specify another form field of which the contents will be checked against the current field to see if they're the same. This can be useful for validating email or password fields.

Combobox validation
Error message
This message will be displayed when the user enters the wrong data.

Selection required
Require users to make a selection from the combobox.

Disallow first choice
If you use the first option to display instructions, such as "Select an option," you can make the that first option unavailable by enabling this option.

FileUpload validation
Error message
This message will be displayed when the user enters the wrong data.

Data required
If this option is enabled then the user must specify a filename.

Valid extensions
Specifies which extension will be accepted by the form.
**GDI+ Information**

90 Second Website Builder uses GDI+ (Gdiplus.dll) for some of its advanced graphic features such as drawing lines, polygons and curves. If you do not have GDI+ installed on your system these features will be disabled in the application. But you can easily install GDI+ on your system!

**GDI+ details:**
Microsoft Windows GDI+ is a “next generation” 2D graphics environment, adding advanced features such as alpha blending, gradient shading, more complex path management, intrinsic support for modern graphics-file formats like JPEG and PNG,

GDI+ is included with Windows XP or higher.

Customizing 90 Second Website Builder
This section describes how to add customize 90 Second Website Builder so you can add your own
image buttons, themes etc.

90 Second Website Builder saves all user specific configuration information in the folder:
My Documents\90 Second Website Builder\system\This makes it easy to backup all your files and settings by copying all the files and folders in
My Documents\90 Second Website Builder.

For example if you modify the gradient styles through the Style manager the changes will be saved to
My Documents\90 Second Website Builder\system\gradients.dat

Publish settings will be saved in the file My Documents\90 Second Website Builder\system\publish.dat

ClipArt
You can download thousands of free dingbats fonts to use as ClipArt from the Internet. Search for ‘free
dingbat fonts’ to find all large collection of new shapes.
After you’ve downloaded one or more files you can copy them to the 'clipart' folder in the 90 Second
Website Builder system folder: My Documents\90 Second Website Builder\system\clipart\Extensions

Extensions (also called add-ons or plugins) are components which enhance the functionality of 90
Second Website Builder. Extensions can be accessed through the Toolbox or via the Insert menu just like
the standard objects. Although you can use the Extension Manager to install new extensions it’s also
possible to copy the files manually to the My Documents\90 Second Website
Builder\system\extensions\ folder.

Photo Gallery Frames
Frames can be applied to Photo Galleries and standard images.
Custom frames styles can be added to the folder:
My Documents\90 Second Website Builder\system\gallery\Templates

Templates you create will be saved to: My Documents\90 Second Website Builder\system
\templates This means that if have downloaded templates from the website or another source
these should be place in this folder. See also the Template description.

Navigation Bar
To add your own button images for usage in the navigation bar place them in the
My Documents\90 Second Website Builder\system\navbar folder.

Menubar
To create your own theme for the menubar you can use ThemeStudio. These themes should be copied to My
Documents\90 Second Website Builder\system\menubar\ For more details how to create your own
menubar themes please read: How to add a theme created with Theme Studio to 90 Second Website Builder
in the menubar chapter.
**Tab Menu**

The themes for the tabmenu are stored in the folder:  
`My Documents\90 Second Website Builder\system\tabmenu`  
See also the Tab Menu description.

---

**Theme Roller**

Many of the jQuery widgets can be styled by using ThemeRoller themes. 
New themes must be installed in the 'themeroller' folder of 90 Second Website Builder:  
`My Documents\90 Second Website Builder\system\themeroller`

You can easily create custom themes by visiting the ThemeRoller website:  
[http://www.themeroller.com](http://www.themeroller.com)

**Step 1**

Go to the ThemeRoller website: [http://www.themeroller.com](http://www.themeroller.com)

**Step 2**

Select one of the predefined themes or create your own theme.

**Step 3**

Download the theme to your computer.

Make sure you select 'All components' and version 1.8.x for jQuery 1.4+.

In 'Advanced Theme Settings' you can specify the name of your theme. Let's call it 'MyFirstTheme'.

The downloaded file is in zip format and will be called something like: `jquery-ui-1.8.2.custom.zip`

**Step 4**

Unzip the files to a temporary folder on your harddisk.

There are a lot of files in the zip that you don't need.

You will find your custom theme in: `development-bundle\themes\MyFirstTheme`

(where MyFirstTheme is the name of your theme).

You will need to copy this complete folder to the 90 Second Website Builder themeroller folder:  
`My Documents\90 Second Website Builder\system\themeroller\MyFirstTheme`

The new theme will now be available the next time you open the properties of the jQuery objects.
Creating Newsletters

Although an HTML Newsletter seems just another HTML page, this unfortunately is not completely true. Unlike modern browsers, email clients only support a limited subset of HTML. Most email clients do not support CSS and there for you will need to follow a few guidelines to make sure your Newsletters can be displayed in all major email clients.

The most important step is to set the layout mode of the page to 'Table Layout'. You can do that in the Page Properties (Menu->Page->Page Properties->Misc->Layout Mode).

Now 90 Second Website Builder will use (invisible) tables to position objects on the page. This has one huge disadvantage: you cannot overlap objects! So your layout cannot have objects on top of each other.

To work around this limitation you can use the 'Merge' option, to merge multiple objects into a single image.

Here's a list of the most important limitations of HTML email:

- You cannot put objects on top of each other. Overlapping is not supported. Merge objects to bypass this limitation.
- External CSS Style sheets are not supported. (Disable in Menu->Tools->Options->HTML).
- JavaScript (this includes navigation, events, jQuery based objects) is not supported.
- Forms will usually be displayed, but they will not be functional!
- Flash and other media files are not supported.
- Background images are not supported.
- Internal links will not work, always use absolute links (for example: http://www.yourwebsite.com/pagename.html)

Tip:
Always test your emails before you send them out! Once an email has been sent out, it's impossible to take it back.
Index

A
Action, 87
Active Link Color, 36
ActiveX, 105
Add to Cart button, 177
Adding an image to a web page, 15
Adding text to the page, 14
Advanced Button, 92
Alternate text, 75
Anchors, 72
Animation, 248
Animation Manager, 250
Appearance, 236
Apply effects to an image, 16
Author, 37

B
Backup, 61
Backup folder, 61
Banner, 144
Blog, 156
Bookmark, 72
Bookmarks, 235
Brightness, 77
Bulleted List, 73
Button, 102
Buy Now Button, 176

C
CAPTCHA, 93
Carousel, 157
Categories, 37
Cell HTML, 46
Cell Padding, 46
Cell Properties, 46
Cell Spacing, 46
Center in browser, 33
Character Set, 34
Checkbox, 95
ClipArt, 146
Clone Page, 26
Close, 21
Close Web Site, 21
CMS Admin, 197
CMS Database, 195
CMS Label, 205
CMS Menu, 206
CMS plug-ins, 202
CMS Search, 207
CMS View, 208
Combobox, 96
Content Management System, 194
Content Place Holder, 120
Contrast, 77
Convert to Form, 180
Copy, 23
Crop, 77
CSS animation and transitions, 248
CSS Menu, 132
Curve, 147
Curved Text, 148
Customize, 54
Cut, 23
Default Font, 36
Delete, 23
Delete Column, 45
Delete Row, 45
Description, 37
Document Type, 33
Don’t Publish Assets, 24
Donations, 179
Don’t Publish this page, 34
Don’t synchronize this page in Navigation Objects, 34
Edit Menu, 23
Editbox, 98
Effects, 77, 79
Embedded OLE Object, 122
Encoding type, 87
Error Reports, 65
Events, 246
Exit, 22
Export to HTML, 22
Extensions, 63
Favorites Icon, 33
File extension, 32
File Menu, 21
File Publisher, 106
File Upload, 100
Find, 23
Flash, 107
Flash Variables, 108
Flash Video Player, 109
Flip, 77
Font Color, 42
Font Size, 42
Font Style, 42
Font Type, 42
Form, 86
| Form Area, 86 | Language, 61 |
| Form Validation, 254 | Layer, 115 |
| Form Wizard, 83 | Line, 149 |
| Format Menu, 42 | Link, 41 |
| Formatting Tools, 10 | Link Color, 36 |
| FTP, 59, 231 | Links, 233 |
| Full Screen Mode, 25 | Lock, 48 |
| | Lock All, 48 |
| | Lock page size, 49 |
| | Logging, 59 |
| GD+ Information, 257 | Login tools – Admin, 183 |
| General Styles, 43 | Login tools – Change Password, 185 |
| Generator, 37 | Login tools – Edit Profile, 193 |
| Getting Started, 8 | Login tools – Login, 187 |
| Global Replace, 68 | Login tools – Logout, 188 |
| Go Menu, 133 | Login tools – Protected Page, 190 |
| Gradient Style Manager, 245 | Login tools – Signup, 191 |
| Gradient Styles, 43 | Login tools – Password Recovery, 189 |
| Grid Spacing, 49 | Look Up in Dictionary, 43 |
| Guide Borders, 49 | |
| Guide settings, 49 | |
| Handles, 15 | Make Default, 34 |
| Hidden Fields, 91 | Marquee, 80 |
| Horizontal Line, 74 | Master Frame, 120 |
| HTML, 111 | Master Objects, 118 |
| HTML 4.01 Transitional, 33 | Media Player, 130 |
| Hue/Saturation, 77 | Mega Menu, 134 |
| Hyperlink Style Sheet, 236 | Menu Bar, 136 |
| Hyperlink Styles, 43 | Menu Name, 32 |
| Hyperlinks, 17 | Merge Cells, 45 |
| Image, 75 | Meta Tags, 37 |
| Image Button, 101 | Mobile Theme Manager, 67 |
| Image Map, 159 | Mobile Web Design, 251, 252 |
| Import HTML, 28 | |
| Inline Frame, 114 | Navigation bar, 138 |
| Insert Menu, 41 | New Page, 26 |
| Insert Rows or Columns, 45 | New Web Site, 21 |
| Insert Table, 45 | New Web Site From Template, 21 |
| Java, 113 | News Feed Ticker, 169 |
| jQuery Accordion, 210 | Notes, 123 |
| jQuery Auto Complete, 211 | Object Manager, 242 |
| jQuery Button, 212 | Object Outlines, 25 |
| jQuery Datepicker, 213 | Open Web Site, 21 |
| jQuery Dialog, 214 | Options, 55 |
| jQuery Menu, 216 | |
| jQuery Progressbar, 218 | |
| jQuery Slider, 219 | Page Footer, 124 |
| jQuery Spinner, 221, 225, 226, 227, 228, 229 | Page Header, 125 |
| jQuery Tabs, 217 | Page Height, 32 |
| jQuery Tooltips, 222, 223 | Page HTML, 28 |
| | Page Language, 34 |
| | Page Properties, 30 |
| | Page Width, 32 |
| Keywords, 37 | Panel Menu, 140 |
Paste, 23
Paste in Place, 23
PayPal Donations, 179
PayPal eCommerce Tools, 175
PayPal Shopping Cart, 177
Photo Gallery, 161
PHP Login Tools, 180
Polygon, 151
Preview, 18
Preview Folder, 59
Preview in Browser, 22
Preview Scope, 59
Properties Inspector, 13, 244
Publish, 19
Publish Options, 59
Publish to a local folder, 19
Publish your website, 230

Quicktime, 127

Radio button, 103
Ready to use Java Scripts, 164
Real Player, 128
Redo, 23
Reflection, 75
Remove formatting, 43
Remove link, 43
Remove Page, 26
Rename Page, 27
Replace, 24
Resample, 77
Restore Original Size, 24
Rollover image, 165
Rollover Text, 166
Rotate, 16, 77
Rotation, 76
RSS Feed, 167
Rulers, 25

Save, 22
Scribble, 152
Search in Google, 43
Search Index, 64
Select, 41
Select All, 23
Shape, 153
Shopping Cart, 177
Show Grid, 49
Sign Up for a PayPal Account, 175
Site Manager, 12, 238
Site Map, 53
Site Search, 172
SiteTree, 141
Slide Show, 171
Snap to grid, 25
Split Cell, 45

Stencils, 77
Style Manager, 245
Subscriptions and Recurring Payments, 178
SWFObject, 108
Symbol, 41

Tab Menu, 142
Table HTML, 46
Table Menu, 45
Tables, 45
Tabs, 11
Target screen size, 32
Templates, 21
Text, 80, 81
Text Menu, 143
TextField, 104
Theme Manager, 66
Theme Studio, 137
Timer, 174
Title, 32
Toolbox, 11, 69
Tools Menu, 51
Transition, 249
Transitions, 40

Undo, 23
Unlock, 48
Unlock All, 48
User database, 181

Verify Links, 52
View Cart button, 177
View Menu, 25
Visited Link Color, 36

Web safe fonts, 44
Workspace, 11
Wrapping Text, 126

XHTML 1.0 Transitional, 33

You Tube, 131

z-index, 243
Zoom, 25
z-order, 243